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Documentation Conventions

OPNET documentation uses specific formatting and typographic conventions to 
present the following types of information:

• Objects, examples, and system I/O

• Object hierarchies, notes, and warnings

• Computer commands

• Lists and procedures

Objects, Examples, and System I/O

• Directory paths and file names are in plain Courier typeface:

opnet\release\models\std\ip

• Function names in body text are in italics:

op_dist_outcome()

• The names of functions of interest in example code are in bolded Courier 
typeface:

/* determine the object ID of packet’s creation module */
src_mod_objid = op_pk_creation_mod_get (pkptr);

• Variables are enclosed in angle brackets (< >):

<opnet_user_home>/op_admin/err_log

Object Hierarchies, Notes, and Warnings

Menu hierarchies are indicated by right angle brackets (>); for example:

Open File > Print Setup > Properties...
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Attribute hierarchies are represented by angled arrows (➘ ) that indicate that you 
must drill down to a lower level of the hierarchy:

Attribute level 1 ➘ Attribute level 2 ➘ Attribute level 3

Note—Notes are indicated by text with the word Note at the beginning of the 
paragraph. Notes advise you of important supplementary information.

WARNING—Warnings are indicated by text with the word WARNING at the 
beginning of the paragraph. Warnings advise you of vital information about an 
operation or system behavior.

Computer Commands

These conventions apply to Windows systems and navigation methods that use 
the standard graphical-user-interface (GUI) terminology such as click, drag, and 
dialog box.

• Key combinations appear in the form “press <button>+x”; this means press 
the <button> and x keys at the same time to do the operation.

• The mouse operations left-click (or click) and right-click indicate that you 
should press the left mouse button or right mouse button, respectively.

Lists and Procedures

Information is often itemized in bulleted (unordered) or numbered (ordered) 
lists:

• In bulleted lists, the sequence of items is not important.

• In numbered lists, the sequence of items is important.

Procedures are contained within procedure headings and footings that indicate 
the start and end of the procedure. Each step of a procedure is numbered to 
indicate the sequence in which you should do the steps. A step may be followed 
by a description of the results of that step; such descriptions are preceded by an 
arrow.

Procedure FM-1 Sample Procedure Format 

1 Procedure step.

➥ Result of the procedure step.
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2 Procedure step.

End of Procedure FM-1

For more information about using and maintaining OPNET documentation, see 
the OPNET VNE Server Documentation Guide.
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1 Overview

Introduction

The Virtual Network Environment (VNE) Server provides you with a software 
environment that replicates the behavior of your entire network. VNE Server is 
the first network management solution to provide a continuously valid, 
complete, and integrated view of a network, consisting of the following:

• physical topology 

• logical topology 

• device configuration 

• protocol configuration 

• interface utilization 

• traffic flow

• performance information 

VNE Server provides an open architecture based on an extensible family of 
network information collection adapters. Specifically, VNE Server continuously, 
automatically, and on a scheduled basis 

• collects disparate network information via an extensible set of adapters 

• normalizes and archives the information collected

• infers physical and logical topology through powerful link and connection 
inference agents

• validates and fuses the information utilizing intelligent merge agents

• maintains itself by automatically updating new information and deleting stale 
information 

OPNET analysis software connects to VNE Server as a client to obtain data that 
you can then use to analyze your network.

VNE Server is currently supported on Windows 2000, Windows 2000 Server, 
Windows XP Professional, and Windows 2003 Server. 

VNE Server provides the ability to view the changes occurring in your network. 
Furthermore, VNE Server provides extensive, on-line reporting and network 
element browsing capabilities. VNE Server provides adapters for popular 
third-party network data sources and will also allow third parties to author their 
own adapters, ensuring applicability in all network environments. 
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The VNE Server adapter set includes network data collection from 

• network management applications 

• performance management applications

• traffic measurement applications

• device configuration files

• device SNMP MIBs

• device console commands

• proprietary information sources

• simple ASCII csv files
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Architecture 

This section describes the VNE Server architecture and data flow to provide you 
with a better understanding of the product’s ability to directly collect network 
data and to operate with third-party network management systems. The 
following figure shows how VNE Server fits into the network management 
environment. 

Figure 1-1   VNE Server Architecture

VNE Server is composed of a comprehensive suite of adapters, a VNE Services 
framework, and a network database. The data collection adapters collect and 
translate network data into normalized eXtensible Markup Language (XML) files 
that can be imported into the network database. Adapters operate in a 
scheduled mode within an event service framework. 

(Concord, 
CiscoWorks, 
HP OpenView, 
MRTG)
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The VNE Server suite of adapters consists of native adapters and third-party 
network management system (NMS) adapters. The native adapters collect data 
directly from each device in the network. The third-party NMS adapters collect 
device data from other products such as CiscoWorks or Concord eHealth. 
These adapters do not access network devices directly but leverage data 
collected from existing NMS platforms in your network. This minimizes polling of 
your network. 

VNE Server Services are composed of framework services such as XML import, 
intelligent merge, and scheduled services such as Database Aging, 
Maintenance, and Interface Utilization Rollup. The XML import and merge 
services add and merge data to the network database. The Database Aging and 
Interface Utilization Rollup services remove stale data from the network 
database and manage database growth resulting from traffic data collection. A 
Live Update Server provides information about network changes to interested 
clients. VNE Server Services also provides an Export Server that controls model 
export to OPNET analysis software.

The network database is an Oracle8i or Oracle9i database. You can configure 
VNE Server to operate with a local database or remote database. 
Communication with the database is standards-based to allow VNE Server to 
operate with other databases in the future. 

User Interfaces 

VNE Server provides several user interfaces for management of the product. 
These user interfaces let you configure VNE Server operating parameters, start 
data collection, monitor VNE Server adapter operation, and display reports 
related to network information that VNE Server has collected. With these tools, 
you can control VNE Server’s activities and network usage, and can determine 
whether data collection is proceeding properly. The user interfaces provided by 
VNE Server are shown in Table 1-1: 

Table 1-1   VNE Server User Interfaces  (Part 1 of 2)

Interface Name Description 

VNE Server Console Serves as the control panel for VNE Server. Displays status information about 
adapter and service operation. All VNE Server functions are launched from the 
Console. 

VNE Server Event Viewer Displays VNE Server data collection, import, and intelligent merge events. 

VNE Server Management Console Provides control over VNE Server operating parameters pertaining to adapter 
operation, NMS platforms and network devices. 
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You can find more information about the VNE Server Console, Event Viewer, 
Management Console, Network Browser, and Report Manager in the User 
Interface chapter. 

Adapters and Services 

Data collection in VNE Server is performed by a set of agents called adapters. 
Each adapter is designed to acquire or translate a specific type of network 
information. The VNE Server platform comprises an event service and 
scheduling framework that coordinates the operation of each adapter and 
service. The information collected by each adapter is stored in an underlying 
relational database. A powerful merge engine consolidates all acquired network 
information into a comprehensive network model. The Database Aging Service 
provides for self-maintenance by alerting you to aging information and 
eventually removing stale information. Other services are available to process 
information in the database and to manage the VNE Server environment. 

VNE Server Network Browser Provides a graphical tree-based view of network devices, their associated 
interfaces and sub-interfaces, along with configuration information. Links are 
visible in the browser. Change history of network elements is also available. 

VNE Server Group Browser Provides the ability to define, manage and view device group definitions - both 
those created as export groups and those used for blocking adapter import. 

VNE Server Report Manager Provides reports on collected data in the network database. Can be used to 
judge the correctness of VNE Server operation and produce reports about the 
target network. 

End of Table 1-1

Table 1-1   VNE Server User Interfaces  (Part 2 of 2)

Interface Name Description 
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VNE Server supports the adapters and services listed in Table 1-2. These 
agents are discussed in more detail in the Adapters and Services chapter.

Table 1-2   VNE Server Adapters and Services  (Part 1 of 3)

Adapter or Service Name Description

Device Config File Collection Directly connects to devices, executes show commands, and collects 
the output into files. Supports telnet and secure shell (SSH) as well as 
TACACS+ managed devices.

Remote File Collection Transfers files from another host to the VNE Server working 
environment. Currently uses FTP for retrieval. 

Device Config File Import

Device ifIndex Import

Device FR Map Import

Device Version Import

Device IP Route Import

Device CDP Import

Device ARP Table Import

Device Interface Import

Device Module Import

Device VTP Status Import

Device CAM Table Import

Device VLAN Database Import

Nortel EPIC Output Import 

Parses, translates, normalizes, and imports the output of the device 
console commands. These adapters are normally used to import 
configuration files collected by the Device Config File Collection 
adapter. 

Device MIB Configuration Import Uses SNMP to retrieve device information from supported MIBs. 

CiscoWorks Config File Collection Connects to the CiscoWorks server and collects device configuration 
files that the CiscoWorks server has collected. 

CiscoWorks Config File Import Parses, translates, normalizes, and imports the configurations files 
retrieved from CiscoWorks. 

CiscoWorks RME Database Import Connects directly to the CiscoWorks RME database to retrieve basic 
information about managed devices including information contained 
in the System MIB, IF MIB, and entity MIB. 

CiscoWorks ANI Database Import Connects directly to the CiscoWorks ANI database to retrieve 
information useful for determining connectivity between devices, and 
imports this information into the VNE database. 

Cisco WAN Manager Import Connects to a Cisco WAN Manager database to retrieve information. 

HP OpenView NNM Import Connects to an HP OpenView Network Node Manager server, 
collects, and imports topology and configuration information. 
VNE-1-6 VNE Server/Release 3.0



VNE Server User Guide 1—Overview
DNS Alias Import Performs a reverse DNS lookup using interface addresses to 
populate device and interface alias information in the database. 

Link and Connection Inference Infers physical and logical connectivity based upon collected device 
and interface information.

Trace Route Link Inference Analyzes network connectivity and uses device traceroute commands 
to collect additional information about the network. This information is 
used to add devices and links to tie together isolated portions of a 
network in order to create a fuller network model. 

MIB-Based Interface Utilization Import Uses SNMP to poll known devices and collect interface utilization 
information.

Concord eHealth Network Utilization Import Collects interface utilization information from Concord 
eHealth/Network systems. Uses telnet and FTP for access and 
retrieval. 

StatScout Interface Utilization Import Collects interface utilization information from a StatScout server. 

MRTG Interface Utilization Import Collects interface utilization information from a MRTG server. Both log 
and RRD files are supported. 

InfoVista Network Utilization Import Collects interface utilization information from an InfoVista server. 

VistaMart Interface Utilization Import Collects interface utilization information from a VistaMart server

Cisco Netflow Collection Collects traffic flow information from a Cisco Netflow Collector server. 

NetScout nGenius Import Collects traffic flow information from a NetScout nGenius server, 

Cflowd Import Collects traffic flow information from a Cflowd server. 

Demand Traffic Processing Service Processes traffic flow data to perform endpoint mapping, Categorizes 
traffic flow based upon source and destination. 

ASCII Generic Data Import Imports user-generated network information that overrides, or 
supplements information in the network model. Commonly used to 
provide geographic location data for devices. 

Post Processor Processes model attributes so that missing attributes, such as 
sysLocation, can be populated from related information in other 
attributes. 

Database Aging Service Identifies and removes stale, or inconsistent network information. 

Maintenance Service Removes outdated data files and temporary files in order to manage 
disk space utilization. 

Change Records Maintenance Service Manages the growth of change records in the network database. 

Report Export Service Provides scheduled export of VNE Server reports. 

Table 1-2   VNE Server Adapters and Services  (Part 2 of 3)

Adapter or Service Name Description
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Documentation Roadmap 

Depending upon the information you need, you can continue along several 
paths through the documentation. 

• To learn more about the VNE Server user interfaces, continue with the User 
Interface chapter. 

• To learn more about the VNE Server adapters, continue with the Adapters 
and Services chapter. 

• To learn more about configuring and operating VNE Server, continue with the 
Operation chapter. 

• To learn more about VNE Server administration, continue with the 
Administration chapter. 

• To learn more about VNE Server troubleshooting, continue with the 
Troubleshooting appendix. 

• To learn more about supported device configuration commands, continue 
with the Device Configuration Commands appendix. 

Interface Utilization Rollup Service Consolidates collected traffic data in order to manage network 
database growth. 

External Adapter Provides the ability to run external scripts and tools under control of 
the VNE Server scheduler. 

Demand Traffic Rollup Service Consolidates collected traffic flow data in order to manage network 
database growth. 

Export Service Provides scheduled export of a VNE Server network model. 

End of Table 1-2

Table 1-2   VNE Server Adapters and Services  (Part 3 of 3)

Adapter or Service Name Description
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2 User Interface

Introduction 

This chapter describes the VNE Server user interface (UI). The UI supports 
configuration of operating parameters, starting and stopping data collection, 
monitoring adapter operation, and displaying reports about the network. 
Through the UI, you can control VNE Server’s activities and network usage, and 
can determine whether data collection is proceeding properly. The VNE Server 
user interfaces use a combination of standard UI features such as menus, 
dialog boxes and buttons. The VNE Server UI also uses expandable treeviews 
of configuration properties. 

VNE Server provides the following user interfaces:

Table 2-1   VNE Server User Interfaces

User Interface Description

Console Provides a high-level view of adapter and service 
activity. From the Console, you can start or stop VNE 
services and open other user interfaces. The 
Console serves as the control panel for VNE Server. 

Event Viewer Displays VNE Server events, and functions as a 
system logger. The Event Viewer provides a 
lower-level view of adapter and service activity to 
complement the high-level view provided by the 
Console. 

Management Console Provides control over VNE Server operating 
parameters pertaining to device access, adapter 
operation, and display presentation. 

Report Manager Provides reports on data collected in the network 
database. Can be used to judge the correctness of 
VNE Server operation and produce reports about the 
target network. 

Network Browser Provides a graphical tree-based view of network 
devices, links, and the information collected about 
them. VNE services must be running in order to use 
the Live Network Browser. 

An offline Network Browser is also available for 
viewing the network when VNE services are not 
running. The offline Network Browser displays a 
subset of the information available through the Live 
Network Browser. 
VNE Server/Release 3.0 VNE-2-1



2—User Interface VNE Server User Guide 
The VNE Server Program Group 

VNE Server is launched from the OPNET VNE Server 3.0 program group. This 
program group provides the selections shown in the following table:

Note—You must be logged in as Administrator for the VNE Server program 
group to be visible. 

Starting VNE Server 

Procedure 2-1 describes how to start VNE Server from the program group.

Procedure 2-1   Starting VNE Server

1 Select Start > Programs. 

2 Locate the OPNET VNE Server 3.0 program group. 

3 Select OPNET VNE Server from the OPNET VNE Server 3.0 program group. 

➥ Within a minute, the VNE Server Console opens. 

End of Procedure 2-1

Table 2-2   VNE Server Program Group Selections

Selection Function

OPNET VNE Server Opens the VNE Server Console. 

Open File Log Viewer Opens the VNE Server File Log Viewer. 

Open Licensing Web Page Opens a web browser to the OPNET License 
Registration page. 

OPNET VNE Server 
Documentation 

Opens the VNE Server documentation menu in 
Acrobat Reader. 

Remove current project from 
database 

Removes all the data related to the current data 
collection project from the network database. 

Remove temp dir and current 
project from database 

Removes the temporary directory (which is usually 
C:\op_admin\tmp\vne), and all the data related to the 
current data collection project from the network 
database. 

End of Table 2-2
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Deleting the Current Project

Procedure 2-2 describes how to remove the current project from the VNE 
Server database. This erases all data about the current network and is a good 
step to take when starting a new project.

Procedure 2-2   Removing the Current Project

1 Select Start > Programs. 

2 Locate the OPNET VNE Server 3.0 program group. 

3 Select the Remove current project from database item from the OPNET VNE 
Server program group. 

WARNING—Removing the current project from the database erases all data about the 
current network. Data stored under other projects remains in the database.

➥ A window opens and shows a number of INFO messages. The window closes 
when this task is complete. 

End of Procedure 2-2

Deleting the Temporary Directory and Current Project 

Procedure 2-3 describes how to remove the current project and the temporary 
directory (temp dir) from the VNE Server database. This includes the removal of 
working files in the temp dir.

Procedure 2-3   Removing the Current Project and Temp Dir

1 Select Start > Programs. 

2 Locate the OPNET VNE Server 3.0 program group. 

3 Select the Remove temp dir and current project from database item from the 
OPNET VNE Server program group. 

WARNING—This task removes all data about the current network from the database. 
Data stored under other projects remains in the database. 

➥ A window opens and shows a number of INFO messages. The window closes 
when this task is complete. 

End of Procedure 2-3
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Viewing VNE Server Documentation 

To open the VNE Server documentation set, follow the steps in Procedure 2-4:

Procedure 2-4   Open VNE Server Documentation

1 Select Start > Programs. 

2 Locate the OPNET VNE Server 3.0 program group. 

3 Select the OPNET VNE Server documentation item from the OPNET VNE Server 
program group. 

➥ Acrobat Reader opens and shows the VNE Server documentation menu. 

End of Procedure 2-4

Viewing Event Log Files 

Procedure 2-5 describes how to view the VNE Server event log file.

Procedure 2-5   Viewing the VNE Server Event Log: 

1 Select Start > Programs. 

2 Locate the OPNET VNE Server 3.0 program group. 

3 Select the Open File Log Viewer item from the OPNET VNE Server program 
group.

➥ A file selection browser opens and displays a list of event log files that exist in 
the VNE Server environment. 

4 Select the event log file to open, and press Select. 

➥ An Event Viewer window opens and displays the contents of the event log file. 

End of Procedure 2-5

Opening the OPNET Licensing Web Page 

You can open the OPNET licensing web page directly from the program group 
using the steps in Procedure 2-6.

Procedure 2-6   Opening the OPNET LIcensing Web Page

1 Select Start > Programs. 

2 Locate the OPNET VNE Server 3.0 program group. 
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3 Select the Open Licensing Web Page item from the OPNET VNE Server program 
group.

➥ The default web browser opens and displays the OPNET License Registration 
web page. 

End of Procedure 2-6

VNE Server Commands on Solaris 

For VNE Server on a Solaris Platform, the major functions described in the 
previous section are executed as follows.

Starting VNE Server

Change your working directory to the VNE Server installation directory on 
Solaris. Enter the following command to start VNE Server: 

vnes.sh -r Oracle9i EV

Deleting the Current Project

Change your working directory to the VNE Server installation directory on 
Solaris. Enter the following command to delete the current project within the 
database: 

vnes.sh -r Oracle9i CLEANDB 

WARNING—This command permanently removes all data for the current 
project from the database. 

Deleting All Projects and Tables

Change your working directory to the VNE Server installation directory on 
Solaris. Enter the following command to delete all the projects and tables in the 
database: 

vnes.sh -r Oracle9i CLEANALLDB 

This command leaves the user account and tablespace files intact but removes 
all tables, synonyms, and projects owned by this user from the database. Use 
the CLEANALLDB command when upgrading to a new build that changes the 
table schema. Running CLEANALLDB allows the new build to reinitialize the 
database without re-running the setup_accounts SQL script. 
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This command target also exists for Windows users. 

WARNING—This command permanently removes ALL data for ALL VNE 
Server projects from the database. 

Deleting the Temporary Directory and Current Project

Change your working directory to the VNE Server installation directory on 
Solaris. Enter the following command to delete the temp dir and the current 
project in the database: 

vnes.sh -r Oracle9i CLEANALL 

WARNING—This command will permanently remove all data for the current 
project from the database. 

Viewing VNE Server Documentation 

Change your working directory to the VNE Server installation directory on 
Solaris. Enter the following command to view documentation: 

vnes.sh -r Oracle9i HELP 

Viewing Event Log Files 

Change your working directory to the VNE Server installation directory on 
Solaris. Enter the following command to view an event log file: 

vnes.sh -r Oracle9i FV 

Performing License Operations 

Refer to the Product Licensing on page VNE-5-11 section of the Administration 
chapter for command line licensing procedures for VNE Server on Solaris. 

Console 

The Console is the most visible component of VNE Server and is the UI that you 
see after starting the product. The Console acts as the VNE Server control 
panel. From the Console, you can start and stop data collection services, 
monitor the status of adapter and service execution, and open the other UIs 
provided by VNE Server. You can access the following UIs from the Console: 

• Event Viewer 

• Management Console 
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• Report Manager 

• Network Browser 

• Help

The Console has two display modes: detail view and summary view. 

Console Summary View

The Summary View of the Console provides a small footprint UI that only shows 
the event totals, by severity, and provides a menu bar. Clicking on the button in 
the bottom, right corner of the Console window toggles the view between Detail 
and Summary. Use the Summary View when you need to recover some desktop 
area for other work. The Console Summary View is shown below. 

Figure 2-1   Console Summary View

Console Detail View

The Detail View provides a standard window containing the following elements: 

• System Status panel 

• Adapter Status panel

• Menu bar

— Console File Menu

— Console Control Menu

— Console Data Menu

— Console Help Menu

• Tool button bars 

• Event totals color coded by severity 

• Elapsed time and system time clocks 

When you start VNE Server, the Console opens in Detail View mode. An 
anatomy of the Console Detail View is shown below.
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Figure 2-2   Console Detail View 

Note—When the Console is opened before any adapter configuration occurs, 
the Adapters section of the System Status area is empty, and the Services 
section only has a VNE-XML Import entry. 

System Status Panel 

The main viewing area of the Console contains tabbed panels, System Status 
and Adapter Status, that show status information about operation of the 
adapters and services. The System Status panel is divided into two sections: 
Adapters and Services. Each section displays the following information: 

• Adapter or service execution state (Inactive, Idle, Queued, or Running)

• Execution progress bar 

• Event that triggered adapter or service execution 

 

System Status and Adapter Status panel tabs

Menu Bar

Toolbar

System status 
display for adapters

System status 
display for services

Event totals since 
start of services

Elapsed time since 
start of services

System Time

Toggle display mode
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The purpose of the System Status panel is to provide a high-level view of VNE 
Server activity. This panel shows which adapter or service, if any, is currently 
running. When XML data is being imported by the VNE-XML Import service, this 
panel also shows which adapter’s data is being imported. The System Status 
panel answers, at a glance, questions about VNE Server’s current activities. 

An example of this panel is shown in Figure 2-3. In this example, the InfoVista 
Network Utilization Import adapter is running and was triggered manually. A 
progress bar indicates how much work remains. The HP OpenView NNM Import 
adapter is queued and waiting to run. This adapter was also triggered manually. 
The Services section of the System Status panel shows that the Database 
Aging Service is running. 

Figure 2-3   System Status Panel Showing Adapter and Service Execution

Both sections of the System Status panel provide horizontal and vertical scroll 
bars when the data to be displayed exceeds the panel space. In both the 
System Status and Adapter Status panels, columns can be resized by dragging 
the borders and can be repositioned by dragging the column header. 

Adapters and services that are in a Running or Queued state move to the top of 
the status sections. 
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Adapter Status Panel 

The Adapter Status panel provides more details about adapter operation to 
complement the high-level view provided by the System Status panel. The 
Adapter Status panel provides the following information about adapter 
operation: 

• Start time, end time and duration of previous adapter run 

• Trigger event and details of previous adapter run 

• Trigger event and details of the next adapter run 

VNE Server allows adapters to be scheduled to run at specified times or in 
response to another adapter’s operation. In Figure 2-4, the panel clearly shows 
how an adapter is scheduled to run. 

Figure 2-4   Adapter Status Panel Showing Details of Adapter Execution 
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The Previous Trigger and Next Trigger fields show whether the adapter is 
triggered to run based upon a time schedule (schedule) or a system event 
(event). The Trigger Details fields show why the adapter runs. When an adapter 
is triggered to run based upon a completion event raised by another adapter, as 
shown in Figure 2-5, the Trigger Details fields show the triggering adapter and 
event. 

Figure 2-5   Adapter Status Panel Showing Details of Next Adapter Trigger

Status Display Filter 

The Console provides a display filter that allows you to filter out panel entries 
based upon execution state. To access the filter, right-click the mouse on the 
table header in either the System Status or Adapter Status panels. A Display 
Filters menu appears. Check each execution state that you want to be displayed 
in the Status panels. 

Figure 2-6   Status Panel Display Filter 
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Console File Menu 

The Console File Menu provides the selections shown in Table 2-3. 

The New Log Viewer selection opens a menu that has two choices: Live Log 
and File Log. 

• The Live Log selection opens an Event Viewer that shows new events as 
they are created by the system. 

• The File Log selection prompts you for an event log file and opens an Event 
Viewer window that shows the events in the selected log file. A File Log 
Event Viewer window is only used to view past events and is your primary 
tool for viewing past events. 

The Exit selection terminates VNE Server. If VNE Server services are running 
when you choose Exit, you are prompted to stop services.

Console View Menu 

The Console View menu provides the selections shown in Table 2-4. This menu 
contains all of the Console view control options.

Table 2-3   File Menu Summary 

Menu Item Description

New Log Viewer Opens an Event Viewer window. Choose between Live Log and 
File Log options. 

Exit Closes and exits the VNE Server application. 

End of Table 2-3

Table 2-4   View Menu Summary

Menu Item Description

Detailed View Expands the Console to show the System and Adapter Status 
display. See also Console Detail View on page VNE-2-7.

Summary View Collapses the Console display to only show the menu bar and 
event summary area. See also Console Summary View on 
page VNE-2-7.

Display Filters Opens the Display Filters selection dialog. See also Status 
Display Filter on page VNE-2-11.

Adapter Statistics Opens the Adapter Statistics report. 

Event Refresh... Controls the event refresh rate used by the Console. 

End of Table 2-4
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Adapter Statistics

The View menu contains an Adapter Statistics selection. The Adapter Statistics 
menu choice provides valuable information about the results of each adapter 
session. These statistics include 

• Adapter name, start and stop time, and total duration 

• Information about files collected or processed 

• Device access statistics such as collection attempts, successes, failures

• Statistics about devices, interfaces and links that have been created or 
removed

While viewing System Status in the Console is a good way to get information 
about current system activity, Adapter Statistics is the quickest way to get a 
good summary of system operation. 

• You can see If adapters are running as scheduled. 

• You can see if access failures consistently occur.

• You can monitor VNE Server operation. 

The Adapter Statistics display is limited to a fixed number of entries that 
represent the most recent activity. The information displayed in Adapter 
Statistics is saved in a text file named adapterStats.txt that is located at <temp 
dir>\adapterStats. This file contains all the Adapter Statistics entries for the 
current installation of VNE Server, and can be read in any text editor. Starting 
and stopping services does not affect the contents of the file, so it provides an 
extended history of adapter operation. For this reason, adapterStats.txt is a 
good file to include with Tech Support problem reports. For more on filing 
support calls, see Filing an OPNET Technical Support Case on 
page VNE-A-21.
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Procedure 2-7   Open Adapter Statistics

1 Select View > Adapter Statistics from the Console menu bar. 

➥ VNE Adapter Statistics opens as shown below. 

2 Choose any of the following options from the File menu.

Open Adapter Statistics File—Displays the entire stat file contents. 

Clear—Clears the window display. The adapterStats file remains intact. 

Close—Closes the Adapter Statistics window. 

End of Procedure 2-7

Console Control Menu 

The Console Control menu provides the selections shown in Table 2-5. The 
Start and Stop selections allow you to control activation of VNE Server services. 
Adapter data collection occurs while the framework services are running. 
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From this menu, you can also open the Management Console. The 
Management Console provides the configuration environment for VNE Server. 
The Management Console allows you to configure adapters, schedule them, 
and maintain device access information. 

Starting VNE Services 

Start VNE services from the Control menu as follows:

Procedure 2-8   Start VNE Services

1 Select Control > Start VNE Services from the Console menu bar. 

➥ A progress box appears, which will display initialization information about 
service start-up. If services fail to start, a message box appears with failure 
information. 

Note—When service initialization is complete, the Console elapsed time clock 
starts counting. As system events occur, depending upon adapter scheduling, they 
will be displayed by the Console. 

End of Procedure 2-8

Stopping VNE Services

Stop VNE services from the Control menu as follows:

Procedure 2-9   Stop VNE Services

1 Select Control > Stop VNE Services from the Console menu bar. 

➥ A confirmation box prompts you for whether or not you want to stop services. 

2 Press Yes to stop services. 

End of Procedure 2-9

Table 2-5   Control Menu Summary

Menu Item Description 

Start VNE Services Starts the VNE Server service framework. 

Stop VNE Services Stops the VNE Server service framework. 

Management Console... Opens the Management Console. 

End of Table 2-5
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Starting the Management Console

Start the management console from the Control menu as follows:

Procedure 2-10   Start the Management Console

1 Select Control > Management Console from the Console menu bar. 

➥ The Management Console appears. 

End of Procedure 2-10

Console Data Menu 

The Console Data menu provides the selections shown in Table 2-6. The user 
interfaces for the utilities listed are covered later in this chapter. 

Start the report manager or network browser from the Console Data menu as 
follows:

Procedure 2-11   Start the Report Manager

1 Select Data > Report Manager from the Console menu bar. 

➥ The Report Manager appears. 

End of Procedure 2-11

Procedure 2-12   Start the Network Browser 

1 Select Data > Network Browser from the Console menu bar. 

➥ The Network Browser appears. 

End of Procedure 2-12

Table 2-6   Data Menu Summary

Menu Item Description 

Report Manager... Opens the Report Manager. The Report Manager is available 
regardless of whether VNE services are running. 

Network Browser Opens the Network Browser. 

End of Table 2-6
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Console Help Menu 

The Console Help menu provides the selections shown in the menu summary 
table. From the Help menu, you can open the documentation package in 
Acrobat. The About VNE Server selection provides release information, a legal 
statement, and build manifest information for this product. 

Event Viewer 

The VNE Server Console provides a high-level view of adapter and service 
operation. As each adapter or service runs, system events are generated that 
log low-level operations. To view these event logs, use the Event Viewer. 

The event logs show adapter startup and work in progress events, and mark 
adapter completion. Some examples of logged events are 

• Device login progress via telnet, Secure Shell, or other methods

• Device or third-party NMS access problems

• Adapter progress as collected files are parsed and converted to XML

• VNE-XML Import progress and network merge activities

• Device, interface, and link creation

• Deletion of network attributes from database by the Database Aging Service

• Event-based scheduling activity

• Network export activity

Events are assigned a color-coded severity ranging from Emergency to Debug. 
The Event Viewer gives you the ability to configure and filter the events to be 
shown. An example of the Event Viewer is shown below. 

Table 2-7   Help Menu Summary

Menu Item Description 

VNE Server Help... Opens the VNE Server documentation menu. 

About VNE Server... Opens information panels regarding VNE Server. 

End of Table 2-7
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Figure 2-7   Event Viewer 

Event Information

During VNE Server operation, the Event Viewer shows service framework and 
adapter events in the event display area. Each event has a severity ranging from 
Emergency to Debug level that has a corresponding color code. The 
color-coded event summary area along the left side of the Event Viewer window 
shows the total number of events of each severity that lie within the viewer’s 
event buffer.

Event Summary Area Event Display Area

Table 2-8   Event Color Codes  (Part 1 of 2)

Event Level Color

Emergency Red

Alert Violet

Critical Orange

Error Yellow

Warning Bright Green
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Each event appearing in the display area is also written to an ASCII log file that 
is located in the VNE Server log directory. Each event provides the following 
information: 

• ID—an event ID number 

• Source—the source adapter for the event 

• Date—the event date 

• Time—the event time 

• Priority—the event severity 

• Description—a brief description of the event 

• Data—additional data about the event 

Event Selection and Navigation

Events can be viewed in a number of ways: 

• Use a scroll bar on the right side of the Event Viewer window to scroll through 
the event display area. 

• Click on an event severity category in the event summary area to only show 
events of a specific severity in the event display area. 

• Use the event filter to select events for display based upon time, source and 
severity. 

• Double-click on an event in the display area to open an Event Detail window.

You can display events of a specific severity by clicking the mouse on the 
severity color in the event summary display. When doing so, only events of the 
selected severity appear in the display area. This display mode is useful for 
looking at Error or Critical severity events. Click on the total event count block 
at the top of the event summary display to restore display of all events in the 
display area. 

Notice Dark Green

Information Turquoise

Debug Teal

End of Table 2-8

Table 2-8   Event Color Codes  (Part 2 of 2)

Event Level Color
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The Event Viewer View menu provides a Filter Events dialog that is used to 
select events for display based upon source, time, and severity. The event filter 
is the best way to view all the events from specific adapters. This dialog lets you 
specify a time interval and event severity for the events that are shown. 

Procedure 2-13   Filter Events in Display Area

1 Select View > Filter Events from the Console menu bar. 

➥ The Filter Options dialog opens. 

2 Use the time selection controls to apply a start time, end time, or both, to the events 
shown. 

3 Use the event source checkboxes to select the events to be shown. 

4 Use the event severity checkboxes to select the severity class to be shown.

5 Press the Apply button to apply the event filter to the display area.

Note—Press cancel to exit without applying any event filter changes.

6 Press OK to exit the Filter Options dialog.

Note—To remove any filtering from the events displayed in the Console, check all 
adapters and all severities (except Debug). Press OK.

End of Procedure 2-13
VNE-2-20 VNE Server/Release 3.0



VNE Server User Guide 2—User Interface
An event filtering example is illustrated in Figure 2-8. In this example, the Filter 
Options panel settings filter the events shown in the Console to those of 
Warning or Error severity that were generated by the Device Config File 
Collection adapter. In this example, no time settings were specified for the event 
filter.

Figure 2-8   Filtering the Event Viewer Display 
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Procedure 2-14   View Events in Event Detail Window

1 Select the event you wish to see in a detail window by double-clicking on the event 
in the display area. 

➥ The Event Detail window opens. 

2 You can use the Previous and Next buttons to display surrounding events in the 
Event Detail window. 

3 Press Close to exit the Event Detail window. 

End of Procedure 2-14

Event Viewer File Menu 

The File Menu provides the selections shown in the menu summary table. 

Table 2-9   Event Viewer File Menu Summary

Menu Item Description

New Console... Opens a new Event Viewer window. Choose between Live Log 
and File Log options. 

Save As Saves the currently displayed events into a user specified file. 

Close Closes the current Event Viewer session. 

End of Table 2-9
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• The New Console selection opens a new Event Viewer window. This 
selection has two choices: Live Log and File Log. 

— The Live Log selection opens an Event Viewer that shows new events as 
they are created by the system. 

— The File Log selection prompts you for an event log file, and opens an 
Event Viewer window that shows the events in the selected log file. A File 
Log viewer window is only used to view past events. 

• The Save As selection lets you save events currently shown in the Event 
Viewer to a log file. This log file can be read by a Event Viewer File Log 
viewer. 

Note—When combined with the event filter, the Save As option is the best way 
to capture events related to a problem for use by OPNET Technical Support. For 
more information on filing a case with OPNET Technical Support, see Filing an 
OPNET Technical Support Case on page VNE-A-21.

• The Close selection closes the Event Viewer window. 

Event Viewer View Menu 

The Event Viewer View menu provides the selections shown in Table 2-10. This 
menu contains all of the Event Viewer view control options. 

Table 2-10   View Menu Summary

Menu Item Description

All Events Displays all VNE Server events in the Event Viewer. 

Filter Events... Opens a dialog window that allows you to filter the events to be 
displayed based upon time, event source, and severity. 

Newest First Displays the most recent events at the top of the event display. 

Oldest First Displays the oldest events at the top of the event display. 

Rows... Selects the number of events to be displayed by the Event 
Viewer. 

Columns... Selects the columns to be displayed by the Event Viewer. 

Event Refresh... Controls the event refresh rate used by the Event Viewer. 

Clear Clears the Event Viewer event display. 

Refresh Repaints the current Event Viewer display. 

End of Table 2-10
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Using the Console to Monitor VNE Server 

The VNE Server Console provides several UIs that allow you to monitor product 
operation. This section summarizes the benefits provided by each UI. 

Console Status Panels 

Use the System Status and Adapter Status panels provided by the Console to 
see which adapter or service is currently running. With these panels, you can 
determine which adapters and services have recently run, and which ones are 
about to run. These panels also show scheduling details about each adapter 
and service. The Status panels provide you with a high-level view of VNE Server 
operation. 

Event Viewer 

Use the Event Viewer to monitor event-level adapter and service operation. 
With the Event Viewer, you can see problems with adapter data collection or 
with the VNE Server environment. The Event Viewer provides you with a 
low-level view of VNE Server operation. 

Adapter Statistics 

Use the Adapter Statistics summary to monitor the outcome of each adapter 
session. This summary shows the sequence, duration, and key statistics of 
each adapter. Adapter Statistics provides you with a summary view of VNE 
Server operation. 

Management Console 

The Management Console gives you control over VNE Server system 
properties and configuration and is the interface used to configure the product. 
With the Management Console, you can do the following tasks: 

• Define a project name to be used with the database 

• Change the database account information

• Configure adapter properties

• Configure adapter schedules 

• Manually run adapters

• Manage adapter merge priority

• Manage device access information

• Manage log file size and event log retention policy
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User Interface Elements

The Management Console is organized as tabbed panels that group together 
related properties. The panels provided by the Management Console are

Viewing and Editing Properties 

The Management Console supports complex and simple properties. Complex 
properties are composed of other properties, both compound and simple. 
Simple properties have no children, which means that these properties are leaf 
nodes in the property tree. The properties in each panel are organized in an 
expandable, collapsible treeview. When you click on a property, it is highlighted 
and becomes the focused property. Complex properties are displayed with a file 
handle. 

• To expand a complex property, click on the file handle when it shows a “+”. 

• To collapse a complex property, click on the file handle when it shows a “-”. 

To change a simple property, click on the property. Depending upon the type of 
data represented by the property, a pull-down menu, text field, file or directory 
selector will appear for you to specify changes to the property. After you have 
edited the property, click on a nearby property to shift focus away from the 
property just changed. The changes just made to the edited property are now 
visible. 

Table 2-11   Management Console Panels

Panel Description

Project Properties Contains global properties.

Database Properties Contains database access properties.

Device Info File Contains the location of the device file used by the 
Device and Platform Info panel to store device 
information.

Device and Platform Info Contains device access information.

Adapter Schedule Contains adapter schedules.

Adapter Priority Contains adapter priority properties.

Adapter Resources Contains adapter configuration properties.

Font Properties Contains UI appearance properties.

Merge Rules Contains the merge rules for nodes, links and 
groups.

End of Table 2-11
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The properties supported by the Management Console are stored in resource 
files located in the <install dir>\lib\xml\res directory. When you save changes to 
properties in the Management Console, these files are updated with the new 
value of the property. Changes to properties in the Adapter Resource panel are 
used the next time that the affected adapter runs. Changes to other properties 
take affect when VNE Server services are stopped and restarted. 

The bottom of each Management Console panel has the following control 
buttons. 

• Apply—Saves changes to the resource files. 

• OK—Saves changes to the resource files and closes the console. 

• Cancel—Closes the console without saving property changes. 

Advanced Editing 

The Management Console provides the ability to clone, copy, paste, and delete 
both complex and simple properties. The following buttons are provided in the 
panels that support this capability: 

Table 2-12   Buttons Used When Editing Properties

Button Description Details

New Child Creates a child property under a 
complex property.

The New Child button is only available when a 
complex property has focus. Clicking on this button 
opens a dialog from which you choose whether the 
new property is simple or complex. The newly 
created property is a child of the property under 
focus when the New Child button was pressed. 

New Sibling Copies the property to a new, 
adjacent property.

The New Sibling button is used with both simple and 
complex properties. This button clones the property 
under focus when New Sibling is pressed. The new 
property is placed at the same level, and adjacent to 
the focused property. A good example of the use of 
this button is to add an additional MRTG server to the 
configuration for the MRTG adapter. 

Copy Copies a property to a paste 
buffer.

The Copy button is used to copy simple or complex 
properties to the paste buffer.

Paste Creates a new property from the 
paste buffer.

The Paste button is used to paste the properties in 
the paste buffer to a child position under a complex 
property. 

Delete Deletes the property under focus. The Delete button simply deletes the property which 
has focus. A confirmation box asks if you really want 
to delete the property.

End of Table 2-12
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After you create a new child or sibling property, you can click on the property 
name to get focus on the name, and then change the name. This is useful when 
creating new Concord, MRTG, or ASCII import properties because you can give 
a meaningful name to the new property. 

WARNING—When you use New Sibling, New Child, or Paste to create a new, 
complex property, press the Apply button to save the new property before doing 
any further edits to the property. Doing so ensures that the changes are saved 
properly to the underlying resource file. After the new property is saved, you can 
rename the property or do additional editing. 

Note—When you add properties to a tree, they always go to the end of the list. 

The ability to clone and copy properties and customize them is required in 
several circumstances: 

• Adding a new device type to the Device Config File Collection setup. 

• Extending the collection dialog in Device Config File Collection setup. 

• Adding additional Concord, InfoVista or MRTG servers. 

• Adding additional ASCII Generic Data Import override files. 

The remaining sections discuss each Management Console panel and its 
properties. 
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Project Properties

The Project Properties panel contains global properties that describe the VNE 
Server operating environment. The properties supported by this panel are 
shown below. 

Note—Properties in this panel that are not described in more detail here are 
fixed properties that require no user action. They are set during installation 
based upon the install path. 

Refer to Managing Projects on page VNE-5-5 in the Administration chapter for 
more information about choosing a project name. 

VNESfeatures Property Tree

The VNESfeatures property tree supports the following features: 

• archiving—Controls archiving of element history (TRUE/FALSE).

• logging—Manages the RMID log file. 

When the archiving property is set to TRUE, element history is maintained in 
the database. This allows reports and the network browser to show details 
about the original, previous, current, and most recently observed values of a 
network attribute. When archiving is set to FALSE, no element history is 
maintained. 

Table 2-13   Project Properties 

Property Description

projectName The project name used for data storage.

rootTempDir The location of the temp file directory (Not supported).

rootLockDir The location of the lock file directory.

deviceMap The location of the device map file.

port number to application type 
map

The location of the port definitions file.

adapterStatsDir The location of the adapter statistics log.

VNESfeatures Used to configure database archiving and RMID logging. 
See VNESfeatures Property Tree for more information.

debug Used to enable debug mode and set debug level.

End of Table 2-13
VNE-2-28 VNE Server/Release 3.0



VNE Server User Guide 2—User Interface
The logging properties control logging of RMID events. The shouldLogToFile 
property turns on logging when set to TRUE. The other properties set the file 
name, location, and maximum size. 

Device Info File

The Device Info File panel contains properties that describe the device info file. 
This is the file used to populate the device info table in the Device and Platform 
Info panel. The device info file provides access information (addresses and 
login information) for the devices that VNE Server polls. The properties 
supported by this panel are shown below. 

• Device Info File Location—Points to the device info file. The default 
location and name of the device info file is: <install 
dir>\input\DeviceInfo\deviceInfo.txt. The device info file can be named 
anything, and be located anywhere as long as this property points to the file. 
The Device and Platform Info panel uses the properties in this panel to 
access the device file.

• delimiter—Field separation delimiter for the device file. The default field 
delimiter for the device info file is a tab. The other choices from the delimiter 
pull-down menu are: comma, semicolon and space. 

Note—Consider placing the device info files for your networks outside of the 
VNE Server installation directory. Doing so eliminates the need to copy device 
info files from an old installation directory to a new directory following a software 
upgrade. 

Device and Platform Info 

The Device and Platform Info panel is used to manage the device access 
information that VNE Server uses to poll devices in your network. This panel 
supports the following tasks: 

• Importing device access information from CiscoWorks, Concord or HP 
OpenView files. 

• Importing device access information from the VNE Database. 

• Adding new devices to the device access list. 

• Removing devices from the device access list. 

• Changing access information for an existing device. 

• Enabling or disabling of data collection for devices. 
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An example of the Device and Platform Info panel is shown below. 

Figure 2-9   Device and Platform Info

The visible fields in each device entry are

Table 2-14   Fields for Device and Platform Info Panel

Field Description

Device Name Specifies the hostname of the device.

Access Address Specifies the network address used to access the 
device.

telnet username Specifies the username for telnet or SSH access.

telnet password Specifies the password for the telnet or SSH account.

privileged password Specifies the password for the privileged exec mode.

Read Community Specifies the SNMP read community string.

Device Access Script Specifies the sequence of expected prompts and 
commands (login and show commands) for this device 
type.

Active Activates or inactivates direct collection for the device.

Access Method Specifies non-TACACS, TACACS, or SSH.

End of Table 2-14
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The password and community string fields are encrypted both at the file level 
and in the Device and Platform Info display. 

Note—The device type and vendor subtypes defined for the Device Config File 
Collection adapter in the Adapter Resources panel are used to populate the 
Device Access Script field. 

Format of the Device Info File 

The device info file can also be constructed off-line in an editor such as 
Wordpad or in a spreadsheet program. When doing so, note the fields and order 
shown below. Except for the hidden fields, the fields match the display order. 

• Device Name—hostname of the device 

• Access Address—network address used to access the device 

• telnet username—username used to login to the device 

• telnet password—password used to login to the device 

• privileged password—password for privileged exec mode 

• Read Community—SNMP community string 

• Device Access Script—access script for device vendor or vendor subtype 

• Active—activates all collection types for the device 

• hidden field—an obsolete field that must be present. Set to false. 

• hidden field—an obsolete field that must be present. Set to false. 

• hidden field—an obsolete field that must be present. Set to false. 

• Access Method—non-TACACS, TACACS, or SSH

Valid field delimiters are: tab, comma, semicolon, and space.
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Adding a Device to the Device Info File 

Procedure 2-15   Adding a Device

1 From the Device and Platform Info panel, press Add Device. 

➥ The New Device dialog opens. An example is shown. 

2 Fill in each field with access information about the new device. 

Note—For the Device Vendor and Access Method fields, use the pull-down menu 
to select the correct value for the field. 

3 Press Apply to save the changes. 

Note—Device entry changes do not take effect until VNE Server services have 
been stopped and restarted. 

End of Procedure 2-15

Removing a Device from the Device Info File 

Procedure 2-16   Remove a Device

1 Select the device entry by clicking on the entry. 

➥ The device entry is highlighted. 

2 Press Remove Device. 

➥ The device entry is removed from the table. 
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3 Press Apply to save the changes. 

Note—Device entry changes do not take effect until VNE Server services have 
been stopped and restarted. 

End of Procedure 2-16

Using a CiscoWorks inventory File to Create a Device Info File 

Procedure 2-17   Adding Devices from CiscoWorks Inventory File

Note—To obtain a CiscoWorks inventory file for use in this procedure, refer to 
Collecting a CiscoWorks Inventory File on page VNE-5-39 in the Administration 
chapter. 

1 Press Add Devices from... 

➥ A menu with a list of import sources opens.

2 Select CiscoWorks Inventory File. 

➥ A standard file selection dialog opens. 

3 Use the file selection dialog to select the CiscoWorks inventory file to be imported, 
and press Select.

➥ New devices appear in the device list that have been created from the 
CiscoWorks inventory file.

Note—Devices created from CiscoWorks inventory file are missing information 
from some fields. Fill in the empty fields before you save the changes.

4 Press Apply to save the changes. 

Note—Device entry changes do not take effect until VNE Server services have 
been stopped and restarted. 

End of Procedure 2-17

Using a Concord dci file to Create a Device Info File 

Procedure 2-18   Create a Device Info File from a Concord dci File

1 Press Add Devices from... 

➥ A menu with a list of import sources opens. 

2 Select Concord Config File. 

➥ A standard file selection dialog opens. 
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3 Use the file selection dialog to select the Concord dci file to be imported. Press 
Select. 

➥ New devices appear in the device list that have been created from the Concord 
dci file. 

Note—Devices created from Concord dci files are missing information from the 
following fields: telnet username, Device Type, Access, and Access Method. Fill in 
these fields before you save the changes. 

4 Press Apply to save the changes. 

Note—Device entry changes do not take effect until VNE Server services have 
been stopped and restarted. 

End of Procedure 2-18

Using HP OpenView NNM Server to Create a Device Info File

Procedure 2-19   Create a Device Info File Using HP OpenView NNM

1 Press Add Devices from... 

➥ A menu with a list of import sources opens. 

2 Select HP OpenView NNM Server. 

➥ An import dialog opens as shown. 

3 Fill in the server access fields and press Import. 

➥ New devices appear in the device list that have been created from the HP 
OpenView NNM Server. 

Note—Devices created from HP OpenView are missing information from some 
fields. Fill in the empty fields before you save the changes.

4 Press Apply to save the changes. 

Note—Device entry changes do not take effect until VNE Server services have 
been stopped and restarted. 

End of Procedure 2-19
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Using the Contents of the VNE Database to Create a Device Info File

Procedure 2-20   Create a Device Info File from VNE Server Database

1 Press Add Devices from... 

➥ A menu with a list of import sources opens. 

2 Select VNE Database. 

➥ Devices in the database are added to the device list in the Device and Platform 
Info panel. Devices are inactive, by default.

3 Click on the checkbox in the Active field to enable collection from a device. 

4 Check each field in the entry and correct or add data as needed to complete the 
entry. 

Note—Cisco devices are populated as using a Device Access Script named Cisco 
Systems. For these devices, change the Device Access Script to Cisco. 

Note—Device entry changes do not take effect until VNE Server services have 
been stopped and restarted. 

End of Procedure 2-20

Using the Active Checkbox to Control Device Data Collection 

The Active field in the Device and Platform Info table controls whether data 
collection occurs for a given device. When checked, adapters such as Device 
Config File Collection and Device MIB Configuration Import attempt to collect 
data from the device. When unchecked, the device is skipped during data 
collection. 

The main use of the Active field is to change collection status of a device for 
troubleshooting purposes. This can be done on a device by device basis, or for 
each device in the table. 

• To enable or disable collection for all devices in the table, right-click in the 
Active field heading to open a menu. The menu choices are: all active and all 
inactive. Choose one to change the state of all devices to the desired state.

• To work with a small number of devices, disable all using the Active menu, 
and click in the Active check boxes to enable the devices you want to test. 
When done, use the Active menu to enable all devices for operational data 
collection.
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Backup the Device Info File 

When device access configuration is complete for your network, you should 
save the device info file somewhere outside of the VNE Server environment. 
Should the operational file within the VNE Server environment become corrupt 
for some reason, recovery is easier if you work from a backup copy. You can 
also recover by populating a new file from the VNE Database, as previously 
described. 

Adapter Schedule 

The Adapter Schedule panel controls the scheduling policy for each adapter. 
With this panel, you can enable or disable each adapter, create one or more 
schedules for each adapter, or manually run an adapter. 

VNE Server provides complete flexibility with adapter scheduling. Both time- 
based and event-based scheduling are supported. 

• With time-based scheduling, adapters are set up to run at specified times or 
intervals. 

• With event-based scheduling, an adapter is triggered to run by an event 
raised from another adapter. Event-based scheduling allows you to chain 
adapters together in a sequence.

More than one schedule can be created for an adapter (using New Sibling) with 
all the schedules being jointly active. 
VNE-2-36 VNE Server/Release 3.0



VNE Server User Guide 2—User Interface
Additionally, an adapter can also be manually run at any time by pressing the 
Run Now button for the Manual schedule. An example of this panel is shown in 
Figure 2-10. In this example, the Device Config File Collection adapter is 
enabled. The Custom schedule provides a 1 minute delay between the start of 
VNE Server services and first execution of this adapter. A 12 hour cycle time 
means that this adapter runs every 12 hours.

Figure 2-10   Time-Based Scheduling

An example of event-based scheduling is shown in Figure 2-11. In this example, 
the Device Config File Collection adapter is enabled and will be triggered by the 
Service End event from the Interface Utilization Rollup Service. Whenever the 
Interface Utilization Rollup Service finishes running, it raises a Service End 
event. The VNE Server scheduler uses this event to trigger the Device Config 
File Collection adapter to run. 

Cycle offset

Cycle duration

Adapter name
Activation state

Schedule type

Run the adapter now.
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Figure 2-11   Event-Based Scheduling

Adapter Priority

The Adapter Priority panel gives you the ability to configure the adapter merge 
priority for each network attribute. Since the data collected by an adapter can 
overlap with data collected from another adapter, VNE Server uses a priority 
scheme to determine which adapter’s data is used in the network model. The 
goal is to always use the most trustworthy data for each network attribute. The 
default settings for adapter priority should produce the most accurate network 
model. The Adapter Priority panel provides the ability to configure merge 
priorities, should you need to alter merge priorities. 

For each network attribute listed in this panel, you can 

• Set a merge priority from 1..n for each adapter’s data

• Set a clean threshold from 1..n for each adapter’s data

• Control whether the adapter can create a new device, interface or 
subinterface

• The lowest merge priority number represents the most trustworthy data. 
That is, data from an adapter with a merge priority of 1 will replace data from 
an adapter with a merge priority of 2 or greater. 

Schedule type: event Trigger event 

Trigger source
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• The clean threshold represents the number of times an adapter runs, 
without seeing a network attribute that it introduced, before the Database 
Aging Service removes the attribute from the network model. 

• The Can Create property controls whether an adapter is allowed to introduce 
a new node, interface or subinterface to the network model. This property is 
useful for preventing stale data from being introduced to the network model 
from third-party NMS platforms. 

An example of the Adapter Priority panel is shown in Figure 2-12. In this 
example, the linkList linkType attribute is expanded to show which adapters can 
contribute link data to the network model. The ASCII Generic Data Import 
adapter has the most trustworthy data, since you create it, and is assigned a 
merge priority of 90. The Link and Connection Inference adapter has the next 
most trustworthy data, and is assigned a merge priority of 100. The HP 
OpenView NNM Import adapter and Trace Route Link Inference Service can 
also create links, but have lower priorities since their data is less trustworthy. 
Each adapter has a clean threshold of 2 and is allowed to create a link. 

Figure 2-12   Adapter Priority Panel 

Adapter Resources

The Adapter Resources panel contains the configuration properties for each 
adapter and service offered by VNE Server. Each time an adapter runs, it 
initializes itself from the properties contained in this panel. Some examples of 
adapter properties are

• Timeout and retry values governing device access by the adapter 

• Vendor specific configuration collection commands 
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• Platform and database access properties for third-party NMS platforms 

• The location of working directories or control files 

The Adapter Resources panel uses the same expandable property treeview that 
is used throughout the Management Console. Each adapter has its own 
property tree. For more information about each adapter and its configurable 
properties, refer to the Adapters and Services chapter. 

Font Properties 

The Font Properties panel gives you control over the visual appearance of menu 
labels, menu items, table headers and tooltips. In this panel, you can change 
the font name, style and size for each property. The changes effect menu 
appearance in the Console, Network Browser and Report Manager. Property 
changes take effect after you exit and re-enter VNE Server. 

Merge Rules 

The Merge Rules panel gives you the ability to configure the rules used to match 
and merge nodes, interfaces, links and groups into the network model. Each 
category supports multiple rules. Each rule can be set active or inactive and has 
a weight property that determines which data merge rule takes precedence. 

Report Manager 

The Report Manager gives you the ability to view predefined reports about the 
network information collected by VNE Server. A wide selection of reports are 
available, ranging from node, interface, and link summaries to device level 
access lists and routing tables. Report Manager gets the information from the 
network database and formats it for display. Once displayed, the report can be 
searched, sorted, detached, printed, or exported to text, HTML, or CSV formats. 

Report Summary 

The Report Manager provides access to reports from the following categories: 

• Configuration—Reports containing network configuration information. 

• Inventory—Reports containing network inventory information. 

• Utilization - Reports containing interface utilization information. 

• Demands—Reports containing traffic demand information. 

• Troubleshooting—Reports containing troubleshooting information about 
data collection, import and the content of the network model. 
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A summary of the reports by category is provided in the following tables. 

Table 2-15   Configuration Reports 

Report Title Description 

Access List Statistics Displays access list statistics such as the number of access lists, average 
lists per device and lines per list. 

Access List Summary Displays the Access Lists on each device. 

Adapter Discrepancy Displays network attributes for which data sources show differing values. 

Configuration Summary Displays a network-wide total of the number of devices and interfaces 
configured for each protocol. 

Group Membership Configuration Displays the device groups defined for the network, group members and 
subgroups contained in groups. 

Import Blocker Summary Displays devices and attributes for which import blocking has been 
configured, 

Interface (Port) Status Summary by Group Displays interface (or port) status for each device in a defined group. 

Interface (Port) Status Summary by Group 
- Detailed 

Displays more details on interface status across groups and devices 
broken out by interface type. 

IP Routing Table Displays the IP routing table for each device. 

LAN Interface (Port) Status Summary by 
Group

Displays LAN interface (or port) status for each device in a defined group. 

LAN Interface (Port) Status Summary by 
Group - Detailed 

Displays more details on LAN interface status across groups and devices 
broken out by interface type. 

Neighbor Discovery Protocol 
Configuration 

Displays whether a neighbor discovery protocol such as CDP is enabled 
for each device interface in the network. 

Network Summary Displays summary statistics of network content - devices by vendor, 
interfaces and links by type. 

Router Protocols Displays the protocols for each device and interface. 

Router Protocol Summary - OSPF Displays OSPF areas and statistics about the number of devices and 
interface types in each area. 

Router Protocol Summary - EIGRP Displays EIGRP processes and statistics about the number of devices and 
interface types in each process. 

(Report Group) System Change - Last 
(time period) 

Displays a summary of detected system changes over the time interval 
specified in the report title. 

End of Table 2-15
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Table 2-16   Inventory Reports  (Part 1 of 2)

Report Title Description 

Adapter Collection Displays the adapters that have collected data on the devices and interfaces 
in the network. 

Adapter Discovery Displays the network elements that have only been detected by a single 
adapter. 

Alias Summary Shows the alias name (a network address) associated with each device in 
the network. 

Asset Inventory Displays the hardware configuration of each device in the network. 

ATM PVC Summary Displays ATM PVCs by link type for each device. 

ATM SVC Summary Displays ATM SVCs by link type for each device. 

ATM-FR PVC Summary Displays ATM-FR PVCs by link type for each device. 

Autonomous System Summary Displays the devices in each Autonomous System in the network. 

Chassis Module Summary Displays the modules in each device chassis. 

Connected Components Displays the connected component to which each device belongs. 

Device Address Displays interface, address, and chassis information for each device in the 
network. 

Device and Vendor Summary (System 
Object ID)

Displays a network-wide total of the number of devices by vendor, and model 
(sysoid for chassis). 

Device and Vendor Summary (System 
Description) 

Displays a network-wide total of the number of devices by vendor, and model 
(sys descr for chassis).

Discovered Neighbors Displays the discovered neighbors for each device. 

DNS Alias Summary Displays DNS alias for each device interface. 

FR PVC Summary Displays the Frame Relay PVCs in the network. 

Interface (Port) Status Displays totals for interface types by vendor. 

Interface Summary Displays interface details for each device. 

IP Subnets Displays the IP subnets and device addresses on each subnet for the 
network. 

IP Static Routes Displays the static routes for each device. 

Link Summary Displays the links found in the network. 

Node Connections Displays device connections to other devices. 
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Node Summary Displays the devices found in the network. 

Physical Link Summary Displays the physical links in the network. 

Routing Module Summary Displays the routing modules and their host device chassis, 

Software Version Summary Displays a network-wide total of the number of devices at a specific software 
version. 

VC Summary Displays a virtual circuit summary across all technologies.

Traffic Rollup Summary Displays statistics on the utilization rollup by source and category. 

Voice Connection Summary Displays voice connections by link type, device and interface. 

End of Table 2-16

Table 2-16   Inventory Reports  (Part 2 of 2)

Report Title Description 

Table 2-17   Utilization Reports 

Report Title Description 

(Report Group) ATM and FR PVC 
Utilization 

Displays ATM and Frame Relay PVC utilization statistics by collector type 
(eHealth, MRTG etc.)

Interface Util - MIB - Based - Top 5 Displays interface utilization statistics obtained from VNE Server’s 
MIB-Based Interface Utilization Import adapter. 

Interface Util - eHealth - Top 5 Displays interface utilization statistics obtained from a Concord eHealth 
system. 

Interface Util - MRTG - Top 5 Displays interface utilization statistics obtained from a MRTG server. 

Interface Util - StatScout - Top 5 Displays interface utilization statistics obtained from a StatScout server. 

Interface Util - InfoVista - Top 5 Displays interface utilization statistics obtained from an InfoVista server. 

Interface Util - All Collectors/All Samples Displays interface utilization statistics obtained from all adapters. Shows all 
samples. 

Physical Link Utilization - eHealth Displays utilization for the network’s physical links. 

End of Table 2-17
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Table 2-18   Demands Reports 

Report Title Description 

Demands - Source/Destination Pairs - 
Last Hour 

Displays the last hour of DetailCallRecords for each source, destination 
pair. 

Demands - Subnet Traffic - Last Hour Displays the last hour of DetailCallRecords for each subnet. 

Demands - Application Types - Last Hour Displays the last hour of DetailCallRecords by application type. 

Demands - Summary of Mapped and 
Unmapped Demand Endpoints 

Displays the number of mapped and unmapped demand endpoints. 

Demands - All Demand Records Displays all traffic demand records. 

End of Table 2-18

Table 2-19   Troubleshooting Reports  (Part 1 of 2)

Report Title Description 

Adapter Merge Warnings (Devices 
merged) 

Adapter Merge Warnings (Interfaces 
merged)

Chassis -- missing routing modules Displays device chassis in the network that do not appear to contain routing 
modules. 

Device Config File Collection Errors Displays a list of devices for the latest config file collection cycle that had file 
collection problems. 

Device MIB Configuration Import Errors Displays a list of devices for the latest MIB collection cycle that had collection 
problems.

Duplicate IP Address Displays devices in the network with duplicate IP addresses. 

Duplicate Interface Indexes Displays devices in the network with duplicate interface indexes. 

Duplicate MAC Address Displays devices in the network with duplicate MAC addresses. 

Duplicate Serial Numbers Displays devices in the network with duplicate module serial numbers. 

Duplicate sysNames Displays devices in the network with duplicate sysNames. 

Invalid Files Displays information about collected config files that are viewed as invalid and 
cannot be processed. 

Isolated Node Summary Displays a list of devices that are not connected to anything else in the 
network. 
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Starting the Report Manager 

Procedure 2-21   Starting the Report Manager

1 Select Data > Report Manager from the Console menu bar. 

➥ After a brief delay, the Report Manager window opens. An example is shown 
below. 

End of Procedure 2-21

Neighbors Not Found in Model Displays a list of devices that are not in the network model, but are seen as 
neighbors to devices in the network model (via CDP and equivalent 
protocols). 

Network Troubleshooting Snapshot Displays a snapshot summary of network troubleshooting information. 
Contains connectivity summary, collection error summary and more. 

Routing Modules -- missing chassis Displays a list of routing modules that appear to not have a parent chassis. 

SysName Not Set Displays a list of devices for which the sysName has not been set. 

SysName-Prompt Mismatch Displays a list of devices where the sysName and prompt do not match. 

End of Table 2-19

Table 2-19   Troubleshooting Reports  (Part 2 of 2)

Report Title Description 

Tool bar buttons, left to right:
Print
Export
Reload
Detach
Search
Fit

Report Selections

Report Status 
Progress bar

Report Categories 
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In addition to a standard menu bar, the Report Manager consists of a tool bar, 
a Report Categories menu, a Report Selections menu, a Report Subsets menu, 
a report display area, a status line, and a progress bar. 

Selecting Reports 

The Report Manager provides a growing list of reports. To make it easier to find 
the report you want, the report list can be grouped by subject. The left panel of 
the Report Manager window is divided into the following areas: Report 
Categories, Report Selections, and Report Subsets. The selections made in the 
Report Categories and Report Subsets areas determine what reports are 
displayed in the Report Selections area. To view a report, choose a selection 
from the Report Selections area. 

The Report Categories are: All Reports, Configuration, Inventory, Utilization, 
and Demands. When you select a category in the list, the list updates the report 
choices displayed in the Report Selections area, grouping them by category. 

The Report Subsets are: None, ATM, Frame Relay, IP, LAN, Link and Node. 
When you select a subset in this list, the list updates the report choices 
displayed in the Report Selections area, grouping them by subset. 

Viewing a Report 

Procedure 2-22   Viewing a Report

1 (Optional) Use Report Category and Report Subset selections to prune the list of 
reports displayed in the Report Selections area.
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2 Select the report that you want to view from the reports listed in the Report 
Selections area. 

➥ The report progress bar indicates that the report is being retrieved. When 
retrieval is done, the selected report is displayed in the display area. An example 
is shown. 

Note—The report status line indicates any errors that occur during report 
generation. 

End of Procedure 2-22

Altering the Appearance of a Report 

Once a report is displayed, you can alter its appearance. You can resize the 
Report Manager window or individual columns. You can also rearrange columns 
by dragging them to a new location. To do this, click on the column, hold down 
the mouse button, and drag the column to its new location in the report display 
area.The bar that divides the left and right display areas is movable so you can 
create more display room in one of the areas. 

Printing and Exporting a Report 

Once a report is displayed, you can print it, or export it to a file. To print the 
report, select File > Print from the menu bar. To export a report, select File > 
Export from the menu bar. An Export Report dialog opens. Use this dialog to 
choose between ASCII or HTML file formats. Select a file name for the exported 
report. For ASCII formats, choose between Space, Tab, and Other for the field 
delimiter. Press OK to export the report. 
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Searching a Report 

Once a report is displayed, you can search the report by pressing the Search 
button on the tool bar. A Search dialog box opens. Enter the search string in the 
Find: text-field, and press Find Next or Find All. The Find Next button locates 
and highlights the next search match. The Find All button locates and highlights 
all matches in the report. Other search options allow you to ignore case, match 
a word, or to search backward. 

Comparing Reports 

The Report Manager provides a tool bar button for detaching a report from the 
main Report Manager window. The detach feature is useful for looking at 
several reports and comparing data between them. A detached report is 
displayed in a “tear-away” report window which has no menus or buttons. To 
detach the report currently being displayed in the Report Manager window, 
press the Detach button. An example of detached reports is shown below. 

Figure 2-13   Detached Reports
VNE-2-48 VNE Server/Release 3.0



VNE Server User Guide 2—User Interface
Viewing Element History 

Some report fields contain element history. This is defined on a report by report 
basis for each field. Element history for a network attribute shows which 
adapters have seen the attribute and when they collected the data. 

Procedure 2-23   Viewing Element History

1 Select and view the report of interest. 

➥ The selected report opens in the Report Manager display area. 

2 Click on the network attribute 

➥ The selected report field is highlighted. 

3 Right-click the mouse to open an options menu. 

➥ An options menu opens. 

4 Select element history from the options menu. 

➥ A window opens and shows element history for the selected attribute. 

End of Procedure 2-23
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The following two windows show how to display element history for an interface. 

Figure 2-14   Selecting Element History for an Interface

1) Select an attribute
2) Right-click to open an options menu
3) Select element history
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Figure 2-15   Element History for an Interface

Report Manager File Menu 

The Report Manager File menu provides the selections shown in the menu 
summary table.

Table 2-20   File Menu Summary

Menu Item Description 

Reload Reloads the current report. 

Export... Exports the current report to ASCII text or HTML file. 

Print... Prints the current report. 

Close Closes the Report Manager. 

End of Table 2-20
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Report Manager Options Menu 

The Report Manager Options menu provides the selections shown in the menu 
summary table.

Table 2-21   Options Menu Summary

Menu Item Description 

Cache Not supported in VNE Server. 

Table Options Use to fill or clear empty cells. 

Sort Use to sort report columns in ascending or descending order. 
Sorting only works on single-level reports. 

Show Use to show or hide the Report Category and Report Subset 
selection areas. 

End of Table 2-21
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Network Browser 

The Network Browser provides a Windows Explorer style UI for viewing your 
network. The browser is updated dynamically as network data changes occur. 
The browser window is divided into 2 panels: navigation and display. 

The navigation panel provides an expandable treeview of your network. At the 
top level of the view is the network. The network consists of devices, which 
contain interfaces, interface properties, protocol configuration, and many other 
properties. The network also contains links, VLANS and clouds. Network 
elements selected in the navigation panel are shown in the display panel. 

You can also use the Network Browser to delete selected items from the 
network model and to also block import of model attributes and even entire 
devices from one or more sources. 

Starting the Network Browser 

Procedure 2-24   To start the Network Browser, do the following steps. 

1 Select Data > Network Browser from the Console menu bar. 

➥ After a brief delay, the Network Browser window opens. 

Note—When the Network Browser first opens, only the top level Root_Network is 
visible. Click on the expansion handle, or double-click on the Root_Network to 
expand the view to show all network devices and links. Repeat this process to 
expand any property in the network tree which contains other properties. 

End of Procedure 2-24

Once the browser is open and a network element is selected, data pertaining to 
the element appears in the display panel with the following fields: 

• Name—The name of the displayed element. 

• Type—The type of element: Interface, Configuration, Attribute, etc. 

• Current Value—The current value of the element. 

• Previous Value—The previous value of the element. 

• First Value—The first observed value of the element. 

• Observed Value—A list of observed values from each source adapter. 
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Figure 2-16   Network Browser

In the navigation panel, you can right-click on an entry to open a menu with a 
Refresh selection. Clicking on Refresh results in a forced refresh and redisplay 
of the element’s data from the VNE database. 

In the display panel, you can right-click on an entry and open a menu with the 
following selections: 

• View Text—Displays the element in a text field viewer

• History Detail—Displays the element history in a window. You can also 
double-click on an entry in order to display history details.

If Change Markers are enabled in the View menu, elements which are updated 
by the browser are highlighted. Note that this does not mean that the element 
changed value, just that its value is updated. 

Navigation panel Display panel Status line 
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An example of the data for an interface is shown. 

Figure 2-17   Expanded Interface Data in the Network Browser

Updated attributes highlighted by change markers

Data from the selected interface appears in display panel 
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The following figure shows an example of element history for the ifDescr field of 
an interface. In the Observed Values window, the value, source adapter, and 
timestamp are shown for ifDescr. 

Figure 2-18   Using Network Browser to View Element History 

Viewing element history is a good way to spot whether all the adapters that see 
an element are bringing in the same value. For example, an interface ifSpeed 
may not get the same value from all adapters. An adapter that gathers incorrect 
data from an incorrectly configured third-party NMS platform can degrade model 
accuracy. Element history provides a powerful tool for diagnosing this type of 
problem. 

You can also use the Adapter Discrepancy report in the Report Manager for this 
purpose. 

Deleting Network Elements and Blocking Import 

You can use the Network Browser to delete devices or device attributes from 
the network model. You can also mark devices or their attributes so they cannot 
be imported by specific adapters. 

To delete a device or device attribute from the database, select the item in the 
display view and right-click to open a menu. Select Delete from the menu. When 
the deletion request is imported by VNE Server, the selected item is removed 
from the database. 

Double-click to display
Observed Values
(element history) 
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To block import of a device or device attribute, select the item in the display view 
and right-click to open a menu. Select Import Blocker from the menu. A dialog 
box opens as shown below. 

Figure 2-19   Import Blocker Dialog 

Select the adapter you wish to block as data sources for this item and press 
Block Adapters. You can use the shift key to select contiguous groups of 
adapters. Use the CTRL key to select multiple adapters that are not listed 
together. 

if you wish to delete a device or attribute and then block import from a given 
source, block import first and then delete the item. 

Note—Unless you use the Network Browser to delete an item after you block it 
from future import, the device or attribute will persist in the network model until 
the Database Aging Service removes it after the configured number of merge 
cycles. 
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Network Browser Menus 

The Network Browser has the following menus: File, View, and Help. 

• The File menu provides a Close selection that is used to exit the browser. 

• The View menu provides the selections shown in the following table. 

The Help menu gives you a Request Monitor selection that opens a window 
displaying the dialog between the Live Network Browser and the internal Live 
Update Server. The Request Monitor is useful for collecting information for 
OPNET Technical Support. 

For normal operation, leave the Request Monitor closed. To use the Request 
Monitor, VNE Server must be running in debug mode. This mode is set by the 
debug property in the Project Properties panel of the Management Console. 

WARNING—Do not leave the Request Monitor window open for extended 
periods of time. Doing so will result in the use of excessive memory resources. 

Table 2-22   View Menu Summary

Menu Item Description

Historical Data Enable or disable display of attribute history. 

Change Markers Enable or disable display of attribute change (update) 
markers. 

Nodes Enable or disable display of devices (nodes). 

Links Enable or disable display of links. 

Clear Change Markers Clear any attribute change markers. 

End of Table 2-22
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Group Browser

VNE Server provides the ability to define, view and maintain groups of devices 
with the Group Browser. These device groups are used for the following 
purposes: 

• Exporting a portion of the network model 

• Blocking import from specified adapters for one or more devices

By grouping devices, you can reduce the network portions you import into 
OPNET analysis software, based on what you wish to study. With device 
grouping, you can define your network boundary (i.e., the device list) to create 
groups that define an area of study. Defining groups within VNE Server merely 
tags devices within the database as to their group association. No underlying 
reorganization of the database is performed, so there is no performance penalty 
from grouping devices.

Some attributes of device grouping are 

• Devices can appear in more than one group. 

• Grouping can be done while VNE Server services are running. 

• Groups can be used to build larger groups. 

• A group can be composed of both subgroups and individual devices. 
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Using the Group Browser 

Procedure 2-25   Starting the Group Browser

1 Select Control > Group Configuration from the Console menu bar. 

➥ After a brief delay, the Group Browser window opens. 

Note—When the Group Browser first opens, only the top level Root_Network is 
visible. Click on the expansion handle, or double click on the Root_Network to 
expand the view to show all groups. 

End of Procedure 2-25

Procedure 2-26   Create and Populate New Groups

1 Open Group Browser, as described in Procedure 2-25.

2 Right-click on the Root_Network object in the left panel of the browser. 

➥ A menu appears.

3 Select Create New Group in Root_Network.

➥ A dialog box appears.

4 Fill in the Group Name and Group Description fields, and press Create. 

Once a group is created, populate the group with the devices and groups that 
compose the group. 

5 Select the group name in the right panel. 
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6 Right-click to open a menu. 

7 Select Add Node or Add Sub-Group from the menu. 

8 Select the devices or groups to be added to the current group, and press Add to 
Group. 

➥ A dialog box opens as shown below. 

End of Procedure 2-26

Note—Changes made to groups via the Group Browser do not take effect until 
the resulting XML files are imported by VNE Server. After making a group 
change, use the VNE Server Console to monitor import status. 

Note—A special group exists which is named DoNotImport. This group 
contains a list of devices and attributes that are blocked from being imported by 
the selected source. The group also may contain groups and subgroups. 

Once groups are defined and imported into the database, they are visible to 
OPNET analysis software (10.0 PL2 or later) for selection during model import. 
The Import from VNE Server dialog in the OPNET analysis software provides 
panels that are used to select the groups to be imported from VNE Server. Refer 
to the Importing a VNE Server Network Model into the OPNET analysis software 
section in the Operation chapter for more information. 
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While group creation and maintenance is easy, manual group creation can be 
tedious for a large network with many groups. Depending upon the device 
naming conventions used in you network, you may be able to use the Group 
Wizard to ease this task. The Group Wizard allows you to automatically create 
and populate groups based upon the number of common leading characters in 
device names. If you use common device naming prefixes based upon location, 
network hierarchy, or function, you can use the Group Wizard to automate 
group creation. 

Using the Group Wizard 

Procedure 2-27   Starting the Group Wizard

1 Select Tools > Group Wizard from the Group Browser menu bar. 

➥ After a brief delay, the Group Wizard window opens. 

2 Fill in the number of Characters field with the number of common characters in 
your device naming convention. 

3 Fill in the Group Name to Prepend field with any text that you wish to have 
prepended to group names created by the wizard. This field may be left blank. 

4 Press Create. 

End of Procedure 2-27
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Preferences

VNE Server adds the following preferences to OPNET.

vne_import_dbox_start_function

Specifies the name of the function to invoke to start the VNES import wizard.

vne_import_ior_file

Specifies the IOR file that stores information about connecting to VNE Server.

vne_import_post_operation_function

Specifies the name of the function used to perform operations after a VNES 
import.

vne_import_post_operation_library

Specifies the name of the library containing the post-operation function 
specified by vne_import_post_operation_function.

vne_import_postproc_function

Specifies the name of the function to invoke for VNES import post-processing.

Type string

Default Value “Vne_Import_Dbox_Start”

Type string

Default Value “”

Type string

Default Value “Vne_Import_Post_Operation”

Type string

Default Value “vne_import_postproc”

Type string

Default Value “Vne_Import_Postproc_Default”
VNE Server/Release 3.0 VNE-2-63



2—User Interface VNE Server User Guide 
vne_import_process_library

Specifies the name of the library containing the VNES import post-processing 
function specified by vne_import_postproc_function.

vne_import_ssm_directory

Specifies the name of the directory used to store server modeling (ssm) import 
files after VNES import.

vne_import_state_destroy_function

Specifies the name of the function used to destroy the VNES state.

vne_import_state_library

Specifies the name of the library containing the functions used to register and 
destroy the VNES state.

vne_import_state_register_function

Specifies the name of the function used to register the VNES state.

Type string

Default Value “vne_import_postproc”

Type string

Default Value “”

Type string

Default Value “Vne_Import_State_Destroy”

Type string

Default Value “vne_import_postproc”

Type string

Default Value “Vne_Import_State_Register”
VNE-2-64 VNE Server/Release 3.0



VNE Server User Guide 3—Adapters and Services
3 Adapters and Services

Introduction 

As described in the Overview chapter, VNE Server provides a comprehensive 
selection of data collection adapters and framework services. This chapter 
describes how to configure each adapter and service provided by VNE Server. 

Device Config File Collection 

The Device Config File Collection adapter collects current configuration 
information from specified network devices by means of telnet or secure shell 
(SSH) access. A user generated device access information file, called the 
Device Info File, directs the adapter to each device in the network. The Device 
Info File contains all the information that VNE Server requires to log on to each 
device and obtain configuration information. The information includes 
hostname, IP address, passwords, and vendor. The Device Info File is 
discussed in more detail in section Device and Platform Info on page VNE-2-29 
of the User Interface chapter. 

When the Device Config File Collection adapter remotely connects to a device, 
it issues the vendor-specific commands for collecting the configuration 
information for the device. The adapter captures the output from these 
commands and stores it in files at a default location within the VNE Server 
temporary directory. The vendor devices currently supported by VNE Server 
are: Cisco routers (IOS and Integrated IOS), Cisco Catalyst devices (IOS and 
CatOS), Juniper routers (JUNOS), Nortel Networks routers (BayRS), and Nortel 
Networks Passport 8000 series devices. 
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The commands used to collect configuration data for each vendor device type 
are provided in Table 3-1:

Table 3-1   Configuration File Collection Commands by Vendor  (Part 1 of 2)

Device Type Supported Commands

Cisco routers (IOS-based) show running-config

show frame-relay map

show version 

show vtp status 

show ip route

show cdp neighbors detail 

show arp

show interfaces

show vlan

show mac-address-table dynamic 

Cisco Catalyst devices (IOS- and 
CatOS-based)

show config all or show running-config

show frame-relay map 

show version

show ifindex (Catalyst 4000: show port ifindex) 

show arp 

show module

show cam dynamic

show mac-address-table dynamic (Catalyst 6000)

show cdp neighbors detail 

show vlan

show vtp status

Juniper routers (JUNOS-based) show configuration

Nortel routers (BayRS-based, 
supporting the Bay Command 
Console or BCC)

show config -all
VNE-3-2 VNE Server/Release 3.0



VNE Server User Guide 3—Adapters and Services
You can schedule the Device Config File Collection adapter to run at intervals 
that you specify during VNE Server configuration. Each time the adapter runs 
and connects to a specific device, it uses the command sequences you 
specified in the configuration properties to collect data. 

The top-level hierarchy for the configuration properties supported by this 
adapter are described in Table 3-2.

Nortel Passport devices show config verbose 

show vlan info all 

show ports info all

Extreme devices show config detail 

show edp 

show iparp 

show fdb 

show iproute 

Foundry devices show running-config 

show fdp neighbors detail 

show interfaces 

End of Table 3-1

Table 3-1   Configuration File Collection Commands by Vendor  (Part 2 of 2)

Device Type Supported Commands

Table 3-2   Device Config File Collection Properties  (Part 1 of 2)

Adapter Property Schema Description 

timeout integer Specifies the timeout per command (in seconds) used to 
collect configuration data. 

retries integer Specifies the number of retries to attempt during collection 
of configuration data. 

session time limit integer Specifies the timeout (in seconds) for the entire collection 
session. 

login property tree Contains the properties that control how this adapter 
connects to each device. 

login - Cisco property tree Contains the properties that control how this adapter 
connects to Cisco devices. 

login - Juniper property tree Contains the properties that control how this adapter 
connects to Juniper devices. 

login - Nortel property tree Contains the properties that control how this adapter 
connects to Nortel devices. 
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login - CiscoCatalyst property tree Contains the properties that control how this adapter 
connects to Cisco Catalyst devices. 

login - NortelPassport8000 property tree Contains the properties that control how this adapter 
connects to Nortel Passport 8000 devices.

show commands property tree Contains the properties that specify the commands used to 
collect device configuration. 

show commands - 
Configuration 

property tree Contains the properties that specify the commands used to 
collect “running” config data. 

show commands - 
Frame-Relay Map 

property tree Contains the properties that specify the commands used to 
collect Frame Relay PVC config data. 

show commands - Version property tree Contains the properties that specify the commands used to 
collect software, firmware and hardware version data. 

show commands - ifIndex property tree Contains the properties that specify the commands used to 
collect interface index data.

show commands - Module property tree Contains the properties that specify the commands used to 
collect hardware module information. 

show commands - CAM 
Table

property tree Contains the properties that specify the commands used to 
collect a device’s CAM (Content Addressable Memory) 
table. 

show commands - IP Route property tree Contains the properties that specify the commands used to 
collect IP Route config data. 

show commands - CDP property tree Contains the properties that specify the commands used to 
collect Cisco Discovery Protocol neighbor data. 

show commands - ARP 
Table

property tree Contains the properties that specify the commands used to 
collect a device’s ARP (Address Resolution Protocol) table. 

show commands - Interface property tree Contains the properties that specify the commands used to 
collect interface data. 

show commands - VLAN property tree Contains the properties that specify the commands used to 
collect VLAN data.

End of Table 3-2

Table 3-2   Device Config File Collection Properties  (Part 2 of 2)

Adapter Property Schema Description 
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Figure 3-1   TACACS+ Login Sequence for Cisco Devices

Configuring Device Login Properties

Table 3-2 shows the top-level hierarchy for this adapter’s properties. All the 
properties are organized under login and show commands property trees. 
Under the login tree, a property tree exists for each vendor. This tree contains 
properties that hold the vendor specific commands and expected responses 
used to access and retrieve data from the device. Under each configuration 
command in the show commands tree, vendor specific property trees hold the 
commands and responses used to collect configuration data. 
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Figure 3-1 window shows an example of the command and response sequence 
used to access TACACS+ managed Cisco devices. Each access 
method—SSH, TACACS+, and others—has a command sequence defined for 
each vendor. Notice that the login command sequence contains references to 
$USERNAME, $PASSWORD, and $ENABLE_PASSWORD variables. When a 
specific device in the network is accessed, these variables are filled in with 
information for this device that is taken from the device info file. Refer to Device 
and Platform Info on page VNE-2-29 in the User Interface chapter for more 
information about the device info file. 

After successful login to a device, the adapter should be at the command level 
in the device where a vendor specific command, such as show running-config 
for Cisco devices, can be issued to obtain configuration data. For the adapter to 
login to the device, each response property, such as initial prompt and expected 
prompt, must match the text string that is returned by the device. Otherwise 
login fails, and the VNE Server Event Viewer shows error messages about the 
failure. 

Configuring Show Command Properties 

Once this adapter has logged into a device, it is ready to submit “show” 
commands to collect all the specified configuration data. All the configuration 
commands to be issued against a device are sent during the same telnet or SSH 
session. The results of each command are stored in a file for each type of 
“show” command. Each type of show command has its own directory in the VNE 
Server temp directory under <temp dir>\Collect. The show command storage 
directories are

• <temp dir>\Collect\ARP

• <temp dir>\Collect\CAM

• <temp dir>\Collect\CDP 

• <temp dir>\Collect\Configs 

• <temp dir>\Collect\FRMap 

• <temp dir>\Collect\ifIndex 

• <temp dir>\Collect\Interface

• <temp dir>\Collect\IPRoute 

• <temp dir>\Collect\Module

• <temp dir>\Collect\Version

• <temp dir>\Collect\Vlan 
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The next two figures show the command and response sequence for the 
configuration command for Cisco and Nortel devices. These screenshots 
illustrate the programmable nature of the dialog between adapter and device. 
As with the login sequence, the expected prompt device responses must match 
the values stored in the expected prompt properties, or data collection fails. The 
VNE Server Console displays error messages about the failure. 

Figure 3-2   Show Config Commands for Cisco Devices 
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Figure 3-3   Show Config Commands for Nortel Networks Devices

Changing Adapter Login and Show Command Properties

WARNING—The default setup for device login and config data retrieval works 
for most customers. However, if you have customized any of your devices so 
that the default command and response sequences do not match device 
behavior, you must change the adapter properties. Refer to Viewing and Editing 
Properties on page VNE-2-25 and Advanced Editing on page VNE-2-26 in the 
User Interface chapter for information about editing properties in the 
Management Console. 

If your setup for a specific vendor differs from the default command sequence, 
but is uniform across all devices for that vendor, then modify the login and show 
commands property trees to specify a matching command sequence. 

If you have a mixed command sequence for devices of a specific vendor, then 
you must create a new device type. The default device types (Cisco, Juniper, 
etc) encompass more than just the vendor. They really denote a vendor and a 
specific command sequence. In both the login and show commands property 
trees, select the device type for the existing vendor that has a mixed command 
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sequence. Clone each property tree by pressing the New Sibling button. Modify 
the new property tree to match the device command sequence. Press the Apply 
button to save the changes. After this is done, go to the Management Console. 
Use the Device and Platform Info panel to change the device type for all the 
affected devices to the name of the newly created device type. 

Device Configuration Import Adapters 

The Device Config File Collection adapter executes multiple configuration 
collection commands for each device it accesses. The resulting configuration 
files are written to the VNE Server temp dir environment. An import adapter 
exists for each file type. These import adapters are

• Device Config File Import 

• Device ifIndex Import 

• Device FR Map Import 

• Device Version Import 

• Device IP Route Import 

• Device CDP Import 

• Device ARP Table Import 

• Device Interface Import 

• Device Module Import 

• Device VTP Status Import 

• Device CAM Table Import

• Device VLAN Database Import 

• Nortel EPIC Output Import 
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Although each adapter has its own set of configuration properties, the properties 
are the same across all the configuration import adapters. These properties are 
shown in the following table. 

Device Config File Import 

The Device Config File Import adapter is responsible for parsing the collected 
device configuration files, and producing a normalized XML file for each device 
that represents the device’s configuration information. Each device’s XML file 
contains a normalized version of configuration information that conforms to VNE 
Server’s data model. VNE Server supports a significant portion of each vendor’s 
command set. A list of supported commands for the currently supported devices 
is available in the Device Configuration Commands appendix. 

The XML file generated for each device is stored in the VNE Server temp 
directory (defaults to: C:\op_admin\tmp\vne). As with the other adapters, the 
Device Config File Import adapter is scheduled to run at regular intervals and 
will overwrite any previously existing file from the same device.

Device ifIndex Import

The Device Ifindex Import adapter is responsible for parsing the collected 
interface index information and producing a normalized XML file for each device 
representing the device’s interfaces and corresponding interface indices.

Device FR Map Import 

The Device FR Map Import adapter is responsible for parsing the collected 
Frame Relay Map information and producing a normalized XML file for each 
device representing the device’s frame relay PVC configuration information. 

Table 3-3   Device Configuration Import Properties

Adapter Property Schema Description 

inputFileDir text Points to the temp dir that holds files collected by the Device 
Config File Collection adapter. The default is <temp 
dir>\Collect\<file type> where <file type> = Configs, ifIndex, 
FRMap, Version, IPRoute, CDP etc.

renameDeviceConsoleConfigFil
es 

true, false Controls whether XML files are renamed after they are 
imported. The default is true. 

renameExtension text The file extension to add to imported files. The default is 
“.IMPORTED”. 

logFileDir text Points to the directory where parser log files are located. The 
default is <install dir>\log\<file type> where <file type> = 
Configs, ifIndex, FRMap, Version, IPRoute, CDP etc. 

logExtension text The parser log file extension. The default is “.log”. 

End of Table 3-3
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Device Version Import 

The Device Version Import adapter is responsible for parsing the collected 
device version information and producing a normalized XML file for each device 
representing the device’s systems description, chassis type, software version, 
and device identifier. 

Device IP Route Import 

The Device IP Route Import adapter is responsible for parsing the collected IP 
routing table information and producing a normalized XML file for each device 
representing the device’s IP routing table.

Device CDP Import 

The Device CDP Import adapter is responsible for parsing the collected Cisco 
Discovery Protocol neighbor information and producing a normalized XML file 
for each device representing the device’s neighbors as determined by the Cisco 
discovery protocol. 

Device ARP Table Import 

The Device ARP Table Import adapter is responsible for parsing the collected 
ARP table information and producing a normalized XML file for each device 
representing the device’s ARP table. 

Device Interface Import 

The Device Interface Import adapter is responsible for parsing the collected 
interface information and producing a normalized XML file for each device 
representing the device’s interface information. 

Device Module Import 

The Device Module Import adapter is responsible for parsing the collected 
module information and producing a normalized XML file for each device 
representing the device’s module information. 

Device VTP Status Import 

The Device VTP Status Import adapter is responsible for parsing the collected 
VTP status information and producing a normalized XML file for each device 
representing the device’s VTP status information.

Device CAM Table Import 

The Device CAM Table Import adapter is responsible for parsing the collected 
CAM table information and producing a normalized XML file for each device 
representing the device’s CAM table. 
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Device VLAN Database Import 

The Device VLAN Database Import adapter is responsible for parsing the 
collected VLAN information and producing a normalized XML file for each 
device representing the device’s VLAN database. 

Nortel EPIC Output Import 

The Nortel EPIC Output Import adapter is responsible for parsing collected 
EPIC files and producing a normalized XML file containing information about 
each device. 

Remote File Collection 

The Remote File Collection adapter uses FTP to collect files from other hosts. 
This adapter is mainly used to collect files for processing by other adapters. 
Some use cases are 

• Retrieve config files from a custom archive environment 

• Retrieve interface utilization or traffic flow files from an archive environment

The Remote File Collection adapter supports file filtering based upon file name 
prefix and file name extension. When filtering is configured, the only files 
retrieved are those matching the filter specification. 

Files can be retrieved from more than one remote directory. You can use the 
Management Console to add as many remote directory property trees as you 
need for your environment. Files can also be retrieved from subdirectories 
under any specified remote directory. Note that when this feature is enabled, 
directory hierarchy is not preserved. All collected files are written to the specified 
storage directory. When specifying directory paths, always provide the full path. 

Key Concept—The Remote File Collection adapter is typically used to copy files 
from other hosts that have been collected by third-party or “home grown” 
applications. Configure this adapter to copy the data files to the import file 
directory of the adapter that will process the files. For example, if you are 
collecting files for Device Config File Import and the other show command 
adapters, copy them to the appropriate <tempdir>\Collect directories. You can 
schedule this adapter to run based upon time or event triggers. Use event 
triggering and the Finish Import event raised by this adapter to trigger adapters 
to run and process data files collected by this adapter. 

The configuration properties for this adapter are described in the following table. 
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Table 3-4   Remote File Collection Properties 

Adapter Property Schema Description 

sourceList property tree Contains list of remote file servers. 

sourceList server1 property tree Contains the properties for server1. 

server1 - active yes, no Controls whether files are collected from this server. 

server1 - ftp property tree Contains the FTP access properties for server1. 

ftp - hostName text Specifies the name or address of the file server. 

ftp - userName text Specifies the user name used to login to the server. 

ftp - password text Specifies the password used to login to the server. 

ftp - timeout(mSec) text Specifies the FTP connection timeout value. 

ftp - retries integer Specifies the FTP connection retry value. 

server1 - Remote Directory List property tree Contains a list of remote directories to be accessed. 

Remote Directory List - dir1 property tree Contains properties that describe a remote directory. 

dir1 - Remote Directory Full Path text Specifies the path on the remote host from which files are 
collected. 

dir1 - FilenamePrefix text Specifies a prefix string used to filter files by name. Only files 
matching the prefix string are copied from the remote server. 

dir1 - FilenameExtension text Specifies a file extension used to filter files by name. Only 
files matching the extension are copied from the remote 
server. 

dir1 - Include Subdirectory yes, no Specifies whether files are also retrieved from 
subdirectories. 

dir1 - Storage text Specifies the directory to which retrieved files are written. 

sourceList server2 property tree Contains the settings for server2. 

End of Table 3-4
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CiscoWorks Config File Collection 

The CiscoWorks Config File Collection adapter collects device configuration 
information from CiscoWorks. CiscoWorks collects and archives configuration 
information from each device it knows about. The information collected by 
CiscoWorks is a subset of the command set used by the Device Config File 
Collection adapter. 

Note—The CiscoWorks server must be configured to accept rsh/rcp sessions 
from the VNE Server host. Refer to Configuring CiscoWorks on page VNE-5-37 
in the Administration chapter. 

The configuration properties for this adapter are described in the following table.

Table 3-5   CiscoWorks Config File Collection Properties  (Part 1 of 2)

Adapter Property Schema Description 

outputDir text Points to the directory where this adapter stores its collected 
config files. The default is <temp 
dir>\Collect\Configs_CiscoWorks. 

userDbConnection yes, no Controls whether this adapter uses a database connection to 
collect config files, or uses remote shell and remote copy. 
The default is yes. 

rsh executable text Specifies the name of the remote shell executable. 

rcp executable text Specifies the name of the remote copy executable. 

copy executable text Specifies the name of the local (VNE Server host) copy 
executable. 

CiscoWorks Server Rsh 
Parameters 

property tree Contains the properties that describe how to access the 
CiscoWorks host. 

Server Rsh Parameters - 
hostName 

text Specifies the name or address of the CiscoWorks host. 

Server Rsh Parameters - 
platform 

WINDOWS, 
UNIX

Specifies the type of platform which hosts CiscoWorks. The 
default is Windows. 

Server Rsh Parameters - 
userName

text The user name used for remote shell login. 
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CiscoWorks Config File Import 

The CiscoWorks Config File Import adapter parses each configuration file 
collected by the CiscoWorks Config File Collection adapter. From these files, 
this adapter produces a normalized XML file for each device representing the 
device’s configuration information.

The XML file generated for each device is stored in the VNE Server temp 
directory (defaults to: C:\op_admin\tmp\vne). As with the other adapters, the 
CiscoWorks Config File Import adapter is scheduled to run at regular intervals 
and will overwrite any previously existing file from the same device.

The configuration properties for this adapter are described in the following table.

Server Rsh Parameters - 
remoteCfgDir

text Points to the directory path on the CiscoWorks host where 
configuration files are located. 

Server Rsh Parameters - timeout integer The timeout value, in milliseconds, for connection to the 
CiscoWorks host. 

Server Rsh Parameters - 
configFileExtension 

text A file extension used for collected config files. The default is 
“running.cfg”. 

End of Table 3-5

Table 3-5   CiscoWorks Config File Collection Properties  (Part 2 of 2)

Adapter Property Schema Description 

Table 3-6   CiscoWorks Config File Import Properties

Adapter Property Schema Description 

inputFileDir text Points to the temp dir that holds files collected by the 
CiscoWorks Config File Collection adapter. The default is 
<temp dir>\Collect\Configs_CiscoWorks. 

renameDeviceConsoleConfigFil
es 

true, false Controls whether XML files are renamed after they are 
imported. The default is true.

renameExtension text The file extension to add to imported files. The default is 
“.IMPORTED”. 

logFileDir text Points to the directory where parser log files are located. The 
default is <install dir>\log\Configs_CiscoWorks. 

logExtension text The parser log file extension. The default is “.log”. 

End of Table 3-6
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CiscoWorks RME Database Import 

The CiscoWorks Resource Manager Essentials (RME) adapter collects MIB 
data from a CiscoWorks RME database. The data is collected from the following 
MIBs: System, IF, and Physical Entity. 

The configuration properties for this adapter are described in the following table.

Note—Refer to Collecting CiscoWorks Server Information on page VNE-5-38 in 
the Administration chapter for instructions on how to collect from the 
CiscoWorks environment the server information needed for adapter 
configuration. 

CiscoWorks ANI Database Import 

The CiscoWorks Asynchronous Network Interface (ANI) adapter collects MIB 
data from a CiscoWorks ANI database. The data is collected from the following 
MIBs: System, IF (partial), and CDP. 

Table 3-7   CiscoWorks RME Database Import Properties

Adapter Property Schema Description 

outputDir text Points to the directory where this adapter stores its 
processed XML files. The default is <temp 
dir>\CW\RME\XML. 

CiscoWorks RME Database property tree Contains the properties that describe how to access the 
RME database.

RME Database - vendor text Specifies the database vendor for the RME database. The 
default is Sybase. 

RME Database - serverName text Specifies the name or address of the RME database host. 

RME Database - portNumber integer Specifies the port number used to contact the RME 
database. Defaults to 43442. 

RME Database - dbName text Specifies the name of the RME database. Defaults to rme. 

RME Database - userName text Specifies the user name that is used to access the RME 
database. Defaults to dba. 

RME Database - password text Specifies the password that is used to access the RME 
database. 

End of Table 3-7
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The configuration properties for this adapter are described in the following table.

Note—Refer to Collecting CiscoWorks Server Information on page VNE-5-38 in 
the Administration chapter for instructions on how to collect from the 
CiscoWorks environment the server information needed for adapter 
configuration. 

Cisco WAN Manager Import 

The Cisco WAN Manager import adapter collects data from the Cisco WAN 
Manager product about your WAN configuration. Contact OPNET for more 
information about how to set up and use this adapter. 

Table 3-8   CiscoWorks ANI Database Import Properties

Adapter Property Schema Description 

outputDir text Points to the directory where this adapter stores its 
processed XML files. The default is <temp 
dir>\CW\ANI\XML. 

CiscoWorks ANI Database property tree Contains the properties that describe how to access the ANI 
database. 

ANI Database - vendor text Specifies the database vendor for the ANI database. The 
default is Sybase.

ANI Database - serverName text Specifies the name or address of the ANI database host.

ANI Database - portNumber integer Specifies the port number used to contact the ANI database. 
Defaults to 43443.

ANI Database - dbName text Specifies the name of the ANI database. Defaults to ani.

ANI Database - userName text Specifies the user name that is used to access the ANI 
database. Defaults to cwsiSA.

ANI Database - password text Specifies the password that is used to access the ANI 
database. 

ANI Database - jdbc_driver text Specifies the name of the jdbc driver used for database 
access. The default is com.sybase.jdbc2.jdbc.SybDriver. 

End of Table 3-8
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Device MIB Configuration Import 

The Device MIB Configuration Import adapter performs targeted SNMP 
requests to supported MIBs on each known device to obtain additional 
information beyond that obtained from the configuration files. The MIBs 
currently supported by this adapter include 

• RFC1213-MIB

• ENTITY-MIB

• IF-MIB (RFC1573) 

• CISCO-PRODUCTS-MIB

• OLD-CISCO-CHASSIS-MIB

• CISCO-STACK-MIB

• CISCO-CDP-MIB 

• JUNIPER-MIB

• WellFleet-CCT-NAME-MIB

• BRIDGE-MIB

Information collected by this adapter is processed into XML and placed in the 
VNE Server temp directory for processing by the VNE-XML Import adapter. 

The configuration properties for this adapter are described in the following table.

Table 3-9   Device MIB Configuration Import Properties

Adapter Property Schema Description 

timeout integer The timeout value, in seconds, used by the SNMP engine. 

retries integer The number of retries used by the SNMP engine. 

End of Table 3-9
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HP OpenView NNM Import 

The HP OpenView Network Node Manager (NNM) Import adapter collects 
device and topology information from HP OpenView. The information collected 
includes System group and IF MIB data. This adapter provides devices links 
and connections to VNE Server. The HP OpenView NNM adapter uses the ovdb 
application programming interface to connect and retrieve data from HP 
OpenView. 

Note—The HP OpenView NNM server must be configured to allow access to 
VNE Server. Refer to Configuring HP OpenView on page VNE-5-36 in the 
Administration chapter. 

Note—When connecting to HP OpenView NNM version 6.2, or later, set the 
dbPort number property to 2447. If the HP OpenView NNM version is 6.1, use 
9999 for the dbPort number. 

The configuration properties for this adapter are described in the following table.

DNS Alias Import 

The DNS Alias Import adapter performs a reverse DNS lookup on IP interfaces 
in the database. For any matches found, the DNS alias is saved in the network 
model. This adapter can be thought of as a utility adapter. It collects information 
that can aid other adapters in doing interface and node level matching required 
in order to import their data into the network model. Contact OPNET for advice 
on whether you need to use this adapter based upon the adapter mix you plan 
to use to build your network model. 

Table 3-10   HP OpenView NNM Import Properties

Adapter Property Schema Description 

outputDir text Points to the directory where this adapter stores its collected 
files. The default is <temp dir>\hpov. 

HP OV NNM Server Parameters property tree Contains the properties that describe how to connect to the 
HP OpenView server. 

Server Parameters - hostName text Specifies the name or address of the HP OpenView host. 

Server Parameters - dbUser text Specifies the user name that is used to access the HP 
OpenView database. Defaults to ovdb. 

Server Parameters - dbPort integer Specifies the port number used to contact the HP OpenView 
database. Defaults to 2447. 

End of Table 3-10
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Link and Connection Inference Service 

The Link and Connection Inference Service uses device and interface 
information collected by other adapters to deduce the links that exist in the 
network. This service supplies network topology to the VNE Server network 
model. The Link and Connection Inference service is scheduled to run on a 
regular basis and produces an XML file of inferred link data in the VNE Server 
temp directory environment. The VNE-XML Import adapter processes the link 
inference XML file, and commits link data to the network database. 

Note—Links can also be inferred based upon ARP cache and CAM table data. 
ARP and CAM data is disabled, by default, as link sources. Set the importViaArp 
and importViaCam properties to true if you want to use this data for link 
inference. 

The configuration properties for this adapter are described in the following table.

Table 3-11   Link and Connection Inference Service Properties

Adapter Property Schema Description 

importViaCdp true, false Controls whether links inferred from CDP data are imported. 
The default is true. 

importViaArp true, false Controls whether links inferred from ARP cache data are 
imported. The default is false. 

importViaCam true, false Controls whether links inferred from CAM table data are 
imported. The default is false. 

importViaIpAddresses true, false Controls whether links inferred from IP addresses are 
imported. The default is true. 

importFrameRelay true, false Controls whether links inferred from Frame Relay map data 
are imported. The default is true. 

frameRelayFullMesh true, false Controls whether full mesh connectivity is automatically 
created between Frame Relay connections. The default is 
false. 

importAtm true, false Controls whether links inferred from ATM PVC configuration 
data are imported. The default is true. 

atmFullMesh true, false Controls whether full mesh connectivity is automatically 
created between ATM connections. The default is false. 

importAtmFrameRelay true, false Controls whether links inferred from hybrid ATM, Frame 
Relay configuration data are imported. The default is true. 
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Trace Route Link Inference Service 

The Trace Route Link Inference Service is a lowest common denominator 
means of determining connectivity and intervening Layer-3 devices between 
network devices that already exist in the model. This service provides a 
convenient, automated means of ensuring that your network model is complete 
from a connectivity standpoint. 

Generally, the Trace Route service should only be used as a means to 
determine the intervening devices. Once the intervening devices are 
determined, one of the adapters that provides richer detail (if available) should 
be used to gain information from the device. 

atmFrameRelayFullMesh true, false Controls whether full mesh connectivity is automatically 
created between hybrid ATM, Frame Relay connections. The 
default is false. 

importMpls true, false Controls whether links inferred from MPLS LSP configuration 
data are imported. The default is true. 

ignoreIfcOperStatus true, false Controls whether ifOperStatus for an interface is ignored 
during link inference. The default is true. 

compareCamIfcType true, false Controls whether CAM interface type is used for link 
inference. The default is true. 

importPassportTrunks true, false Controls whether Passport trunks are used for link inference. 
The default is false. 

importPassportPnniLinks true, false Controls whether Passport PNNI links are used for link 
inference. The default is false. 

ipAddressExclusionFile text Specifies the path to a file containing a list of IP addresses to 
be excluded from use for link inference. 

End of Table 3-11

Table 3-11   Link and Connection Inference Service Properties

Adapter Property Schema Description 
VNE Server/Release 3.0 VNE-3-21



3—Adapters and Services VNE Server User Guide 
Generally, the Trace Route service may be used under two different scenarios:

1) The Trace Route service is used as an automated assistant to determine 
missing devices. 

The end result of running this service should be the complete set of devices 
and IP addresses to populate the Device Information File which is used by 
other adapters for obtaining device and configuration detail. 

2) The Trace Route service is used as a means for determining intervening 
devices and establishing Layer-3 connectivity between connected 
components of your network when the intervening devices may not be 
accessible or supported but the current adapter set (i.e., a router to which 
you do not have management access to or a firewall or router for which an 
adapter does not currently exist).

Table 3-12   Trace Route Link Inference Service Properties  (Part 1 of 2)

Adapter Property Schema Description

renameTraceRouteFiles true, false Controls whether XML files are renamed after they are 
imported. The default is true. 

renameExtension text The file extension to add to imported files. The default is 
“.IMPORTED”. 

maxFailedCmdPerNode integer Specifies the number of failed commands at a given device 
before Trace Route gives up and terminates the connection.

session time limit (sec) integer Specifies the maximum session time at a given device before 
Trace Route gives up and terminates the connection.

total traceroute time limit 
(minutes) 

integer Specifies he total time allotted to running this adapter. 

traceRouteVendorList property tree Contains the trace route properties for each device type. 

traceRouteVendorList - Cisco property tree Contains the properties that define the trace route 
commands used with Cisco devices. 

Cisco - expected prompt text Specifies the command line prompt string that appears after 
successful login to the device. 

Cisco - traceroute command text Specifies the trace route command to use on this device. 

traceRouteVendorList - Nortel property tree Contains the properties that define the trace route 
commands used with Nortel devices. 

Nortel - expected prompt text Specifies the command line prompt string that appears after 
successful login to the device.

Nortel - traceroute command text Specifies the trace route command to use on this device.
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MIB-Based Interface Utilization Import 

The MIB-Based Interface Utilization Import adapter uses SNMP to poll interface 
utilization statistics from network devices. This scheduled adapter gathers 
similar information to that provided by the Concord and MRTG adapters, but 
does so in a direct manner without relying upon an external system. The data 
collected by this adapter is placed in XML files in the Baseliner/xml subdirectory 
within the VNE Server temp directory environment. Each file name includes a 
timestamp, and the files include traffic data for all nodes visible to VNE Server. 
The VNE-XML Import adapter processes this XML, and commits traffic data to 
the network database. 

Note—The first time that this adapter is run after the service framework starts, 
SNMP polling begins and a polling sweep occurs. A new polling sweep happens 
each time the sample interval defined by the sampleInterval property is reached. 
Polling sweeps continue at this sample interval for as long as product services 
are running. Each sweep generates XML files in the temp dir. These XML files 
are imported into the database whenever this adapter is scheduled to run in the 
Management Console Adapter Schedule panel. 

traceRouteVendorList - Juniper property tree Contains the properties that define the trace route 
commands used with Juniper devices. 

Juniper - expected prompt text Specifies the command line prompt string that appears after 
successful login to the device.

Juniper - traceroute command text Specifies the trace route command to use on this device.

End of Table 3-12

Table 3-12   Trace Route Link Inference Service Properties  (Part 2 of 2)

Adapter Property Schema Description
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The configuration properties for this adapter are described in the following table.

Concord eHealth Network Utilization Import 

The Concord eHealth Network Utilization Import adapter imports interface 
utilization statistics collected from one or more Concord systems. VNE Server 
uses telnet to connect to the Concord system. Once connected, Concord 
commands are issued to display the traffic group data specified by the adapter 
properties. The output of the traffic report commands is saved in the adapter 
temp directory as dci and ddo files. Each traffic group specified in the adapter 
properties produces a timestamped dci/ddo file pair after a Concord collection 
session. The dci files contain setup information about the interfaces in each 
traffic group. The ddo files contain the interface utilization statistics for each 
interface in the traffic group. The dci/ddo files are saved in the VNE Server temp 
cnh/input subdirectory. 

The Concord adapter processes the dci/ddo files for each traffic group. The 
adapter converts the traffic data for each device into timestamped XML files in 
the cnh/xml subdirectory. Each device has an XML file that contains traffic data 
for its interfaces. These files are imported by the VNE-XML Import adapter. 

To configure this adapter, set up the Concord login properties, and modify the 
groupNames list to contain the names of the traffic groups you wish to collect. 
Work with the Concord administrator to determine the traffic groups you need. 
If you have more than one Concord system, clone and configure the “live” 
property tree for each system. 

Table 3-13   MIB-Based Interface Utilization Import Properties

Adapter Property Schema Description 

outputFileDir text The temp dir that contains output XML files that are ready for 
import. The default is <temp dir>\Baseliner\xml. 

sampleNumber integer Set to 0 when continuously running this adapter in a 
scheduled mode. When set to a non-zero value, determines 
the number of samples to take when manually running this 
adapter. The default is 0. 

sampleInterval integer The interval between samples in seconds. The default is 
300. 

retries integer The retry count used by the SNMP engine. 

End of Table 3-13
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The configuration properties for this adapter are described in the following table. 

Table 3-14   Concord eHealth Network Utilization Import Properties  (Part 1 of 2)

Adapter Property Schema Description 

sourceList property tree Contains property trees for live, local and remote Concord 
data sources. 

sourceList - live property tree Contains the property tree that describes how to collect data 
from a live Concord system. 

live - active yes, no Controls whether VNE Server collects data from this server. 

live - dataSource live, local, 
remote f

Specifies the source of Concord data. For operational 
environments, use live. For testing, use local or remote. 

live - login property tree Contains the login properties for a Concord system. 

live - login - platform UNIX,

Windows

Specifies the type of platform that hosts the Concord system. 

live - login - hostName text Specifies the name or address of the system. 

live - hostTimeZone time zone 
menu 

Specifies the time zone in which the Concord server lies. 

live - login - loginPrompt text Specifies the login prompt string used by the Concord host. 
The default is login: 

live - login - userName text Specifies the user name used to login to the system. 

live - login - password text Specifies the password used to login to the system. 

live - login - additionalParams property tree Contains two placeholder property trees that you can 
configure to issue additonal login and navigation commands. 

live - login - commandPrompt text Specifies the host command line prompt string that will 
appear after a successful login. 

live - login - timeout integer Specifies the timeout, in milliseconds, to wait for the 
command prompt. The default is 60000 (60 secs). 

live - cnhExport property tree Contains the properties governing traffic group data 
collection. 

live - cnhExport - timeout integer Specifies the timeout, in milliseconds, to wait for traffic group 
data. The default is 3600000. 

live - cnhExport - trafficRange time menu Specifies the time span used when requesting traffic data for 
a group. Varies from prevHour to prev4Weeks

live - groupNames property tree Contains properties for each traffic group to be collected by 
the adapter. 

live - groupNames - group1 text Specifies the name of a traffic group. 
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StatScout Interface Utilization Import 

The StatScout Interface Utilization Import adapter imports interface utilization 
data collected from a StatScout sever. Configuration is similar in nature to the 
other interface utilization adapters.

MRTG Interface Utilization Import 

The MRTG Interface Utilization Import adapter imports interface utilization data 
collected from one or more MRTG servers. Both log file and RRD file formats 
are supported. VNE Server uses ftp to collect data from a MRTG server. Once 
connected, FTP commands are issued to copy the configuration and traffic files 
specified in the adapter properties. These files are saved in the adapter temp 
directory. By default, they have cfg, rrd and log extensions. The cfg files contain 
device and interface information that this adapter uses to extract utilization data 
from the log and rrd files. A log and rrd files are collected for each interface that 
is visible to MRTG. The cfg/log/rrd files are saved in the VNE Server temp 
mrtg/input subdirectory. 

The MRTG adapter processes the cfg/log/rrd files. The adapter converts the 
utilization data for each device into timestamped XML files in the mrtg/xml 
subdirectory. Each device has an XML file that contains utilization data for its 
interfaces. These files are imported by the VNE-XML Import adapter. 

To configure this adapter, set up the MRTG login properties, and modify the file 
filters and directories for the data you wish to collect. Work with the MRTG 
administrator to determine the name and location of the MRTG data files. If you 
have more than one MRTG server, clone and configure the server property tree 
for each system. 

live - groupNames - group2 text Specifies the name of a traffic group. 

live - groupNames - group3 text Specifies the name of a traffic group. 

sourceList - local files property tree  Specifies the location of data files on the local host. 
Generally used only for adapter testing.

sourceList - remote files property tree Specifies the location of data files on a remote host. Used 
when the Concord server is configured to export traffic files 
on a scheduled basis. 

End of Table 3-14

Table 3-14   Concord eHealth Network Utilization Import Properties  (Part 2 of 2)

Adapter Property Schema Description 
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The configuration properties for this adapter are described in the following table.

Table 3-15   MRTG Interface Utilization Import Properties 

Adapter Property Schema Description 

inputFileDir text Points to the directory where this adapter stores collected 
traffic data. The default is <temp dir>\mrtg\input. 

outputFileDir text Points to the directory where this adapter stores its output 
data files. The default is <temp dir>\mrtg\xml. 

mrtgServerList property tree Contains a list of MRTG servers to be polled by VNE Server. 

mrtgServerList server1 property tree Contains the properties for server1. 

server1 - active yes, no Controls whether VNE Server collects data from this server. 

server1 - hostName text Specifies the name or address of the MRTG server. 

server1 - RRD Integrated yes, no Specifies whether the server data uses RRD format. 

server1 ftp - userName text Specifies the user name used to login to the server. 

server1 ftp - password text Specifies the password used to login to the server. 

server1 ftp - timeout integer Specifies the ftp timeout in milliseconds. 

server1 ftp - retries integer Specifies the number of retries to copy files from the MRTG 
server. The default is 3. 

server1 - workDir text Specifies the location of the working dir when MRTG is setup 
so that all working files are in the same directory. 

server1 - cfgDir text Specifies the location of the MRTG configuration files. 

server1 - logDir text Specifies the location of the MRTG data files. 

server1 - cfgFileFilter text Specifies the name filter used to identify the MRTG 
configuration file. The default is *.cfg. 

server1 - logFileExtension text Specifies the extension used for the interface utilization files. 
The default is *.log. 

server1 - trafficRange time menu Specifies the time span used when extracting traffic data 
from the collected log files. Varies from prevHour to 
prev4Weeks. 

mrtgServerList server 2 property tree Server2 contains properties for telnet access in addition to 
the same properties as in server1. This server template is 
setup for RRD files. 

End of Table 3-15
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InfoVista Network Utilization Import 

The InfoVista Network Utilization Import adapter imports interface utilization 
data collected from one or more InfoVista servers. VNE Server uses an API 
supplied by InfoVista to collect data from each server. 

The InfoVista adapter converts the utilization data that it collects into 
timestamped XML files in the iv/xml subdirectory. Each device has an XML file 
that contains utilization data for its interfaces. These files are imported by the 
VNE-XML Import adapter. 

To configure this adapter, set up the InfoVista login properties, and specify the 
time interval for the data you wish to collect. If you have more than one InfoVista 
server, clone and configure the server property tree for each system. 

The configuration properties for this adapter are described in the following table.

Table 3-16   InfoVista Network Utilization Import Properties 

Adapter Property Schema Description 

outputFileDir text Points to the directory where this adapter stores its output 
data files. The default is <temp dir>\iv\xml. 

serverList property tree Contains a list of InfoVista servers to be polled by VNE 
Server. 

serverList server1 property tree Contains the properties for server1. 

server1 - active yes, no Controls whether VNE Server collects data from this server. 

server1 - hostName text Specifies the name or address of the InfoVista server. 

server1 - userName text Specifies the user name used to login to the server. 

server1 - password text Specifies the password used to login to the server. 

server1 - trafficRange time menu Specifies the time span used when extracting traffic data 
from the collected log files. Varies from “Since Last Run” 
through 1, 2, 3, 4, 6, 8, 12, 18 and 24 hour intervals. 

serverList server 2 property tree Server2 contains the same properties as in server1. 

End of Table 3-16
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Cisco Netflow Import 

The Cisco Netflow Import adapter connects to one or more servers running a 
Netflow Collector daemon and collects traffic flow statistic files. After these files 
are collected, the traffic flow information is imported into the VNE database. 
Since flow data can be quite large, this adapter provides front end capabilities 
to filter and aggregate flow data. 

Table 3-17   Cisco Netflow Import Properties  (Part 1 of 3)

Adapter Property Schema Description

output directory text Points to the directory where this adapter stores its output 
data files. The default is <temp dir>\netflow.

Netflow data sources property tree Contains the data sources properties. 

Netflow data sources - server1 property tree Contains the server1 properties. 

server1 - active yes, no Controls whether VNE Server collects data from this server.

server1 - hostname text Specifies the name or address of the system. 

server1 - username text Specifies the user name used to login to the system. 

server1 - password text Specifies the password used to login to the system. 

server1 - retries integer Specifies the number of retries to connect to the server. The 
default is 3. 

Netflow home directory text Specifies the location of the Netflow files on the collector 
server. 

traffic collection parameters property tree Contains traffic collection properties. 

traffic collection parameters - 
time window 

property tree Specifies the time interval over which to collect Netflow 
statistics. 

traffic collection parameters - 
collection devices 

property tree Specifies the collection devices. 

traffic collection parameters - 
aggregation types 

property tree Specifies the aggregation types. 

Netflow data sources - server2 property tree Same as server1. 

Netflow data sources - existing 
files

property tree Contains the properties for collection from test files. 

existing files - active yes, no Enables test file based collection. 

existing files - Netflow data 
directory

text Specifies the directory containing files to collect. 

existing files - read 
subdirectories

yes, no Enables file collection from subdirectories. 
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aggregation and filtering property tree Contains the properties for demand aggregation and filtering. 

aggregation and filtering - 
aggregation 

property tree Contains the properties for aggregation and filtering. 

aggregation and filtering - 
aggregation - 

aggregate demands by... 

property tree Contains the aggregation properties. 

aggregate demands by... 

IP addresses 

yes, no Aggregate by IP address. 

aggregate demands by... 

AS numbers 

yes, no Aggregate by AS numbers. 

aggregate demands by... 

ports 

yes, no Aggregate by ports. 

aggregate demands by... 

protocol 

yes, no Aggregate by protocol. 

aggregate demands by... 

type of service (TOS) 

yes, no Aggregate by TOS. 

aggregate demands by... 

interface indices 

yes, no Aggregate by interface indices. 

aggregation and filtering - 
rebucketization 

property tree Contains the rebucketization properties. 

aggregation and filtering - 
rebucketization - 

time bucket size (minutes) 

integer Specify the bucket size interval for rebucketization. 

aggregation and filtering - 
filtering

property tree Contains the filtering properties. 

aggregation and filtering - 
filtering - 

filter byte flows less than (bytes 
per sec) 

integer Specify the threshold below which byte flow data is not kept. 

Table 3-17   Cisco Netflow Import Properties  (Part 2 of 3)

Adapter Property Schema Description
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NetScout nGenius Import 

The NetScout nGenius Import adapter connects to one or more NetScout 
servers to collects traffic flow statistic files. After these files are collected, the 
traffic flow information is imported into the VNE database. Since flow data can 
be quite large, this adapter provides front end capabilities to filter and aggregate 
flow data. Configuration of this adapter is similar in nature to the Cisco Netflow 
Import adapter. 

Cflowd Import 

The Cflowd Import adapter connects to one or more Cflowd servers to collects 
traffic flow statistic files. After these files are collected, the traffic flow information 
is imported into the VNE database. Since flow data can be quite large, this 
adapter provides front end capabilities to filter and aggregate flow data. 
Configuration of this adapter is similar in nature to the Cisco Netflow Import 
adapter. 

aggregation and filtering - 
filtering - 

filter packet flows less than 
(packets per sec) 

integer Specify the threshold below which packet flow data is not 
kept. 

aggregation and filtering - 
filtering - 

percentage of byte volume to 
keep 

integer Specify the percentage of the byte volume to keep. 

aggregation and filtering - 
filtering - 

filtered log file 

Specify the path to the filtering log file. 

End of Table 3-17

Table 3-17   Cisco Netflow Import Properties  (Part 3 of 3)

Adapter Property Schema Description
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Demand Traffic Processing Service 

The Demand Traffic Processing Service processes demand traffic statistics 
stored in the VNE database to map endpoint IP addresses to network subnets 
and categorize traffic flow based upon source and destination. 

Post Processor Service 

The Post Processor service operates upon the database to fill in missing device 
attributes based upon other information in the network model. Contact OPNET 
for assistance and additional information about this adapter. 

ASCII Generic Data Import 

The ASCII Generic Data Import (GDI) adapter allows the user to supplement 
network information collected by the other adapters and to override incorrect 
information. The geographic location of a device (latitude, longitude) is an 
example of information supplied by ASCII Import that may not be reliably 
obtained by other means. This adapter allows the following information to be 
added or overridden:

• Geographic location 

• Interface and sub-interface properties 

• Interface and sub-interface addressing 

• Link information 

• Physical Entity chassis 

• Device module chassis information 

Table 3-18   Demand Traffic Processing Service Properties

 Service Property Schema Description

map demand endpoints to 
network model 

property tree Contains mapping properties. 

map demand endpoints - 

map demand endpoint IP 
addresses to network model 
subnets 

yes, no Enables demand endpoint mapping. 

demand aggregation property tree Contains aggregation properties 

demand aggregation - 
aggregation options 

text Not configurable at this time. Set to none. 

End of Table 3-18
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• Node groups and sub-groups 

• Node group member lists 

• Device config property information 

• Device deletion 

• Interface deletion 

As with the other data collection adapters, this adapter is scheduled to run 
periodically, reads any configured ASCII override information, and places its 
XML output files in the VNE Server temp dir for processing by VNE-XML Import. 

ASCII import files are manually generated, as described below. The default 
directory for these files lies within the installation directory at <install 
dir>\input\AsciiData and can be changed using the VNE Server Management 
Console. 

The Management Console Adapter Resources panel is used to point to the 
ASCII Import files for your network. To do so, expand the ASCII Generic Data 
Import property, and then expand the location, ifc, ifcaddr or linkinfo property. 
Change the inputFileDir property to point to the desired override file. 

The format for ASCII Import geographic data, and an example, is shown below. 
Note that the fields are delimited by commas. 

Hostname City Country Latitude Longitude NPANXX

SF-Access, SanFrancisco, USA, 37.37, -122.23, 415238

The format for ASCII Import link info data, and an example, is shown below: 

Link_Type;, Endpt_Name*Interface; Endpt_Name*Interface 

&VNE.TYPES.LINK.PTTOPT;,Chicago-Core*Serial0/1;DC-Core*Serial0/0

These files are manually created in a text editor and placed in their target 
directories. 

Note—The default “sample” file for each type of ASCII data document the file 
format. Use the default inputFile location to find the sample files. 

Refer to VNE Server Management Console on page VNE-2-24 in the User 
Interface chapter for a description of property editing in the Management 
Console. 
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The configuration properties for this adapter are described in the following table.

Table 3-19   ASCII Generic Data Import Properties

Adapter Property Schema Description 

location property tree Contains properties that point to the location ASCII data file 
and its associated template file. 

location - inputFile text Specifies the path to the location file. The default is <install 
dir>\inputs\AsciiData\location.txt. 

location - templateFile text Specifies the path to a ASCII GDI template file. The default 
is <install dir>\lib\xml\templates\node_location.res. 

ifc property tree Contains properties that point to the interface ASCII data file 
and its associated template file. 

ifc - inputFile text Specifies the path to the interface file. The default is <install 
dir>\inputs\AsciiData\ifc.txt. 

ifc - templateFile text Specifies the path to a ASCII GDI template file. The default 
is <install dir>\lib\xml\templates\ifc.res. 

ifcaddr property tree Contains properties that point to the interface address ASCII 
data file and its associated template file.

ifcaddr - inputFile text Specifies the path to the interface address file. The default is 
<install dir>\inputs\AsciiData\ifcaddr.txt. 

ifcaddr - templateFile text Specifies the path to a ASCII GDI template file. The default 
is <install dir>\lib\xml\templates\ifc_address.res.

linkinfo property tree Contains properties that point to the link info ASCII data file 
and its associated template file.

linkinfo - inputFile text Specifies the path to the interface address file. The default is 
<install dir>\inputs\AsciiData\linkinfo.txt. 

linkinfo - templateFile text Specifies the path to a ASCII GDI template file. The default 
is <install dir>\lib\xml\templates\link_speed.res.

PEchassis property tree Contains properties that point to the Physical Entity chassis 
ASCII data file and its associated template file. 

groupCreate property tree Contains properties that point to the node group creation 
ASCII data file and its associated template file.

addNodeToGroup property tree Contains properties that point to the node group addition 
ASCII data file and its associated template file.

End of Table 3-19
VNE-3-34 VNE Server/Release 3.0



VNE Server User Guide 3—Adapters and Services
Database Aging Service 

The Database Aging Service works in conjunction with VNE Server’s data 
merge framework to identify and remove stale or inconsistent network data from 
the VNE database. This capability is a key component of VNE Server’s ability to 
maintain an accurate and current view of the target network. There are no 
configuration properties for this service in the Adapter Resources panel. 
However, the clean threshold properties in the Adapter Priority panel control 
how quickly the Database Aging Service removes stale data from the database. 

Maintenance Service 

The Maintenance Service removes used files from the VNE Server temp dir 
environment and limits log file growth. This service should be scheduled to run 
as often as needed to conserve disk space on the VNE Server host. OPNET 
recommends that this service be scheduled to run once during every data cycle, 
or a least once daily. The properties that configure this service are organized 
under WorkingTempDir and EventLogDir categories. 

The WorkingTempDir properties identify temp dir directories that are processed 
by this service. The extensions properties define file name extensions for the 
files to be processed. The Maintenance Service deletes any temp dir files with 
these extensions. The default extensions are IMPORTED, USED, INVALID, 
and INCOMPLETE. 

The EventLogDir properties identify the extensions assigned to event log files 
that are no longer current. The “older than” properties define the retention period 
for log files. After the retention period has passed for a file, Maintenance Service 
deletes the file. The event logs contain the event data that is displayed in the 
VNE Server Console. While they provide a valuable history of VNE Server 
activity, they can consume tens of megabytes of disk space. The Maintenance 
Service manages the disk space consumed by event logs. 

The configuration properties for this service are described in the following table.

Table 3-20   Maintenance Service Properties  (Part 1 of 2)

 Service Property Schema Description 

WorkingTempDir property tree Contains the properties that describe the subdirectories and 
files processed by this adapter. 

WorkingTempDir - name text Points to the temp dir. The default is the temp dir specified at 
installation. 

WorkingTempDir - removeFiles true, false Controls whether eligible files are removed from the temp dir. 
The default is true. 

WorkingTempDir - 
includeSubDirectory 

true, false Controls whether eligible files are removed from the temp dir 
sub directories. The default is true. 
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Change Records Maintenance Service 

The Change Records Maintenance Service manages database growth that 
results when network change history is saved in the database. VNE Server 
provides the ability to archive all detected network changes. When enabled, this 
information is used to populate the System Change reports. This service is used 
to remove any network change records that are older than the defined 
threshold. 

WorkingTempDir - extensions - 
e1 

text A file extension for files to be deleted. The source adapter for 
the files renames the files when they are no longer needed. 
The default is IMPORTED. 

WorkingTempDir - extensions - 
e2 

text A file extension for files to be deleted. The source adapter for 
the files renames the files when they are no longer needed. 
The default is USED. 

WorkingTempDir - extensions - 
e3 

text A file extension for files to be deleted. The source adapter for 
the files renames the files when they are no longer needed. 
The default is INVALID. 

WorkingTempDir - extensions - 
e4 

text A file extension for files to be deleted. The source adapter for 
the files renames the files when they are no longer needed. 
The default is INCOMPLETE. 

EventLogDir property tree Contains the properties that control the event log retention. 

EventLogDir - name text Points to the event log directory. The default is the <install 
dir>\log\eventlog directory. 

EventLogDir - removeFiles true, false Controls whether eligible log files are removed from the 
event log directory. The default is true. 

EventLogDir extensions - e1 text A file extension for event log files to be deleted. The default 
is old.log. 

EventLogDir - old than - 
timeCount 

integer The time interval for event log retention. The default is 1. 

EventLogDir - old than - timeUnit Hour, 

Day, Week, 

Month,

Year

The time units for event log retention. The default unit is a 
Week. 

End of Table 3-20

Table 3-20   Maintenance Service Properties  (Part 2 of 2)

 Service Property Schema Description 
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The configuration properties for this service are described in the following table.

Report Export Service 

The Report Export Service provides the ability to export reports to various 
formats (html, csv) at scheduled intervals. The reports to be exported and their 
location are configurable. The default location lies within the VNE Server temp 
dir. The default settings for the Maintenance Service will not remove these 
reports. The names of the reports do not include timestamps, so successive 
runs of the service overwrite existing reports. For this reason, it is recommended 
that scheduled scripts be written to move reports to an archive location. 

The configuration properties for this service are described in the following table.

Interface Utilization Rollup Service 

The Interface Utilization Rollup Service manages database growth resulting 
from the continuous import of interface utilization data. With this service, 
utilization data is managed with respect to the following time periods: 

• Interval over which raw utilization data is kept 

• Interval over which utilization data is aggregated (rolled up) into fewer 
samples in the database

• Interval beyond which utilization data is removed from the database

Table 3-21   Change Records Maintenance Service Properties

 Service Property Schema Description

numHoursToKeep Integer The number of hours of network change data to keep. The 
default is 168 hours. 

numMinutesToKeep Integer The number of minutes (in addition to the hour interval) of 
network change data to keep. The default is 0 minutes. 

End of Table 3-21

Table 3-22   Report Export Service Properties 

Service Property Schema Description 

outputFileDir text Specifies the directory to which reports are written. 
The default is <temp dir>\vne\Reports. 

exportFormat html, csv Specifies the report format. 

reportList property tree Contains a list of the reports. For each report, select 
true to enable the report, and false to disable the 
report. 

End of Table 3-22
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The configuration properties for this service are described in the following table.
Table 3-23   Interface Utilization Rollup Service Properties  (Part 1 of 2)

 Service Property Schema Description 

configurations property tree Contains the property trees for each utilization source. 

configurations - 

Hourly - concord 

property tree Contains the rollup properties for the Concord eHealth 
utilization source. 

configurations - 

Hourly - concord - 

Applies To Data Collected By= 

baseline, 
concord, 
mrtg, 
InfoVista 

Specifies the utilization source to which this roll up 
configuration applies. 

configurations - 

Hourly - concord - 

Applies to Description= 

text 

configurations - 

Hourly - concord - 

Roll Up Description= 

hourly Name of the roll up configuration. 

configurations - 

Hourly - concord - 

Roll Up Interval 

time The DD:HH:MM interval used to aggregate (roll up) data that 
is older than the raw data threshold. 

configurations - 

Hourly - concord - 

Amount of Raw Data To Keep= 

time The DD:HH:MM interval over which raw data is kept.

configurations - 

Hourly - concord - 

Amount of Roll Up Data To 
Keep= 

 time The DD:HH:MM interval beyond the raw data threshold for 
which rolled up data is kept. 

configurations - 

Hourly - concord - 

Is Enabled

true, false Specifies whether rollup is enabled for this utilization source. 

configurations - 

Hourly - baseline 

property tree Contains the rollup properties for the MIB-Based Interface 
Utilization source. 

configurations - 

Hourly - mrtg 

property tree Contains the rollup properties for the MRTG utilization 
source. 

configurations - 

Hourly - InfoVista 

property tree Contains the rollup properties for the InfoVista utilization 
source. 
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External Adapter 

The External Adapter provides a means to integrate outside tools and scripts 
into the schedule of adapters and services that you wish to run. Some use cases 
are

• Copy exported model files to an archive environment 

• Copy exported reports to an archive environment

• Move config files or data files collected by other tools to the temp dir

• Run scripts and tools to manage the VNE Server environment

This adapter can run one or more external commands. By default, the shell of 
one external command is provided and disabled. Use the Management Console 
Adapter Resources panel for this adapter to fill in the details of the number of 
commands to run and their setup properties. 

Note—As with all adapters and services, the External Adapter can only appear 
at one point in the product schedule. More than one schedule rule can be active, 
so a mix of event and time based scheduling can be done 

The configuration properties for this adapter are described in the following table.

configurations - 

Hourly - StatScout 

property tree Contains the rollup properties for the StatScout utilization 
source.

configurations - Daily property tree Contains the Daily rollup properties for all sources. 

configurations - Weekly property tree Contains the Weekly rollup properties for all sources. 

End of Table 3-23

Table 3-23   Interface Utilization Rollup Service Properties  (Part 2 of 2)

 Service Property Schema Description 

Table 3-24   External Adapter Properties  (Part 1 of 2)

Service Property Schema Description 

cmd1 property tree Contains the setup properties for cmd1. 

cmd1 - process_name text Name of the external command for use in event logs. 

cmd1 - cmd text The tool or script that you wish to run as an external 
command. 

cmd1 - workingDir text The path to the external command tool or script. 
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To configure this adapter, select cmd1 and use the New Sibling button to create 
a copy of the cmd1 shell for each command you wish to run. Press the Apply 
button after each command is created and before any other editing takes place. 
The term command used here can refer to an executable or script. Examples 
are Windows bat files, Solaris shell scripts, Perl scripts, Java, C, C++ 
executables and more. For each command you create, do the following: 

1) Enter a display name for the command into the process_name property. 

2) Enter the command you wish to run into the cmd property. Do not directly 
run shell commands such as dir or copy. Run them from a script. Consider 
these examples. 

— For Perl scripts, cmd = perl. 

— For executables, cmd = <executable name>. 

3) Enter the path to the command you wish to run into the workingDir property. 

4) If the command has arguments, enter them into the args - values text field. 
Some notes: 

— If you have no arguments, leave the text field empty. 

— If you have more than one argument, separate each by one or more 
spaces in the text field. 

— Use full path names to any files or directories in the argument list. 

5) If the command is a vnes.bat or vnes.sh target, keep the env v1-v4 
properties. They default to product installation paths. Otherwise, select and 
delete each env variable v1-v4. Do not delete the env parent property. 

6) Set the enabled property to true. 

WARNING—Terminate bat or shell scripts with an “exit” or equivalent 
statement. Failure to do so will cause the External Adapter to hang when it runs 
the script. 

cmd1 - args property tree Contains the arguments for external commands. 

cmd1 - args - values text Contains the external command arguments. 

cmd1 - env - v1..v4 property tree Contains optional environment variable data for the external 
command. 

cnd1 - enabled true, false Set to true to enable the command, false otherwise. 

End of Table 3-24

Table 3-24   External Adapter Properties  (Part 2 of 2)

Service Property Schema Description 
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Some setup examples follow. 

To run a Perl script: 

process_name = Save_Reports

cmd = perl 

workingDir = C:\Perl\bin 

args = C:\vnes\tools\saveReports.pl C:\op_admin\tmp\vne\Reports C:\vnes\reports 

env = 

To run an executable: 

process_name = Collect_Demand_Data

cmd = collectDemandData.exe 

workingDir = C:\vnes\tools 

args = C:\op_admin\tmp\vne\netflow\collectedFiles 

env = 

Demand Traffic Rollup Service 

The Demand Traffic Rollup Service manages database growth resulting from 
the continuous import of demand flow data. At this time, the service deletes 
demand data from the database that is older than the specified time period. 

Export Service 

The Export Service provides scheduled export of a full network model. The 
configuration properties in the Management Console for this service also 
specify what interface utilization and demand data is included in the network 
model. 
VNE Server/Release 3.0 VNE-3-41



3—Adapters and Services VNE Server User Guide 
The configuration properties for this service are described in the following table. 

Table 3-25   Export Service Properties 

Service Property Schema Description 

ScheduledExport property tree Contains the properties that control scheduled network 
model export. 

ScheduledExport - exportDir text Specifies the directory to which network models are 
exported. 

ScheduledExport - 
maxNumExportFiles 

integer Specifies the maximum number of archived network model 
files to retain. Once the limit is reached, the oldest file is 
deleted. 

ScheduledExport - 
allowWhiteSpace 

true, false Specifies whether the XML network model file contains 
whitespace formatting. A formatted file is larger than one that 
is not formatted, but is much easier to read in a text editor. 

Utilization Priority property tree Contains the properties that control default export of 
interface utilization data. 

Utilization Priority - ALL yes, no Specifies whether the exported network model contains 
utilization data from all sources. When set to no, the priority 
scheme defined for each source governs its inclusion in the 
model. 

Utilization Priority - Concord property tree Specifies Concord export properties. 

prefix text label A fixed text label that is used to match the data source. 

priority integer The order in which data from this source will be 

Utilization Priority - MRTG property tree Specifies MRTG export properties. 

Utilization Priority - InfoVista property tree Specifies InfoVista export properties.

Utilization Priority - MIB property tree Specifies MIB export properties.

Utilization Priority - StatScout property tree Specifies StatScout export properties.

Default Demand Export Filter property tree Contains the properties that control default export of demand 
data. 

Default Demand Export Filter - 
demand type 

menu Specifies the default demand type to export. 

Default Demand Export Filter - 
time window 

menu Specifies the default demand time period to export. 

End of Table 3-25
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4 Operation

Introduction 

VNE Server is designed to operate autonomously as a network model server. 
After installation, an iterative setup process configures and tunes VNE Server 
for data collection from a particular target network. Once configuration is 
complete, continuous data collection is started and monitored through the VNE 
Server Console. The following sections describe the VNE Server configuration 
process, and how to manage network data collection. 

VNE Server Workflow 

The workflow used with VNE Server is divided into several distinct phases: 
Installation, Configuration, and Continuous Operation. The configuration 
decisions and activities at each phase are discussed in more detail in the 
following sections. A diagram illustrating VNE Server workflow is shown below. 
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Installation 

During installation, your main decision is whether to install VNE Server and its 
network database on the same host platform or to install the VNE Server 
remotely from the database. The best reason to use a remote database is to 
take advantage of an existing database elsewhere in your organization. For very 
large networks, better performance will also be achieved if the database is 
located on a separate host than VNE Server. VNE Server can support either 
installation scenario. 

Configuration

After installation, the next phase is the configuration of VNE Server for 
continuous operation, including adapter selection and configuration. This 
portion of the setup process is iterative and consists of the following stages: 

• Create the device access information used to guide VNE Server data 
collection. 

• Identify the adapters needed based upon your network management 
environment. Use VNE Server’s third-party NMS adapters to leverage your 
other network management products as much as possible. Doing so 
minimizes the additional traffic required on your network to deliver a 
complete network model. 

• Configure and run each adapter individually. Evaluate data collection results. 
Reconfigure and retest until you are satisfied with the results. 

• Use VNE Server’s Report Manager and Network Browser to determine the 
completeness of the network that is created. 

• Import a network model into the OPNET analysis software to assess 
accuracy and completeness of the network model. 

• Design a data collection schedule for the adapters. Consider how often 
adapters should run in order to maintain a current picture of your network. 

The remainder of this chapter describes each configuration step in more detail. 

Continuous Operation 

Once adapter configuration and scheduling is defined, and any data collection 
problems are solved, you are ready to continuously run VNE Server as a 
network model server. In this role, VNE Server will build and maintain a 
complete view of your network. Anyone using the OPNET analysis software for 
network analysis can import a current network model whenever one is needed. 

During continuous operation, you should monitor the VNE Server Event Viewer 
for any Critical or Emergency events that require investigation. The Report 
Manager and Network Browser are excellent tools to view device configuration, 
as well as global information about the network. 
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Starting VNE Server 

VNE Server is started from the OPNET VNE Server 3.0 program group. This 
program group provides the selections shown in the following table:

Note—You must be logged in as Administrator for the VNE Server program 
group to be visible. 

Procedure 4-1   Start VNE Server

1 Select Start > Programs. 

2 Locate the OPNET VNE Server 3.0 program group. 

3 Select OPNET VNE Server from the OPNET VNE Server 3.0 program group. 

➥ Within a minute, the VNE Server Console opens. 

End of Procedure 4-1

Refer to VNE Server Commands on Solaris on page VNE-2-5 in the User 
Interface chapter for Solaris operation. 

Table 4-1   OPNET VNE Server Program Group Selections

Program Group Selections Function 

OPNET VNE Server Opens the VNE Server Console. 

Open File Log Viewer Opens the VNE Server File Log Viewer. 

Open Licensing Web Page Opens the OPNET License Registration web page in a 
browser. 

OPNET VNE Server 
Documentation 

Opens the VNE Server documentation menu in Acrobat 
Reader. 

Remove current project from 
database 

Removes all the data related to the current data 
collection project from the network database. 

Remove temp dir and current 
project from database 

Removes the temporary directory 
(C:\op_admin\tmp\vne) and all the data related to the 
current data collection project from the network 
database. 

End of Table 4-1
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Configuring VNE Server 

Setting up VNE Server for continuous operation involves decisions about the 
adapters you need, their setup, and scheduling. Creating device access 
information for a large network can be a tedious task. Working through device 
access problems encountered during adapter testing involves troubleshooting. 
The following sections guide you through the configuration process. 

Creating Device Access Information 

The VNE Server adapters that directly access devices in your network require 
a device file that contains access information about each device that you 
choose to include in the network model. 

The device information file contains the hostnames, access addresses, and 
login information that VNE Server needs to collect configuration and MIB data 
from each device. By default, this file is located in the <install 
dir>\input\DeviceInfo directory as deviceInfo.txt, but it can have any name or 
location. The Device Info File panel in the Management Console has a property 
that points to this file. Refer to Device Info File on page VNE-2-29 and Device 
and Platform Info on page VNE-2-29 sections of the User Interface chapter for 
more information about the device file format and editing tools. 

You can create the device info file in the following ways: 

• Offline using device access data and scripts or spreadsheets 

• Online within the Management Console

• By a combination of offline and online methods

Create a Device Info File Offline

Offline methods work best for creating an initial device information file for a large 
network. This is especially true if you already have files that list device names 
and their access addresses. You can use a spreadsheet to create the device 
file. To do so, do the following steps.

1) Import your device name and address file into a spreadsheet. 

2) Use the spreadsheet’s editing tools to fill in missing data. Refer to Device 
and Platform Info on page VNE-2-29 section of the User Interface chapter 
for details on the file format. 

3) Copy the file to the device file location configured in the Device Info File 
panel in the Management Console. 

4) Open the Device and Platform Info panel to view the contents of the device 
file. 
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If the device data does not display as expected, verify that the field order and 
delimiter is correct. Correct any problems found. 

Create a Device Info File Online

The Device and Platform Info panel is where you do online, interactive editing 
to create or maintain a device file. While you can use this panel to create access 
information for your entire network, it is less tedious to create large device files 
offline. The best use of this panel is to maintain an existing device file. Adding, 
removing, or changing device information for a small number of devices is easy. 

This panel also provides the ability to import device information from the 
following sources. 

• CiscoWorks inventory files—refer toUsing a CiscoWorks inventory File to 
Create a Device Info File on page VNE-2-33 in the User Interface chapter. 

• Concord dci files—refer to Using a Concord dci file to Create a Device Info 
File on page VNE-2-33 in the User Interface chapter. 

• HP OpenView NNM Server—refer to Using HP OpenView NNM Server to 
Create a Device Info File on page VNE-2-34 in the User Interface chapter. 

• VNE Database—refer to Using the Contents of the VNE Database to Create 
a Device Info File on page VNE-2-35 in the User Interface chapter. 

The device files from these sources are still partial files. Once the device file is 
created, import it into a spreadsheet and fill in the missing fields. When done, 
export the file back to text format. Make sure you use a field delimiter that 
matches the one specified by the delimiter property in the Device Info File panel. 

Note—Some types of devices need to be separated into multiple entries in the 
device info file. For example, Cisco Catalyst devices consist of 2 switching cores 
and additional routing modules. In this case, each addressable module should 
appear as an entry in the device info file. Interface and port modules do not need 
to be handled in this fashion. Systems from other vendors may require similar 
treatment. 

Once you have created a device info file, you are ready to select, configure and 
test the adapters. 

Choosing Adapters 

VNE Server offers a comprehensive selection of data collection adapters. Some 
adapters collect data directly from each device in the network. Others collect 
data from other NMS platforms such as CiscoWorks, HP OpenView, or 
Concord. 
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The adapters that you choose to use depend mainly upon the following 
considerations: 

• Other NMS platforms used in the network

• Device vendor mix

• Policy restrictions regarding SNMP use

• ASCII data requirements

The presence of other network management systems in your network have the 
biggest effect on adapter selection. For each of your third-party NMS platforms, 
use the corresponding VNE Server adapter to collect their data. For more 
information on particular adapters, refer to the Adapters and Services chapter 
of this manual.

CiscoWorks Adapters

For CiscoWorks, the choices are more varied. VNE Server provides separate 
adapters to collect configuration files from CiscoWorks and to access the RME 
and ANI databases. Use the adapters that correspond to your CiscoWorks 
components. 

Since the VNE Server device configuration adapters collects more information 
than CiscoWorks, consider running the following adapters to maximize the data 
collected from each device: 

• Device Config File Collection 

• Device ifIndex Import 

• Device FR Map Import 

• Device Version Import 

• Device IP Route Import 

• Device CDP Import 

• Device ARP Table Import 

• Device Interface Import 

• Device Module Import 

• Device VTP Status Import 
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• Device CAM Table Import

• Device VLAN Database Import

Note—Refer to Device Config File Collection on page VNE-3-1 in the Adapters 
and Services chapter for a list of the commands used to gather device 
configuration data for each supported vendor. 

The device vendors present in your network also affect the adapters to use. In 
a network consisting only of Cisco devices with a full CiscoWorks 
implementation, you may be able to omit the following adapters and still obtain 
a complete network model: 

• Device Config File Collection 

• Device Config File (ifIndex, FR Map, Version, IP Route, CDP, ARP Table, 
Interface, Module, VTP Status, CAM Table, VLAN Database) Import 

• Device MIB Configuration Import 

In a mixed vendor network, run all of these adapters to build a complete 
network. For such a scenario, the device file can omit Cisco devices since 
CiscoWorks supplies all configuration data for these devices. 

Collecting Utilization Data

VNE Server supports several adapters that import interface utilization data. 

• Concord eHealth and MRTG—If you use some combination of Concord 
eHealth and MRTG, use the corresponding VNE Server adapters to import 
the data. You do not need to use the MIB-Based Interface Utilization Import 
adapter. You only need this adapter if there is no other source of interface 
utilization data. 

• SNMP Polling Policies—Network management policies regarding SNMP 
polling also affect your adapter choices. If your organization tightly restricts 
SNMP polling, consider whether the data collected by the Device MIB 
Configuration Import and MIB-Based Interface Utilization Import adapters is 
worth the additional traffic on your network. 

• Geographic Data Import—VNE Server provides the ASCII Generic Data 
Import adapter to support import of geographic location and link override 
data. Consider whether you need this adapter to build a complete network. 

• Network Link Information—Always use the Link and Connection Inference 
Service. If you do not use HP OpenView, this service is the only way to create 
links for your network. For HP OpenView users, VNE Server can infer 
additional network links based upon the broader set of data available to VNE 
Server. Do not rely solely upon HP OpenView for creation of network links. 
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• Framework Services—Always use the framework services: Database 
Aging Service, Maintenance Service, Demand Traffic Rollup Service, 
Interface Utilization Rollup Service and the Change Records Maintenance 
Service. These services perform essential housekeeping for VNE Server. 

— The Database Aging Service removes stale data from the database. 

— The Maintenance Service removes outdated files from the file system. 

— The Demand Traffic Rollup and Interface Utilization Rollup services 
remove old demand and interface utilization data from the database. 

— If you have enabled archival of network changes, use the Change 
Records Maintenance Service to manage the growth of network change 
history in the database. 

Once you have chosen the adapters that best fit your network management 
environment and modeling needs, you are ready to configure and test each 
adapter. 

Configuring Adapters 

Once you have created device access information about your network, and 
have chosen adapters, you must configure each adapter for operation. Most of 
the default settings for adapter properties can remain unchanged. Use the 
Adapter Resources panel in the Management Console to evaluate each adapter 
property. Change adapter properties, as needed, to configure adapters for your 
network. 

Note—Before you configure adapters, review Management Console on 
page VNE-2-24 in the User Interface chapter to learn more about user 
interfaces in the Management Console. For each adapter that you need, review 
its description in the Adapters and Services chapter. 

The following sections discuss configuration issues for each adapter. 

Device Config File Collection Adapter 

In the Management Console, open the Adapter Resources panel. Expand the 
property tree for the Device Config File Collection adapter. 

1) Review and adjust the timeout and retries properties to values appropriate 
for your network. 

2) Review the login properties for each device vendor in your network. 

The login command and response sequence programmed in the login 
properties should match the sequence configured for your devices. 

Check the command sequence for all supported access methods (SSH, 
TACACS+, etc.) under each vendor. 
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3) Review the show commands properties for each command and vendor.

The command sequence should match the sequence configured for your 
devices. 

If you have mixed login or show command sequences for a specific device type 
in your network, you must create new device types so that all the command 
sequences are defined. Each device in the device info file should have the 
Device Access Script field set to a device type (vendor or vendor subtype). 

Device Configuration Import Adapters 

In the Adapter Resources panel, expand the property tree for each of the device 
configuration import adapters. Review each property and change the settings as 
needed. The default settings for these adapters are suitable for normal 
operation.

CiscoWorks Adapters 

Since the CiscoWorks adapters connect to CiscoWorks databases to collect 
data, most of the adapter properties specify database connection attributes. In 
the Adapter Resources panel, expand the property tree for the CiscoWorks 
adapters. Review each property and change the settings as needed. Work with 
the CiscoWorks administrator to get the hostname, database name, user info, 
port numbers and other information needed to access the CiscoWorks 
databases. 

Note—Some configuration is required on the CiscoWorks host to permit access 
from the VNE Server host. Refer to Configuring CiscoWorks on page VNE-5-37 
in the Administration chapter for instructions on how to configure CiscoWorks to 
work with VNE Server. 

Device MIB Configuration Import Adapter 

In the Adapter Resources panel, expand the property tree for the Device MIB 
Configuration Import adapter. Review each property and change the settings as 
needed. With this adapter, the timeout used by the SNMP engine may need to 
be increased. If you have other network management products that use SNMP 
to poll the network, start with timeout settings that are known to work in your 
network.
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HP OpenView NNM Import Adapter 

In the Adapter Resources panel, expand the property tree for the HP OpenView 
NNM Import adapter. Review each property and change the settings as needed. 
For this adapter, change the HP OpenView access properties to match those 
used in your network. 

Note—If VNE Server is located on a different host machine than HP OpenView, 
some configuration is required in the HP OpenView environment to permit 
access from the VNE Server host. Refer to Configuring HP OpenView on 
page VNE-5-36 in the Administration chapter for instructions on how to 
configure HP OpenView to work with VNE Server. 

Link and Connection Inference Service 

In the Adapter Resources panel, expand the property tree for the Link and 
Connection Inference Service. Review each property and change the settings 
as needed. The properties for this service allow you to disable link inference 
based upon a specific information source. Link creation based upon ARP and 
CAM data is disabled by default. Consider whether you should enable these 
properties. 

Trace Route Link Inference Service 

In the Adapter Resources panel, expand the property tree for the Trace Route 
Link Inference Service. Review each property and change the settings as 
needed. Review the traceRouteVendorList settings to ensure that the expected 
prompts match the configured setting. 

MIB-Based Interface Utilization Import Adapter 

In the Adapter Resources panel, expand the property tree for the MIB-Based 
Interface Utilization Import adapter. Review each property and change the 
settings as needed. Change the sampleInterval property to the desired 
polling interval (seconds). Consider whether the retry count should be 
increased. This adapter requires you to configure source list.

Concord eHealth Network Utilization Import Adapter 

VNE Server supports data collection from one or more Concord servers. Each 
server has its own set of configuration properties. In the Adapter Resources 
panel, expand the property tree for the Concord eHealth Network Utilization 
Import adapter. Review each property and change the settings as needed. 

• This adapter requires you to configure the “live” source. If you have multiple 
Concord systems, use New Sibling to make copies of “live”. Configure each 
server instance. Change the access properties (platform, hostName, 
userName, etc.) to match the server. 
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• The additionalParams property is used for any extra access commands that 
are needed to navigate to Concord data. Edit the prompt and reply properties 
with these commands. If no extra commands are required, then delete the 
param1, param2 nodes under additionalParams. Adjust the timeout 
property as needed. 

• Change the commandPrompt property to reflect the command line prompt 
displayed by the Concord host. 

• Expand the cnhExport property tree. Adjust the timeout property as 
needed. Change trafficRange to the setting that reflects the amount of traffic 
to import from Concord. 

• Expand the groupNames property. Add, change or remove groups to match 
those setup on the Concord server. 

• Set the active property to yes. Configuration is complete. 

Refer to Configuring Concord eHealth on page VNE-5-40 in the Administration 
chapter for more information about how to configure Concord to work with VNE 
Server. 

MRTG Interface Utilization Import Adapter 

VNE Server supports data collection from one or more MRTG servers. Each 
server has its own set of configuration properties. By default, two servers are 
provided. Both servers are disabled. One is configured for a MRTG server that 
has the same path for its working, cfg, and log directories. The other provides 
properties to define separate paths for each directory.

In the Adapter Resources panel, expand the property tree for the MRTG 
Interface Utilization Import adapter. Review each property and change the 
settings as needed. This adapter requires you to configure the server list 
property. 

Note the following:

• If you have one MRTG server, and its working directory configuration 
matches one of the default servers, edit the access properties (hostName, 
userName, etc.) for the matching server entry. Set the working directory 
paths. Set the active property to yes. Configuration is complete.

• If neither MRTG server entry matches your server setup, alter the closest 
setup by adding and changing properties until you are done. Configure the 
access properties, set the working directory paths and set the active 
property to yes. 

• If one of the existing MRTG servers matches your server setup, but you have 
more than one server with this setup, then use the New Sibling button to 
clone the matching setup for each of server. Configure the access properties, 
set the working directory paths and set the active property to yes for each 
server. 
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Refer to Configuring MRTG on page VNE-5-40 in the Administration chapter for 
more information about how to configure MRTG to work with VNE Server. 

InfoVista Network Utilization Import Adapter 

VNE Server supports data collection from one or more InfoVista servers. Each 
server has its own set of configuration properties. By default, two servers are 
provided, with both servers disabled. 

In the Adapter Resources panel, expand the property tree for the InfoVista 
Network Utilization Import adapter. Review each property and change the 
settings as needed. This adapter requires that you configure the server list 
property. 

For server1, edit the access properties (hostName, userName, etc.) for the 
matching server entry. Set the active property to yes. If you have a second 
server, configure the server2 properties. If you have more than 2 servers, use 
the New Sibling button to clone additional servers. Fill in each new server’s 
properties. Configuration is complete.

Refer to Configuring InfoVista on page VNE-5-41 in the Administration chapter 
for more information about how to configure InfoVista to work with VNE Server.

Cisco Netflow Collection 

In the Adapter Resources panel, expand the property tree for the Cisco Netflow 
Collection adapter. Review each property and change the settings as needed. 
Configure the access information for the Netflow Collector servers in your 
network. Use this adapter together with the Demand Traffic Processing Service. 

Demand Traffic Processing Service 

In the Adapter Resources panel, expand the property tree for the Demand 
Traffic Processing Service. Review each property and change the settings as 
needed. Use this service to map and process traffic demands collected by the 
Cisco Netflow Collection adapter. 

ASCII Generic Data Import Adapter 

In the Adapter Resources panel, expand the property tree for the ASCII Generic 
Data Import adapter. Review each property and change the settings as needed. 
By default, this adapter has properties defined that point to a sample override 
file. 

For more details about creating a data file with geographic location or link 
override information, refer to ASCII Generic Data Import on page VNE-3-32 in 
the Adapters and Services chapter. This section also describes how to add 
additional override properties for this adapter. 
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Maintenance Service 

In the Adapter Resources panel, expand the property tree for the Maintenance 
Service. Review each property and change the settings as needed. The main 
item to review is the event log retention period. Expand the EventLogDir 
property and then expand the old than property. Change the timeCount and 
timeUnit properties to the desired values. 

Depending upon the size of the network and adapter scheduling, a week of 
event logs can use 100-200 MBytes of disk space. Keeping event logs for 
several days is useful for troubleshooting purposes. Keeping logs longer than a 
week is of less value. 

Interface Utilization Rollup Service 

In the Adapter Resources panel, expand the property tree for the Interface 
Utilization Rollup Service. Change the traffic retention intervals to the desired 
setting for each utilization source. 

WARNING—If you use any of the interface utilization adapters, you must run 
the Interface Utilization Rollup Service in order to control the growth of traffic 
data in the VNE database. 

At this point, VNE Server adapter configuration is completed. The next step is 
to test each adapter and correct any problems with adapter operation. 

Report Export Service 

In the Adapter Resources panel, expand the property tree for the Report Export 
Service. Configure the desired output directory for the reports and their format. 
Expand the reportList and enable each report that you wish to export. 

Testing Adapters 

After adapter configuration is complete, test each adapter to verify device and 
platform access information, connectivity, and the ability to import adapter data. 
Some of the problems found during adapter testing are 

• Incorrect device info: address, login information, access methods 

• Device or NMS platform unreachable from the VNE Server host 

• NMS platform data inaccessible

When you test run an adapter, monitor the event messages that appear in the 
VNE Server Event Viewer. The Event Viewer events show whether the problem 
device is reachable or whether a login error occurs. Event Viewer events also 
show if login is successful but data retrieval failed. 
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If you have problems accessing a device or NMS platform, verify access 
information and reachability by trying the following:

• Ping devices and NMS platforms to verify reachability. 

• If a problem device is reachable, telnet to the device and login. 

• If you can successfully login, run the adapter commands used to get the 
device configuration. Note any problems. 

Correct any device access information problems in the Device and Platform Info 
panel of the Management Console. Stop and restart VNE Server services to 
reinitialize device data. Retest the adapter. 

Correct any network reachability problems. If needed, add static routes to the 
VNE Server host. Retest the adapter. 

Correct any adapter setup problems such as incorrect access information for a 
NMS platform. Retest the adapter. 

Continue to work through each of the adapters in this manner. 

Evaluating the Network Model 

After all adapters have been tested and setup problems corrected, use the VNE 
Server Report Manager and Network Browser to examine the network. Import 
the network into an OPNET analysis software project. Examine the topology, 
configuration and traffic imported into the OPNET analysis software model from 
VNE Server. As you evaluate the network model created by VNE Server, you 
may find 

• Missing devices 

• Unexpected devices 

• Missing links or a disconnected topology 

• Incorrect interface speeds 

Investigate anything that appears incorrect based upon your knowledge of the 
network. 

• Missing devices generally result from an incomplete device info file.

• Unexpected devices can be created due to configuration problems or stale 
data from NMS platforms. ASCII data files created by the user for the ASCII 
Generic Data Import adapter may have devices that do not belong in the 
network. 
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• Missing links can mean that the adapters in use do not provide enough 
information to infer the link. Consider whether running adapters that are not 
being used will populate additional data that can aid link inference. Missing 
links may also be due to portions of the network being isolated by firewalls or 
other unmodeled devices. 

• Incorrect interface speeds may be the result of ambiguous configuration 
data. 

Manually run the Trace Route Link Inference Service to fill in missing devices 
and links. This service discovers “hidden” devices in your network and adds 
them to the device info file. Fill in empty fields for these new devices so that 
other adapters can collect data from them to produce a richer network model. 

Correct all problems found in both adapter setup and NMS platforms. Rerun 
adapters. Use the Report Manager and Network Browser to examine network 
data. You can usually see whether a problem has been fixed with these tools. 
Try another model import into an OPNET analysis software project. Iterate until 
the network model is the best that can be obtained, and the causes of missing 
devices, links or data are understood. 

Once you have finalized adapter configuration, you are ready to configure the 
adapter schedules. 

Scheduling Adapters 

The last configuration step before putting VNE Server into continuous operation 
is to configure adapter schedules. VNE Server provides complete flexibility in 
scheduling adapter operation. You can schedule adapters to run on a regular 
basis, or you can schedule adapters to run based upon events raised by other 
adapters. In practice, you will likely use a mix of both scheduling methods. 

Since the VNE-XML Import service imports all the data supplied by adapters 
into the network database, it is important to not over-schedule the adapters. 
Doing so overloads the VNE-XML Import service, which causes it to fall behind. 
Using event-based scheduling, as much as possible, results in the most efficient 
operation for VNE Server and the most current network model. 

When scheduling adapters, consider the following questions. 

• How often does the network configuration change? 

• How large is the network? 

• How often should each adapter poll the network? 

• Do you want some adapters to poll more than once in a data cycle? 

• How often do the third-party NMS products poll the network? 
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The answers to these questions help determine how you schedule the adapters. 
For example, if you have a daily maintenance window for changing your network 
configuration, scheduling all adapters to run 4 times a day will add little to no 
value. 

The size of your network also affects scheduling decisions. If all the adapters 
that you want to run need 4 hours to poll the network and import data into the 
database, then 4 hours is the shortest polling interval that can be used if you are 
using time-based scheduling. 

The polling behavior of third-party NMS products affect your adapter scheduling 
decisions. If a third-party NMS product polls the network every 4 hours, there is 
no value in scheduling the corresponding VNE Server adapter to run any sooner 
than this interval. 

MIB-Based Interface Utilization Import Adapter

The MIB-Based Interface Utilization Import adapter presents a special case. 
This adapter polls the network based upon its sampleInterval property, not the 
scheduled adapter time. The scheduled time refers to when the adapter 
processes its collected data and produces XML data files for import by the 
VNE-XML Import adapter. With this adapter, you have the option to poll and 
collect data more often than you import the data. You do not need to import data 
after each polling cycle, but should not let more than about 6 to 12 polling cycles 
of data accumulate before the XML data is imported. 

Chaining Adapters

The best way to schedule the VNE Server adapters is to use time-based 
scheduling for the third-party NMS adapters based upon the polling schedule of 
the corresponding NMS product. 
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Use event-based scheduling to chain together all the other adapters with the 
time-based ones. The following table shows the events you should use to chain 
to each adapter. 
Table 4-2   Events to Use for Chaining Adapters and Services  (Part 1 of 2)

Adapter or Service Event

Device Config File Collection Finish Import 

Remote File Collection Finish Import 

Device Config File Import, ifIndex, FR Map, Version, IP 
Route, CDP, ARP Table, Interface, Module, VTP 
Status, CAM Table Import VLAN Database Import

Finish Import 

CiscoWorks Config File Collection Finish Import 

CiscoWorks Config File Import Finish Import 

CiscoWorks RME Database Import Finish Import 

CiscoWorks ANI Database Import Finish Import 

Cisco WAN Manager Import Finish Import 

Device MIB Configuration Import Finish Import 

HP OpenView NNM Import Finish Import 

Link and Connection Inference Finish Import 

Trace Route Link Inference NA 

MIB-Based Interface Utilization Import Finish Import 

Concord eHealth Network Utilization Import Finish Import 

StatScout Interface Utilization Import Finish Import 

MRTG Interface Utilization Import Finish Import 

InfoVista Network Utilization Import Finish Import 

VistaMart Interface Utilization Import Finish Import 

Cisco Netflow Collection Finish Import 

NetScout nGenius Import Finish Import 

Cflowd Import Finish Import 

Demand Traffic Processing Service Service End 

ASCII Generic Data Import Finish Import 
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The configuration file collection and import adapters should always be chained 
together via event-based scheduling. Chain the following adapters:

• Device Config File Collection, Device Config File Import, ifIndex, FR Map, 
Version, IP Route, CDP, ARP Table, Interface, Module, VTP Status, CAM 
Table Import, VLAN Database Import. 

• CiscoWorks Config File Collection, CiscoWorks Config File Import (also 
chain the RME and ANI adapters if your installation has these databases). 

• Cisco Netflow Collection, Demand Traffic Processing Service. 

To configure the adapter schedules, use the Management Console Adapter 
Schedule panel. For unused adapters, set the active property for the adapter to 
false. Set this property to true for all other adapters. For each adapter using 
time-based scheduling, set the cycle and delay properties to your chosen value. 
For each adapter using event-based scheduling, select Event from the schedule 
type menu. Choose the triggering event and source adapter in the other 
pull-down menus for the schedule. 

Refer toAdapter Schedule on page VNE-2-36 section in the User Interface 
chapter for more information about adapter scheduling. 

Post Processor Finish Import 

Database Aging Service Service End 

Maintenance Service Service End 

Change Records Maintenance Service Service End 

Report Export Service Service End

Interface Utilization Rollup Service Service End 

External Adapter Adapter End 

 Demand Traffic Rollup Service Service End

Export Service Service End 

End of Table 4-2

Table 4-2   Events to Use for Chaining Adapters and Services  (Part 2 of 2)

Adapter or Service Event
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Continuous Operation 

Once configuration activities are complete, you are ready to transition VNE 
Server to continuous operation. The following sections describe how to start 
data collection and monitor operation using the Console, Event Viewer, Report 
Manager, and Network Browser. 

Using the VNE Server Console to Start and Monitor Data Collection

The VNE Server Console is used to start data collection and to monitor system 
events during initial data collection. You can also use the Console to verify that 
all the enabled adapters activate and that no problems exist with data collection. 
For more information about the VNE Server Console, refer to Console on 
page VNE-2-6 section in the User Interfacechapter. 

Starting Data Collection 

During the configuration process, the network database was populated with test 
data. Before running VNE Server in an operational mode, delete the test 
database by performing the following steps. 

1) Stop VNE Server services, if they are running, and exit VNE Server. 

2) Use the Program Group menu for VNE Server to remove the database and 
temp dir files. Refer to Deleting the Temporary Directory and Current 
Project on page VNE-2-3 in the User Interface chapter. 

3) Restart VNE Server using the procedureStarting VNE Server on 
page VNE-2-2 in the User Interface chapter. 

To monitor VNE Server more closely during initial data collection, switch the 
Console to Detail View mode so you can monitor adapter execution. Open a 
Live Event Log Viewer so start-up events are visible. 

Start VNE Server data collection using the procedure Starting VNE Services on 
page VNE-2-15 in the User Interface chapter.

When services start, a Progress Status box opens and displays start-up 
progress information. After adapters are triggered to run, the Console shows 
adapters operating, and the Event Viewer shows adapter events. 

If you need to stop data collection, refer to Stopping VNE Services on 
page VNE-2-15 in the User Interfacechapter. Note that when you stop data 
collection, any data in the network database is retained. You can restart data 
collection at any time. 
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Monitoring Data Collection 

After you start data collection, closely monitor the progress of initial data 
collection. Continue to monitor adapter activity throughout the remainder of the 
first data collection pass. Use the Console System Status panel to verify 
adapters are running as intended. 

• Verify that each adapter and service runs when scheduled. 

• Verify that adapter and service operation is mostly sequential. 

• Verify that VNE-XML Import is processing and importing data. 

As system events begin to appear in the Event Viewer, verify that 

• Few device access errors occur 

• Third-party NMS products are successfully accessed

• No Emergency or Critical events occur

Throughout VNE Server operation, use the Adapter Statistics view to examine 
adapter execution statistics. To open Adapter Statistics, select View > Adapter 
Statistics from the Console menu bar. Using Adapter Statistics, verify that 

• All adapters are running 

• Devices are accessed successfully

• Files are collected from third-party NMS products

• Links are created

Determine proper operation of VNE Server by monitoring system events and by 
using the Report Manager and Network Browser. These same tools can be 
used at any time to verify that VNE Server is operating as intended or to view 
information about the network. 
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An example of the VNE Server Console window during data collection is shown 
below. 

Figure 4-1   Using the Console to Monitor Operation

Using the Report Manager 

The VNE Server Console gives you a window into system operation as the 
adapters collect and import network data. The Report Manager lets you retrieve 
collected network data from the database in order to examine the merged, 
unified view of the network. For this reason, Report Manager is the best VNE 
Server tool to verify correctness of operation. While the VNE Server Console 
shows that all adapters are running, the Report Manager verifies that data is 
merged properly and imported into the network database. For more information 
on the Report Manager, refer to Report Manager on page VNE-2-40 in the User 
Interface chapter. 
VNE Server/Release 3.0 VNE-4-21



4—Operation VNE Server User Guide 
To verify that VNE Server is creating a correct view of your network, display the 
following reports. Verify that each report’s content makes sense based upon 
your knowledge of the network. 

• Node Summary—Are all devices present? 

• Interface Summary—Does interface information appear? 

• Link Summary—Do the inferred links appear correct? 

• Asset Inventory—Do hardware assets appear? 

• Router Protocols—Do the routing protocols match those used? 

• Interface Utilization—Does traffic activity appear? 

• Adapter Collection—Are all adapters collecting data? 

• Adapter Discovery—Is any data only seen by just one adapter?

• Adapter Discrepancy—Any discrepancies between data sources? 

Other reports provide helpful summary information about your network. These 
reports are 

• Network Summary—Shows the number of devices by each vendor, 
interfaces and links by type. 

• Access List Summary—Shows device access lists. 

• Configuration Summary—Shows the number of devices using each 
protocol. 

• Device and Vendor Summary—Breaks down network composition by 
device and vendor. 

• Interface/Port Summary—Shows the number of ports in operation across 
the network. 

• Software Version Summary—Breaks down network composition by vendor 
and device software version. 
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Examples of several key reports are shown below. 

Figure 4-2   Node Summary Report
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Figure 4-3   Interface Summary Report 

Figure 4-4   Link Summary Report 
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Using the Network Browser 

Another tool that you can use to examine the network is the Network Browser. 
This tool provides a graphical treeview of the network and the data properties of 
each device in the network. Many of the properties available are retrieved from 
device configuration files. You can also view additional properties from other 
sources, such as ASCII data and the Device MIB Configuration Import adapter. 

For more information about the Network Browser, refer to Network Browser on 
page VNE-2-53 in the User Interfacechapter. 

Spot check the information for several devices in the network, comparing the 
displayed configuration information to that collected from the device 
configuration files. An example of the Network Browser window with some 
expanded device data is shown below: 

Figure 4-5   The Network Browser

The VNE Server Console, Report Manager, and Network Browser provide good 
tools for monitoring VNE Server operation and for examining the network model. 
The next section describes how to import a VNE Server network model into the 
OPNET analysis software where the model is used for analysis projects. 
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Importing a VNE Server Network Model into the OPNET analysis software 

After VNE Server has been running long enough to build a complete and 
accurate network model, you can import the model into an OPNET analysis 
software project. Model import from VNE Server into intelligent network 
management clients is automatic. The VNE Server Console displays events that 
show an export request (export from VNE Server’s perspective) being 
processed. 

Note—No action is required by the VNE Server administrator to support a 
specific model export request. 

Note—VNE Server can support multiple, simultaneous export operations to its 
OPNET analysis software clients. 

Connecting an OPNET analysis software Client to VNE Server 

To successfully import a network model from VNE Server, the OPNET analysis 
software client must be provided a valid vneserver.ior file. The vneserver.ior file 
is created by VNE Server when services are started, and placed in the temp 
directory on the VNE Server host. This file contains the information that the 
OPNET analysis software client needs to request a model from VNE Server. 

WARNING—Whenever VNE Server data collection is halted and restarted, a 
new vneserver.ior file is created. If the OPNET analysis software client resides 
on the same host as VNE Server, this does not present a problem. However, if 
the two applications reside on separate hosts, the OPNET analysis software 
client no longer sees a valid ior file. Subsequent attempts to import a model will 
fail. The new ior file must be visible at the vne_import_ior_file path (set in 
OPNET analysis software preferences), or model import into OPNET analysis 
software fails. New ior files can be copied manually to the OPNET analysis 
software host. 

WARNING—Whenever VNE Server data collection is halted and restarted, the 
CORBA connection ports change. If you are connecting to VNE Server through 
a firewall, the new ports must be opened so that the OPNET analysis software 
client can communicate with VNE Server. Refer to Tech Support FAQ 1155 for 
information on decoding the port numbers from the vneserver.ior file. 

The simplest way to ensure that the OPNET analysis software client maintains 
access to a valid ior file is to make the VNE Server temp directory shareable and 
setup a network drive mapping so the vne_import_ior_file OPNET analysis 
software preference points directly to the ior file. 
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Importing a Model 

When importing a network model from VNE Server, the following import 
features are available: 

• Full import of the current network model

• Full import of an archived network model

• Import of topology with no background utilization or demand data

• Partial model import through selection of a device group

• Full or partial topology import with background utilization selection by source 
and time

• Full or partial topology import with demand flow selection by demand type 
and time

Procedure 4-2   Import from VNE Server

1 Create a new project in OPNET analysis software by selecting File > New from the 
main menu. 

➥ A dialog box labeled New opens. 

2 Select Project from the menu. Press OK. 

➥ An dialog box labeled Enter Name opens. 

3 Enter the project and scenario names that you want to use into the text fields of the 
Enter Name dialog box. Press OK. 

➥ The Startup Wizard: Initial Topology dialog box opens. 
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4 Select Import From VNE Server. Press Next. 

➥ An Import From VNE Server options dialog box opens. 

5 Select an Import Type. To import an network model from the list of archived 
models, select Archived Network. To import the current model in VNE Server or 
to filter by device groups, background utilization, or demand flows, select Current 
Network. 

6 Use the Advanced Options dialog to make your choices, if you wish to import a 
portion of the VNE Server model or filter background utilization or demand flows 
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7 Press Import, when done selecting import options.

➥ An import progress box opens. Model import takes several minutes. During this 
time, progress messages appear in the progress box. When import is done, the 
network model appears in the main project window. 

End of Procedure 4-2
VNE Server/Release 3.0 VNE-4-29



4—Operation VNE Server User Guide 
VNE-4-30 VNE Server/Release 3.0



VNE Server User Guide 5—Administration
5 Administration

Introduction 

This chapter describes the VNE Server environment and common 
administrative tasks. VNE Server does not require extensive administration. 
However, you need a basic understanding of the installation and temporary 
directory environment for effective troubleshooting and administration. Since 
VNE Server relies upon an Oracle database, some basic knowledge of Oracle 
administration is also presented in this chapter. 

VNE Server Administration 

This section describes the VNE Server installation and temporary directory 
environment. Administrative procedures in the following areas are also covered. 

• Managing projects 

• Reconfiguring VNE Server 

• Managing logs and traffic data 

• Software upgrades 

• License operations 

• Configuring OPNET analysis software 

Important Files 

To create the full installation path for VNE Server, the system appends 
\VNEServer\3.0 to the path chosen during installation. The VNE Server 
installation directory has the following main subdirectories: 

• doc—Contains VNE Server documentation

• input—Contains device access information and ASCII data files

• lib—Contains XML control files, MIBs, ASCII data templates

• log—Contains product log files

The VNE Server startup scripts, database scripts, and libraries are located in 
the installation directory. 
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Table 5-1 lists some important files within the VNE Server environment. 

Temporary Directory 

The VNE Server temporary directory, temp dir, is the working directory where 
adapter data files are collected and processed. By default, this directory is 
C:\op_admin\tmp\vne and contains subdirectories that are organized by 
adapter. Configuration and traffic data files collected by the adapters are stored 
throughout the temp dir. The XML files produced by each adapter are also 
staged in the temp dir before they are imported into the network database. 
Adapters rename their temporary files after they are processed, so the 
Maintenance Service can identify and remove old files. 

Note—You specify the location of the temp dir during VNE Server installation 
and cannot change it after installation is complete. 

Table 5-2 shows the organization of the VNE Server temp dir environment. 

Table 5-1   Important VNE Server Files

Description Files

File used by OPNET analysis software to import 
data from VNE Server

<temp_dir>\vneserver.ior

VNE Server project lock file <temp_dir>\lock\<project_name>.lck

Console event log file <install_dir>\log\eventLog\vne.log

RMID log file <install_dir>\log\vne_rmid_log.log

Adapter Statistics log file <install_dir>\log\adapterStats\adapterStats_<project_name>.txt

Product startup script <install_dir>\vnes.bat (Windows)
<install_dir>\vnes.sh (Solaris)

Product definition files <install_dir>\lib\xml\dtd

Product resource files <install_dir>\lib\xml\res

Database setup scripts <install_dir>\setup_accounts.sql
<install_dir>\drop_accounts.sql

Installation log files <install_dir>\InstallLogs\installer_debug_initial.log

End of Table 5-1
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Table 5-2   VNE Server Temp Dir Organization  (Part 1 of 2)

Directory Contents 

temp dir root 
(C:\op_admin\tmp\vne) 

Contains subdirectories and XML import files. 

Baseliner Contains xml traffic data produced by the MIB-Based Interface Utilization Import 
adapter. 

cflowd Contains demand XML from processed Cflowd data. 

Cnh 

Cnh\input Contains traffic files collected from Concord. 

Cnh\xml Contains XML from processed Concord data. 

Collect 

Collect\ARP Contains ARP files. 

Collect\CAM Contains CAM files. 

Collect\Cdp Contains CDP files. 

Collect\Configs Contains config files. 

Collect\Configs_CiscoWorks Contains config files collected from CiscoWorks. 

Collect\FRMap Contains frame relay map files. 

Collect\ftp Contains any files collected by the Remote File Collection adapter. 

Collect\ifIndex Contains ifIndex files. 

Collect\Interface Contains Interface files. 

Collect\IPRoute Contains IP Route files. 

Collect\Module Contains Module files. 

Collect\Version Contains Version files. 

Collect\Vlan Contains VLAN files. 

Collect\VTP Contains VTP status files. 

Cw 

Cw\Ani\Xml Contains XML from processed CW ANI data. 

Cw\cache Contains a cache of collected CW files. 

Cw\Rme\Xml Contains XML from processed CW RME data.
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Device_MIB_Collection  Contains XML from Device MIB Configuration Import adapter. 

dns Contains XML from processed reverse DNS lookups. 

export Contains exported XML files of the network model. 

hpov Contains XML from processed HP OpenView data. 

iv 

iv\xml Contains XML from processed InfoVista data. 

lock Contains the VNE Server lock file. 

mrtg 

mrtg\input Contains traffic files collected from MRTG. 

mrtg\xml Contains XML from processed MRTG data.

netflow 

netflow\collectedFiles Contains collected Netflow data. Organized by date, source and flow type. Processed 
demand XML resides in this directory tree. 

netflow\filteredDemands Contains log file showing low traffic demands. 

netflow\xml Not used. 

NetScout Contains XML from processed NetScout nGenius demand data. 

Reports Contains the exported reports. 

ss 

ss\input Contains StatScout input files, organized by device. 

ss\xml Contains XML from processed StatScout data. 

End of Table 5-2

Table 5-2   VNE Server Temp Dir Organization  (Part 2 of 2)

Directory Contents 
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Managing Projects 

Managing VNE Server involves making decisions about project naming that 
affect workflow and data retention across an upgrade. This section describes 
the impact of various project naming conventions. 

Choosing a Project Name 

A VNE Server project represents a model of the network defined by the devices 
in the project’s device information, Device Info, file. VNE Server uses the project 
name, assigned in the Management Console Project Properties panel, to name 
the underlying database tables that store network data. For this reason, the 
project naming convention that you use will affect workflow and upgrade 
strategy. 

When you setup VNE Server, choose among these project naming conventions:

• Use the same name for all projects across all VNE Server releases. 

• Use a project name that is specific to each network and release. 

If you use the same project name for each target network and release, 
administration is simplified, but you may not be able to migrate the database 
across releases. VNE Server does not currently migrate database data to a new 
release when the underlying data schema changes. If you choose this naming 
convention, you must delete your project data and repopulate the database to 
handle schema changes or to model a different network. On the other hand, this 
naming approach results in a smaller database than other approaches. 

If you use a project name per network and release, you can model different 
portions of your network and maintain the data for each network in the database 
at the same time. When you migrate to a release that changes the data schema, 
you must still populate the database with the new project name. However, the 
network model created by the previous release remains in the database and can 
still be accessed by the previous release. This approach provides the greatest 
operational flexibility with VNE Server but consumes the most database space. 

The naming convention that works best for you depends upon the following 
factors:

• The size of your network and available database storage 

• Your need to switch VNE Server among different networks 

• Your need to retain network models from older releases 
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Reconfiguring VNE Server Data Collection

Normally, VNE Server is in continuous operation against a given network. The 
network that VNE Server sees may be your entire network or just a portion of 
the network. For example, you may be using VNE Server to model only your 
core network. The following procedure describes how to switch data collection 
over to another network. 

Procedure 5-1   Switching Data Collection to Another Network

1 Open the VNE Server Management Console.

2 Create a Device Info file for the new network.

3 Create any ASCII data files required for the new network. 

4 Stop VNE Server data collection for the current network by selecting Control > 
Stop VNE Services from the Console menu bar. 

5 Use the Management Console Project Properties panel to assign a new project 
name. 

6 Use the Device Info File panel to point to the new device file.

7 Adjust adapter settings for the new network.

7.1 Reconfigure adapters as needed from the Adapter Resources panel. 

Note—You may need to reconfigure the adapters that access network 
management platforms such as Concord.

7.2 Review the Adapter Scheduling panel, and make any changes required for 
the new network. 

8 Exit the Management Console by pressing OK. 

9 Exit VNE Server by selecting File > Exit from the Console menu bar. 

10 Open the OPNET VNE Server Program Group menu. 

11 Start VNE Server services by selecting Control > Start VNE Services. 

End of Procedure 5-1

Monitor data collection and evaluate the resulting network model as described 
in the Operation chapter. 
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Managing Logs and Traffic Data 

During operation, VNE Server produces log files that contain Console events 
and internal system activity. These files can consume hundreds of megabytes 
of disk space. If you are using VNE Server to collect interface utilization data, 
the traffic data that is written to the database can also require a significant 
amount of storage. This section describes the tools that VNE Server provides 
for managing logs and traffic data. 

Managing Log File Growth 

VNE Server provides the following types of logs: 

• Console event logs that are located at: <install dir>\log\eventlog

• RMID logs that are located at: <install dir>\log

The events displayed by the VNE Server Console are stored in multiple log files. 
The log file that contains events currently displayed in the console is named 
vne.log. Once the maximum event display count is reached in the Console, this 
file is capped, renamed to a vne_<date_time>.old.log file name, and a new 
vne.log file is opened. 

The RMID log provides a history of adapter operation that shows the sequence 
of adapter operation and any warnings, failures, errors or exceptions that occur 
during adapter operation. This log file is named vne_rmid_log.log, and its size 
is capped at a default size of 10 MB. When the log file grows to this size, it is 
renamed to vne_rmid_log.log.archive.<timestamp>, and a new file started. By 
default, the last 10 files are retained. After the maximum number of log files is 
reached, the oldest file is deleted. 

If you want to change the retention period for log files, use Procedure 5-2.

Procedure 5-2   Set the Retention Period for Log Files

1 Open the Management Console by selecting Control > Management Console 
from the Console menu bar. 

➥ The Management Console opens. 

2 Select the Adapter Resources panel in the Management Console. 

➥ The Adapter Resources panel becomes visible. 

3 Expand the Maintenance Service property tree. 

4 Expand the EventLogDir property tree that is located in Maintenance Service. 

5 Expand the old than property tree that is located in EventLogDir. 

6 Change the timeCount and timeUnit properties to the desired settings. 
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7 Save the changes by pressing the Apply button. 

End of Procedure 5-2

Procedure 5-3   Setting Up the Maximum Size for the RMID Log File

1 Open the Management Console by selecting Control > Management Console 
from the Console menu bar. 

➥ The Management Console opens. 

2 Select the Project Properties panel in the Management Console. 

➥ The Project Properties panel becomes visible. 

3 Expand the VNESfeatures property tree. 

4 Expand the logging property tree that is located in VNESfeatures. 

5 Change the maxLogFileSize_In_KB property to the desired setting. 

6 Save the changes by pressing the Apply button. 

End of Procedure 5-3

Managing Traffic Data Growth 

The traffic data imported from the interface utilization adapters by VNE Server 
is stored in the network database. If nothing is done to manage the growth of 
traffic data, all available storage space in the database will eventually be 
exhausted. VNE Server uses the Interface Utilization Rollup Service to remove 
any traffic from the database that is older than a user-specified threshold 
setting. 

You can change the retention period for traffic data by using Procedure 5-4.

Procedure 5-4   Set the Retention Period for Traffic Data

1 Open the Management Console by selecting Control > Management Console 
from the Console menu bar. 

➥ The Management Console opens. 

2 Select the Adapter Resources panel in the Management Console. 

➥ The Adapter Resources panel opens. 

3 Expand the Interface Utilization Rollup Service property tree. 
VNE-5-8 VNE Server/Release 3.0



VNE Server User Guide 5—Administration
4 Change the properties for each utilization collector that you use to the desired 
settings. 

5 Save the changes by pressing the Apply button. 

End of Procedure 5-4

Exporting Reports to Files 

The preferred way to export reports is through the Report Export Service. The 
Report Export Service is used for scheduled export of reports. In addition, VNE 
Server provides a script, export_reports.bat, that exports all reports to 
files. You can run this script while VNE services are operating. Use 
Procedure 5-5 to export reports to files.

Procedure 5-5   Export Reports to Files

1 Open a command prompt window, and navigate to the VNE Server installation 
directory by typing 

cd <install path>\VNEServer\3.0 

2 Run the export script. 

• If you use Oracle8i, type

export_reports.bat -o <output directory path> -e <report 
format> 

• If you use Oracle9i, type 

export_reports.bat /Oracle9i -o <output directory path> -e 
<report format> 

Where <output directory path> is the location to which report files are written, and 
<report format> is

• 0 for HTML formatted report files

• 1 for XML formatted report files

• 2 for CSV formatted report files 

• 3 for ASCII formatted report files 

➥ Progress messages appear in the command window. When export is complete, 
a “Completed exporting...” message appears. 

End of Procedure 5-5

VNE Server provides a script, run_report.bat, that exports a selected report 
to file. You can run this script while VNE services are operating using 
Procedure 5-6.
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Procedure 5-6   Export a Selected Report to File

1 Open a command prompt window and navigate to the VNE Server installation 
directory by typing 

cd <install path>\VNEServer\3.0 

2 To get a list of report IDs, type 

run_report.bat -l 

➥ A list of report names and their ID numbers is displayed in the command window. 
Note the ID number of the report you want to export. 

3 Run the export script. 

• If you use Oracle8i, type:

run_report.bat -f <output filename> -r <report id> -e 
<report format> 

• If you use Oracle9i, type: 

run_report.bat /Oracle9i -f <output filename> -r <report id> 
-e <report format> 

Where <output filename> is the file to which the report is written, and <report ID> 
is the ID number of the report you want to export, and <report format> is

• 0 for HTML formatted report files 

• 1 for XML formatted report files

• 2 for CSV formatted report files 

• 3 for ASCII formatted report files 

➥ Progress messages appear in the command window. When export is complete, 
a “Completed exporting...” message appears. 

End of Procedure 5-6

Software Upgrades 

VNE Server releases use a major release, minor release naming convention 
that is reflected in the installation path name. A major release denotes 
significant new features or framework enhancements in the product. A minor 
release contains incremental improvements and bug fixes. 

The product installer appends VNEServer\<major release> to the chosen 
installation path. For example, if C:\OPNET is the chosen installation path for 
the 3.0 release, the complete path is C:\OPNET\VNEServer\3.0. Minor releases 
are called patch levels and are denoted as PL1, PL2, and so on. 
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The general workflow when doing a software upgrade for VNE Server consists 
of the following steps. 

1) Stop data collection, and exit the existing VNE Server installation. 

2) If you have a local license server running, execute the following 
procedures, based upon your platform, to stop the server. 

• Windows: Procedure 5-7 

• Solaris: Procedure 5-9

3) If upgrading to a new build in the same release, rename the existing 
installation directory to preserve the current release. For example, rename 
a 2.1 PL2 release to 2.1.2_<bld#>. 

4) Install the new VNE Server release. 

5) Migrate the Device Info and ASCII data files to the new installation. 

6) Change the project name to something that reflects the network. 

7) Configure the adapters for the newly installed release. 

8) Start data collection in the newly installed release. 

Note—At this time, VNE Server does not migrate database data schema or 
adapter configuration data from one release to another. 

WARNING—Always follow the installation instructions in the Installation Card 
and the Release Notes for a new release. The general workflow described in 
this section may not match the workflow for a specific release. 

Product Licensing 

VNE Server is integrated into the OPNET licensing system and supports the 
following license scenarios: 

• Remote: obtain a license from a license server on a remote host. 

• Local: obtain a license from a license server on the VNE Server host. 

Licenses for VNE Server can be administered from any OPNET License 
Manager running on remote hosts that can communicate with the VNE Server 
host. Licenses can also be administered from a license manager running on the 
same host as VNE Server. 
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The OPNET License Manager application provides the most convenient means 
to monitor and manage VNE Server licenses. The License Manager provides a 
GUI to support license operations. The OPNET Administrator Guide describes 
how to use the License Manager. When a local license server is installed with 
VNE Server, a command line license management application is provided for 
managing licenses. You only need to use this command line license manager if 
you do not have a GUI based License Manager anywhere in your environment 
that can see the local license server. 

Deployment Scenarios 

When you install VNE Server, you must choose whether to obtain licenses from 
a local or remote license server. Some reasons to choose to obtain licenses 
from a remote license server are 

• Leverage an existing license server within your organization 

• Use a GUI-based License Manager application to manage licenses

• The VNE Server host and license server host can communicate

Some reasons to chose to obtain licenses from a local license server are 

• VNE Server host cannot see a remote license server due to firewalls 

• More robust licensing to support 24x7 VNE Server operation

If you choose to work with a remote license server, the GUI-based License 
Manager is more convenient to use than the command line license manager 
deployed with the local license server, installed with VNE Server. Since VNE 
Server is intended for use as a 24x7 application, persisting network problems or 
host downtime with the remote license server can cause VNE Server to shut 
down if problems are not resolved within the license grace period. 

if you choose to work with a local license server, 24x7 operations are more 
robust since license operations are all local. Network problems cannot affect 
license operations. If the VNE Server host is separated from other license 
servers by a firewall, you must use the command line license manager utility for 
all license management. If the VNE Server host can see another host running 
OPNET analysis software, the GUI-based License Manager on those hosts can 
manage licenses maintained by the license server on the VNE Server host. 

Restrictions and Limitations

VNE Server has the following restrictions regarding product licensing. 

• The license server used by VNE Server must be from the OPNET 10.5.A 
release or higher. 

• Standalone licensing is not supported by VNE Server. 

• Loanable licenses are not supported for VNE Server. 
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• Only one local license server can be installed on the VNE Server host. 

• The license manager utility (LS_UTIL) included with VNE Server does not 
support Express Method license operations. 

• A license server installed with VNE Server on a host with no OPNET analysis 
software installed will default to listen on port_a. 

• A license server installed with VNE Server on a host with OPNET analysis 
software installed (configured for remote licensing) will use the port specified 
in the licensing.ef file in the OPNET analysis software installation at 
\sys\configs\global_prefs. 

If a license server already exists on the VNE Server host as a part of a previous 
OPNET analysis software installation, and you wish to use this local license 
server for VNE Server, install VNE Server to use a “remote” license server. 
During VNE Server installation, do the following: 

• Enter the hostname of the local host as the license server host. 

• Enter the port (a,b,c) used by the local license server. 

License Resources 

The following resources provide more information about OPNET licensing.

• The OPNET Administrator Guide (OPNET doc package). 

• The OPNET License Registration web page at:
http://ds1.opnet.com/4dcgi/licw4d_cl_content.

Command Line Utilities 

VNE Server provides the following command line utilities for license related 
work. 

• LS—Starts a local license server

• LS_KILL—Stops a local license server

• LS_UTIL—A command line license manager utility 

When using these command line utilities, the /lic_host and /lic_port options 
MUST be used in the vnes.bat command line on a Windows system. For Solaris 
systems, the required options are -l (host) and -p (port).

The full command line for each utility on a Windows system is shown. 

• vnes.bat /Oracle9i /lic_host <license server host> 
/lic_port <port> LS 
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• vnes.bat /Oracle9i /lic_host <license server host> 
/lic_port <port> LS_KILL 

• vnes.bat /Oracle9i /lic_host <license server host> 
/lic_port <port> LS_UTIL 

Where <license server host> is replaced with the hostname of the system 
running the license server used to obtain a license. 

Where <port> is the communication port used by the license server. Valid 
entries are port_a, port_b or port_c. 

Note—If you are using an Oracle8i database, the /Oracle9i switch is omitted 
from the commands listed above. 

The full command line for each utility on a Solaris system is shown. 

• vnes.sh -r Oracle9i -l <license server host> -p <port> LS 

• vnes.sh -r Oracle9i -l <license server host> -p <port> 
LS_KILL 

• vnes.sh -r Oracle9i -l <license server host> -p <port> 
LS_UTIL 

License Procedures

The following procedures describe common licensing operations. 

Procedure 5-7   Starting and Stopping a Local License Server using Windows 
Service Manager 

1 Open the Windows Service manager.

• Open Start > Settings > Control Panel > Administrative Tools > Services 

2 In the Services window, scroll down and select the OPNET License Server. 

3 Start or stop the server as needed. 

3.1 To start the server, right-click on OPNET License Server, and select Start 
from the menu. 

➥ The OPNET License Server status changes to “Started”. 
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3.2 To stop the server, right-click on OPNET License Server, and select Stop from 
the menu. 

➥ The OPNET License Server stops. The service status field is cleared. 

End of Procedure 5-7

Procedure 5-8   Starting a Local License Server using Command Line Utilities 

1 Open a command window and “cd” to the VNE Server installation directory. 

2 Type: hostname 

➥ Note the hostname displayed by this command. It is used (exact case match) 
with the /lic_host (or -l) option in the following command. 

3 Start the license server. 

• On a Windows system using Oracle9i, type: 

vnes.bat /Oracle9i /lic_host <local hostname> /lic_port <server port> LS

• On a Windows system using Oracle8i, type:

vnes.bat /lic_host <local hostname> /lic_port <server port> LS

• On a Solaris system, type: 

vnes.sh -r Oracle9i -l <local hostname> -p <server port> LS

For the /lic_port (-p on Solaris) option, specify the port used by this server. It will 
be one of port_a, port_b, port_c. 

End of Procedure 5-8

Procedure 5-9   Stopping a Local License Server using Command Line Utilities 

1 Open a command window and “cd” to the VNE Server installation directory. 

2 Type: hostname 

➥ Note the hostname displayed by this command. It is used (exact case match) 
with the /lic_host option in the following command. 

3 Stop the license server. 

• On a Windows system using Oracle9i, type 

vnes.bat /Oracle9i /lic_host <local hostname> /lic_port <server port> LS_KILL

• On a Windows system using Oracle8i, type 

vnes.bat /lic_host <local hostname> /lic_port <server port> LS_KILL

• On a Solaris system, type 
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vnes.sh -r Oracle9i -l <local hostname> -p <server port> LS_KILL 

For the /lic_port (-p on Solaris) option, specify the port used by this server. It will be 
one of port_a, port_b, port_c. 

➥ A “Success: license server stopped” message appears on the command line. 

End of Procedure 5-9

Procedure 5-10   Changing the Settings used to Communicate with a Remote 
License Server 

Note—Use this procedure to change the host or port settings for the remote license 
server used by VNE Server to obtain a license. 

1 If VNE Server is operating, stop services and exit the Console. 

2 Open a command window and “cd” to the VNE Server installation directory. 

3 Enter the license manager utility. 

• On a Windows system using Oracle9i, type 

vnes.bat /Oracle9i /lic_host <hostname> /lic_port <server port> LS_UTIL 

• On a Windows system using Oracle8i, type

vnes.bat /lic_host <hostname> /lic_port <server port> LS_UTIL

• On a Solaris system, type 

vnes.sh -r Oracle9i -l <local hostname> -p <server port> LS_UTIL 

For the host option, specify the hostname for the license server to be used. 

For the port option, specify the port used by the remote license server. 

4 To leave LS_UTIL, type: exit 

Note—Entering and exiting LS_UTIL with the correct host and port settings 
changes the settings to their new values. 

End of Procedure 5-10

Procedure 5-11   Changing the Settings used by a Local License Server

Note—Use this procedure to change the host or port settings for the local license 
server used by VNE Server to obtain a license. 

Note—You MUST use this procedure to sync-up the local license server port 
setting if the local host already has an OPNET installation that points to a license 
server (local or remote) using port_b or port_c. 

1 If VNE Server is operating, stop services and exit the Console. 
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2 Execute procedure Procedure 5-9 to stop the local license server. 

3 Enter the license manager utility.

• On a Windows system using Oracle9i, type

vnes.bat /Oracle9i /lic_host <local hostname> /lic_port <server port> LS_UTIL

• On a Windows system using Oracle8i, type 

vnes.bat /lic_host <local hostname> /lic_port <server port> LS_UTIL

• On a Solaris system, type 

vnes.sh -r Oracle9i -l <local hostname> -p <server port> LS_UTIL 

For the host option, specify the hostname (exact case) of the local host.

For the port option, specify the port to be used by this server. If you are doing this 
procedure to sync-up the port to the one used for an existing OPNET analysis 
software installation, choose port_b or port_c to match the setting for the OPNET 
analysis software installation. 

4 To leave LS_UTIL, type: exit 

Note—Entering and exiting LS_UTIL with the correct host and port settings 
changes the settings to their new values. 

5 Execute procedure Procedure 5-8 to restart the local license server. 

End of Procedure 5-11

Procedure 5-12   Add a License Using the Browser Method 

Note—If you have access to an OPNET analysis software installation on a host 
that can access the license server host used for the VNE Server license, use the 
OPNET License Manager for all license operations. Follow standard OPNET 
licensing practice as described on the web site. You only need to use this 
procedure when administering a license on a VNE Server host that is isolated (by 
firewalls, etc.) from OPNET analysis software. 

1 Open a command window and “cd” to the VNE Server installation directory. 

2 Type: hostname 

➥ Note the hostname displayed by this command. It is used (exact case match) 
with the /lic_host (-l on Solaris) option in the following command. 

3 Enter the license manager utility. 

• On a Windows system using Oracle9i, type 

vnes.bat /Oracle9i /lic_host <local hostname> /lic_port <server port> LS_UTIL 

• On a Windows system using Oracle8i, type

vnes.bat /lic_host <local hostname> /lic_port <server port> LS_UTIL
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• On a Solaris system, type 

vnes.sh -r Oracle9i -l <local hostname> -p <server port> LS_UTIL 

For the /lic_port option, specify the port used by this server. It will be one of port_a, 
port_b, port_c. 

➥ A “Floating License Manager” banner appears followed by a “manager>” 
prompt. 

4 Type: add

➥ A license transaction code is displayed, followed by an “Approval code>” 
prompt. DO NOT press Enter until an approval code has been entered. 

5 Open the OPNET License Registration web page in a browser. 

• On a Windows host, use Start > Programs > OPNET VNE Server 2.1 > Open 
Licensing Web Page to open the licensing web page in a browser. 

• On a Solaris host, use a browser to go to the following URL:

http://ds1.opnet.com/4dcgi/licw4d_cl_content

6 On the License Registration web page, select “Perform license operations”. 

7 Enter your group ID into the Group ID text field. 

8 Select the “Add License” radio button. Press Next. 

➥ An “Enter Transaction Code” page appears. 

9 Cut and paste the transaction code from the command window to the transaction 
code textfield on the web page. 

10 Enter the hostname (case must match) into the hostname textfield. Press Next. 

➥ A license selection web page appears. 

11 Select a single license or a range of licenses as needed and permitted for your 
group account. Press Select. 

➥ A confirmation page appears with your selected license information. 

12 Press “Get Approval Code”. 

➥ A page appears that displays the license approval code. 

13 Cut and paste the approval code from the web page into the command window at 
the waiting “Approval code>” prompt. Check to make sure you have entered the 
code correctly. Press Enter. 

➥ The command window displays a message that “The license operation 
succeeded.” 

Note—If the operation fails, try again to enter the approval code. You get several 
tries. If you cannot add the license, exit the browser and LS_UTIL and try this 
procedure again. 
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14 Confirm that the license is installed. In the command window, type: permit. 

➥ You should see the license, that you just added, in the license list. 

15 To exit LS_UTIL, type: exit. Exit the browser. 

End of Procedure 5-12

Procedure 5-13   Deregister a License or Change Expiration Dates using the 
Browser Method

Note—If you have access to an OPNET analysis software installation on a host 
that can access the license server host used for the VNE Server license, use the 
OPNET License Manager for all license operations. Follow standard OPNET 
licensing practice as described on the web site. You only need to use this 
procedure when administering a license on a VNE Server host that is isolated (by 
firewalls etc) from OPNET analysis software. 

Note—Follow the steps in procedure Procedure 5-12 to enter the command line 
LS_UTIL utility and use the Browser Method to perform the license operation. For 
each operation, use the following LS_UTIL commands: 

• Deregister license: delete 

• Change license expiration: ch_exp 

• Change maintenance expiration: ch_mtn 

In the browser, select the proper radio button for the desired license operation 
(deregistration, expiration changes). 

End of Procedure 5-13

Configuring OPNET analysis software to Import from VNE Server 

Before OPNET analysis software can import network models from VNE Server, 
you must configure some preferences. The steps required depend upon 
whether OPNET analysis software is installed on the same system as VNE 
Server or elsewhere in the network. Normally OPNET analysis software is 
installed on another system. If OPNET analysis software and VNE Server are 
on the same system, use Procedure 5-14. If OPNET analysis software and VNE 
Server are not on the same system, use Procedure 5-15. 

OPNET analysis software Configuration When VNE Server Resides on the Same System 

Procedure 5-14   Configuring OPNET analysis software for Import from VNE 
Server when Both are on the Same System

1 Start OPNET analysis software. After the control panel appears, select Edit > 
Preferences to open the Preferences window. 
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2 Search for the string vne to find the preferences for VNE Server. 

3 Edit the vne_import_ior_file preference to point to the VNE Server vneserver.ior 
file. The ior file provides connectivity information that OPNET analysis software 
needs to import network data from VNE Server. The ior file is in the VNE Server 
temp directory which, by default, is C:\op_admin\tmp\vne. For this example, set 
vne_import_ior_file to C:\op_admin\tmp\vne\vneserver.ior. Press OK to save the 
changes. 

End of Procedure 5-14

After completing these steps, OPNET analysis software is ready to import a 
network model from a local VNE Server. 

OPNET analysis software Configuration when VNE Server Resides on Another System 

Procedure 5-15   Configuring OPNET analysis software for Import from VNE 
Server on a Different System

1 On the host system for OPNET analysis software, create a directory to store VNE 
Server import information. A recommended choice is C:\op_admin\tmp\vne. 

2 Copy the vneserver.ior file from the VNE Server temp directory on the system 
hosting VNE Server into the directory just created. This file contains the information 
that OPNET analysis software needs to communicate with a remote VNE Server. 
This file is generated by VNE Server at start-up of data collection, and is 
host-specific. 

Note—If data collection is stopped and restarted on VNE Server, the ior file 
becomes invalid. After data collection is restarted, a new copy of vneserver.ior 
must be placed in the import directory. 

Note—If possible, a better way to access the vneserver.ior file is by network drive 
mapping. If the host running OPNET analysis software can map a network drive 
from the VNE Server host, make the VNE Server temp directory shareable. On the 
host running OPNET analysis software, setup a network drive mapping to the VNE 
Server temp directory. Set the vne_import_ior_file preference to point directly 
across the network to the vneserver.ior file in the VNE Server temp directory. 

3 Start OPNET analysis software. After the control panel appears, select Edit > 
Preferences to open the Preferences window. 

4 Search for the string vne to find the preferences related to VNE Server. 

5 Edit the vne_import_ior_file preference to point to the vneserver.ior file in the VNE 
Server import directory created in step 1. Press OK to save the changes.

End of Procedure 5-15

After completing these steps, OPNET analysis software is ready to import a 
network model from a remote VNE Server installation. 
VNE-5-20 VNE Server/Release 3.0



VNE Server User Guide 5—Administration
Oracle Administration 

This section describes the Oracle environment, as it relates to VNE Server, and 
contains some simple procedures for managing and monitoring this 
environment. VNE Server can work with both Oracle8i and Oracle9i databases. 
An Oracle database server can support multiple databases, each with multiple 
users and tablespaces that store data. The user account and tablespace for the 
VNE Server network database is located within a single database instance. 

Important Files 

The Oracle installation directory has the following main sub-directories. 

• admin—Has a subdirectory per database to hold admin files 

• ora81, ora92—Holds the Oracle code, libraries and much more 

• oradata—Has a subdirectory per database to hold data files

The admin directory contains initialization, log and trace files for each database 
within the Oracle server. The ora81 directory (ora92 for Oracle9i) contains the 
application code and libs for all the Oracle components. Control files for the TNS 
Listener service, which VNE Server uses for database connectivity, are located 
under the ora81 (ora92 for Oracle9i) directory tree. The oradata directory 
contains the control and storage files for each database. 

Some important files within the Oracle environment are listed below. 

The initialization control file for Oracle is

• <Oracle install dir>\admin\<db name>\pfile\init.ora 

The database files for VNE Server are 

• <Oracle install dir>\oradata\<db name>\FS1DAT1.ORA 

• <Oracle install dir>\oradata\<db name>\FS1IDX1.ORA 

• <Oracle install dir>\oradata\<db name>\FS1TMP1.ORA 

• <Oracle install dir>\oradata\<db name>\VNELARGE.ORA 

• <Oracle install dir>\oradata\<db name>\VNELGIDX.ORA 

Some important Oracle Net Services files are 

• <Oracle install dir>\<ora81 or ora92>\network\Admin\tnsnames.ora 

• <Oracle install dir>\<ora81 or ora92>\network\log\listener.log 
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The Oracle installation logs are located here: 

• C:\Program Files\Oracle\Inventory\logs\installActions.log 

Oracle Net Services 

VNE Server uses a database’s Oracle Net service name for connection to the 
database. This is true whether VNE Server uses a local or remote database. 
The database service name is located in the tnsnames.ora file. This file is 
located in the <oracle install dir>\<ora81 or ora92>\network\Admin directory. A 
sample file is shown below. 

In this sample file, there are three entries. The O92AML14.OPNET.COM entry 
(highlighted) represents the database service name. Each entry has a <net 
service name> = () structure. The text string preceding the “=” is the service 
name. In this example, you use O92AML14.OPNET.COM as the service name 
for VNE Server installation. 

Note that this file has entries for other Oracle Net services and may contain 
entries for more than one database. If the Oracle installation you are using 
supports other products, contact the database administrator for the service 
name you should use. 
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Figure 5-1   Sample tnsnames.ora File

# TNSNAMES.ORA Network Configuration File:
# Generated by Oracle configuration tools.

O92AML14.OPNET.COM =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = mlpc14)(PORT = 1521))
    )
    (CONNECT_DATA =
      (SERVICE_NAME = o92aml14)
    )
  )

EXTPROC_CONNECTION_DATA.OPNET.COM =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = IPC)(KEY = EXTPROC0))
    )
    (CONNECT_DATA =
      (SID = PLSExtProc)
      (PRESENTATION = RO)
    )
  )

INST1_HTTP.OPNET.COM =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = mlpc14)(PORT = 1521))
    )
    (CONNECT_DATA =
      (SERVER = SHARED)
      (SERVICE_NAME = o92aml14)
      (PRESENTATION = http://admin)
    )
  )
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Account Management 

The procedures in this section describe how to setup, verify, and remove the 
VNE Server tablespace and user account from the Oracle database. 

Setting Up VNE Server Database Accounts within Oracle 

This procedure is normally performed following VNE Server installation when 
VNE Server is initially setup to access the Oracle database. If you have 
removed the VNE Server database tablespace and account from Oracle to 
recover from a problem, use this procedure to recreate the tablespace and a 
user account. 

Note—The setup_accounts.sql script used in this procedure removes the 
existing tablespace and account before creating a fresh tablespace and 
account. All network model data is lost.

Procedure 5-16   Configure the Oracle Database for Use by VNE Server 

1 Open a command prompt window and navigate to the VNE Server installation 
directory by typing 

cd <install path>\VNEServer\3.0 

2 Type sqlplus system/<system password> in the command prompt window. 

3 At the sqlplus prompt, type: @setup_accounts.sql

➥ A list of DBIDs and database instance names are displayed. If you only have a 
database dedicated to VNE Server, one entry will appear. If more than one 
database is available, contact your database administrator to find out which 
database name is used with VNE Server. 

Note—Note the correct database instance name for use in the next step. 

4 The script prompts you for a database name. 

Enter the database instance name obtained in step 3 (use lowercase letters). 

5 The script prompts for the database User password. 

Enter the same Oracle database password that was specified during VNE Server 
installation. 

Note—When running this script after drop_accounts.sql has been run, SQL 
error messages will be displayed and can be ignored. These messages result from 
the script removing VNE Server table and user accounts that have already been 
removed by the drop_accounts.sql script. 

This SQL script configures database storage for VNE Server use and sets up the 
Oracle user account for VNE Server. After this script finishes, the Oracle account 
for VNE Server uses the user name and password entered during VNE Server 
installation. 
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6 Type quit to exit sqlplus. 

End of Procedure 5-16

Verifying the Oracle Configuration 

This procedure verifies that the VNE Server database account is setup 
correctly. 

Procedure 5-17   To verify that the Oracle database is correctly configured for use 
by VNE Server, do the following: 

1 Type sqlplus <user name>/<password> in the command prompt window. 
Enter the user name and password you entered during VNE Server installation. 

If Oracle configuration was successful, an Oracle banner, and a Connected To: 
message appears. Type quit at the SQL> prompt to exit. 

If Oracle configuration failed, error messages appear stating that login has been 
denied. Should this happen, execute Setting Up VNE Server Database Accounts 
within Oracle on page VNE-5-24 again, and re-execute this procedure to check the 
outcome. If configuration problems persist, contact OPNET Technical Support. 

2 Type quit to exit sqlplus. 

End of Procedure 5-17

Removing VNE Server Database Accounts within Oracle 

This procedure removes the VNE Server tablespace and user account from the 
Oracle database used by VNE Server. Run this procedure if you want to remove 
VNE Server content from an Oracle database you no long plan to use for VNE 
Server. 

WARNING—This procedure removes VNE Server’s database. All network 
model data will be lost.

Procedure 5-18   Remove the VNE Server Tablespace and User Account from the 
Oracle Database 

1 Open a command prompt window and navigate to the VNE Server installation 
directory by typing 

cd <install path>\VNEServer\3.0 

2 Within this window, type sqlplus system/<system password> to enter sqlplus. 
VNE Server/Release 3.0 VNE-5-25



5—Administration VNE Server User Guide 
3 Type @drop_accounts.sql <database name>. 

➥ Progress messages appear in the command prompt window as the VNE Server 
user account and tablespace is removed from Oracle. 

4 Type quit to exit sqlplus. 

End of Procedure 5-18

Monitoring the Database 

The Oracle DBA Studio application is used to monitor the database for Oracle8i. 
For Oracle9i, use the Enterprise Manager Console. With these tools, you can 
monitor the following items: 

• Tablespace utilization within the database 

• Active user sessions within the database

Use the following procedures to enter DBA Studio or the Enterprise Manager 
Console and perform some routine tasks to monitor the database. 

• Entering DBA Studio or Enterprise Manager Console and connecting to the 
database. 

• Getting database instance information. 

• Checking database tablespace size. 

• Extending the database tablespace size. 

• Checking the active database sessions. 

These procedures are described in detail throughout the remainder of this 
section. 

Note—For Oracle9i users, enter the Enterprise Manager Console to perform 
the DBA Studio procedures listed below. Once inside the Console, the steps are 
the same as for DBA Studio. 

Procedure 5-19   Enter DBA Studio and Connect to Oracle8i Database

1 Start Oracle DBA Studio by selecting Start > Programs > Oracle > Database 
Administration > DBA Studio. 

➥ The Oracle Enterprise Manager Login panel opens. 

2 Select the Launch DBA Studio Standalone radio button and press OK. 

➥ DBA Studio opens. 
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3 Expand the property tree for the database used with VNE Server. 

➥ A Database Connect Information dialog box opens. 

4 Enter the user name and password that you use for the VNE Server account and 
press OK. 

➥ The database property tree expands. 

End of Procedure 5-19

Procedure 5-20   Enter Enterprise Manager Console and Connect to Oracle9i 
Database

1 Start Enterprise Manager Console by selecting Start > Programs > Oracle > 
Enterprise Manager Console. 

➥ The Oracle Enterprise Manager Login panel opens. 

2 Select the Launch Standalone radio button and press OK. 

➥ Enterprise Manager Console opens. 

3 Expand the property tree for the database used with VNE Server. 

➥ A Database Connect Information dialog box opens. 

4 Enter the user name and password that you use for the VNE Server account. 

5 Select SYSDBA from the Connect As menu and press OK. 

➥ The database property tree expands. 

End of Procedure 5-20

At this point, you can navigate anywhere in the property tree for this database. 

Procedure 5-21   Obtain Oracle8i Database Instance Information

1 Follow Procedure 5-19 to enter Oracle DBA Studio and connect to your database. 

➥ DBA Studio is open with an expanded database property tree. 

2 Expand the Instance property tree. 
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3 Click on the Database property. 

➥ The property details panel, on the right, shows information about the database. 
An example is shown below.

End of Procedure 5-21

Procedure 5-22   Obtain Oracle9i Database Instance Information

1 Follow Procedure 5-20 to enter Oracle Enterprise Manager Console and connect 
to your database. 

➥ The Enterprise Manager Console is open with an expanded database property 
tree. 

2 Expand the Instance property tree. 
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3 Click on the Configuration property. 

➥ The property details panel, on the right, shows information about the database. 
An example is shown below.

End of Procedure 5-22

Procedure 5-23   Check the Oracle8i Database Tablespace Size 

1 Follow Procedure 5-19 to enter Oracle DBA Studio and connect to your database. 

➥ DBA Studio is open with an expanded database property tree. 

2 Expand the Storage property tree. 
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3 Select the Tablespaces property tree. 

➥ The property details panel, on the right, shows each database file, the file size, 
and percentage of the file’s maximum allotted size. An example is shown below. 

Note—The FS1DAT1, FS1IDX1, FS1TMP1, VNELARGE, and VNELGIDX files 
contain the tablespace for the VNE Server network database. 

End of Procedure 5-23

Procedure 5-24   Check the Oracle9i Database Tablespace Size 

1 Follow Procedure 5-20 to enter Oracle Enterprise Manager Console and connect 
to your database. 

➥ Enterprise Manager Console is open with an expanded database property tree. 

2 Expand the Storage property tree. 
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3 Select the Tablespaces property tree. 

➥ The property details panel, on the right, shows each database file, the file size, 
and percentage of the file’s maximum allotted size. An example is shown below. 

Note—The FS1DAT1, FS1IDX1, FS1TMP1, VNELARGE, and VNELGIDX files 
contain the tablespace for the VNE Server network database. 

End of Procedure 5-24

Procedure 5-25   Extend the Size of an Oracle8i Database Storage File 

Note—When you log into the database during the first step of this procedure, use 
the sys or system accounts. The VNE Server user account does not have sufficient 
privileges to extend database storage. 

1 Follow Procedure 5-19 to enter Oracle DBA Studio and connect to your database. 

➥ DBA Studio is open with an expanded database property tree. 

2 Expand the Storage property tree. 

3 Select the Tablespaces property tree. 

➥ The property details panel, on the right, shows each database file, the file size, 
and percentage of the file’s maximum allotted size.
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4 Double-click on the entry for the tablespace file that you are expanding. 

➥ An Edit Tablespace window opens for this database tablespace file. An example 
is shown below. 

5 Change the value in the size field to the new tablespace size. Press Apply. 

➥ The tablespace file size, shown in the DBA Studio property details panel, takes 
on the new value. 

Note—When the VNE Server tablespace files are created using the 
setup_accounts.sql script, a maximum file size is set. During VNE Server 
operation, the tablespace files are automatically extended up to the maximum size. 
Once the maximum auto-extend size is reached, you must manually extend the 
files. 

6 Press OK to exit the Edit Tablespace window. 

End of Procedure 5-25

Procedure 5-26   Extend the Size of an Oracle9i Database Storage File

Note—When you log into the database during the first step of this procedure, use 
the system account. The VNE Server user account does not have sufficient 
privileges to extend database storage. 

1 Follow Procedure 5-20 to enter Oracle Enterprise Manager Console and connect 
to your database. 

➥ Enterprise Manager Console is open with an expanded database property tree. 
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2 Expand the Storage property tree. 

3 Select the Tablespaces property tree. 

➥ The property details panel, on the right, shows each database file, the file size, 
and percentage of the file’s maximum allotted size.

4 Double-click on the entry for the tablespace file that you are expanding. 

➥ An Edit Tablespace window opens for this database tablespace file. An example 
is shown below.

5 Change the value in the size field to the new tablespace size. Press Apply. 

➥ The tablespace file size, shown in the Enterprise Manager Console property 
details panel, takes on the new value. 

Note—When the VNE Server tablespace files are created using the 
setup_accounts.sql script, a maximum file size is set. During VNE Server 
operation, the tablespace files are automatically extended up to the maximum size. 
Once the maximum auto-extend size is reached, you must manually extend the 
files. 

6 Press OK to exit the Edit Tablespace window. 

End of Procedure 5-26
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Procedure 5-27   Check the Active Sessions Against the Database 

1 Follow Procedure 5-19 to enter Oracle DBA Studio (Oracle8i) or Procedure 5-20 to 
enter Enterprise Manager Console (Oracle9i) and connect to your database. 

➥ DBA Studio or Enterprise Manager Console opens with an expanded database 
property tree. 

2 Expand the Instance property tree. 

3 Select the Sessions property tree. 

➥ The property details panel, on the right, displays details about each database 
session. 

End of Procedure 5-27

Backup and Recovery 

Most database applications require periodic backup of the database. Due to the 
nature of the VNE Server product, database backup is not essential. Using a 
restored database with VNE Server presents two problems. 

• If the database was backed up under an older version of VNE Server, data 
schema changes may have occurred in the current release such that the 
recovered database is no longer usable. 

• The other problem relates to the age of the backup. If the network 
configuration has changed significantly since the backup was created, VNE 
Server will take as much time to update the database to the current state of 
the network as it would take to populate a fresh database. For most 
networks, VNE Server can completely populate a network database in a 
matter of hours. 

If you decide to keep backups of your network database, follow Oracle’s 
procedures for performing backup and recovery operations. VNE Server 
provides scripts that can be used to backup and restore the user environment 
and tablespaces that constitute the VNE database. Refer to the following 
procedures. 

Note—The following procedures can be used to backup and restore a local 
VNE database but not a remote one. 

Procedure 5-28   Backup the VNE database using the vnes_db_export.bat Script 

1 Stop VNE services and exit VNE Server. 
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2 Open a command prompt window and navigate to the VNE Server installation 
directory by typing: 

cd <install path>\VNEServer\3.0 

3 Type: vnes_db_export.bat <DB username>/<DB password> 

Where DB username and DB password are used by VNE Server to access the 
database. 

➥ Numerous progress messages appear that contain backup details. 

➥ When complete, the following files are created:

• vnes_db.dmp - backup file of the VNE database 

• vnes_db_export.log - log file of the export session 

End of Procedure 5-28

Procedure 5-29   Restore the VNE database using the vnes_db_import.bat Script 

WARNING—The database information saved in vnes_db.dmp should only be restored 
for the same VNE Server release that was used to create the backup database. 

1 If VNE Server is operating, stop services and exit. 

2 Open a command prompt window and navigate to the VNE Server installation 
directory by typing: 

cd <install path>\VNEServer\3.0 

3 Run the setup_accounts.sql script per Procedure 5-16, to recreate the VNE 
database. 

WARNING—This step will remove all data that is currently in the VNE database. 

4 Copy the vnes_db.dmp file that contains the backed up database to the VNE 
Server installation directory. If you have renamed the file to something more 
descriptive (i.e. something with a timestamp), rename it to vnes_db.dmp. 

5 Type 

vnes_db_import.bat <source DB username> <dest DB username> 
<dest DB password> 

Where the source DB username is for the database account from which the backup 
file originated; and dest DB username and dest DB password are for the account 
to which the database is restored. 

➥ Numerous progress messages appear that contain restore details. 

➥ An “Import terminated successfully...” message appears when done. 

End of Procedure 5-29
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Network Management System Administration 

Some of the VNE Server adapters connect to third-party network management 
systems to retrieve data. This section describes configuration work required on 
these network management systems to provide VNE Server access to the 
system’s network data. 

Configuring HP OpenView 

When VNE Server and HP OpenView are located on separate hosts, HP 
OpenView must be configured to grant VNE Server access. 

Procedure 5-30   Configure HP OpenView to Grant Access to VNE Server 

1 If you are using UNIX, go to the /etc/opt/OV/share/conf directory on the HP 
OpenView host. If you are using Windows, go to the <drive>:\OpenView\conf\ 
directory on the host. 

➥ Within this directory, there will be three authorization files: ovw.auth, 
ovwdb.auth, and ovspmd.auth. These authorization files determine which users 
and what machines will be able to log into the HP OpenView host. 

2 Open each authorization file in a text editor. Each authorization file is divided into 
two sections: a header section that explains how to use and configure the file, and 
a section where the remote client machines and users are specified. 

3 In the section where the client machines and users are specified, add any client 
machine name or user name using the following formats: 

• For a particular client machine with a particular user logged on: 

<machine name> <space> <user name> 

• For any user on a particular client machine: 

<machine name> <space> + 

• For any client machine with a particular user: 

+ <space> <user name> 

• For any user on any client machine: 

+ <space> + 

For example, if your user name is Administrator and the client machine name is 
vnesPC, add the following line: 

vnesPC Administrator 

to each authorization file. 

Note—Minus signs (-) can be used in place of plus signs (+) to deny a particular 
client machine or user access to the HP OpenView host machine. 
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4 Save the changes made to each authorization file, and then close the file. 

Note—If you edited the .auth files while HP OpenView NNM was running, you 
MUST restart NNM for the changes to take place. 

End of Procedure 5-30

Configuring CiscoWorks 

For VNE Server to retrieve configuration files from CiscoWorks, the CiscoWorks 
host machine must be running a remote shell (rsh/rcp) service. Both Windows 
and UNIX host machines require configuration in order to accept rcp requests 
from VNE Server. 

CiscoWorks on a Windows Host 

When CiscoWorks is located on a Windows host, the CMF rsh/rcp service must 
be running. Find the Services tool in the Windows Control Panel, and open the 
Services window to display services. If CMF rsh/rcp service is present but 
stopped, start it. If the service is not present, install it by running <CiscoWorks 
install dir>\RemoteNetsysNT\rcmf.exe. After installation is complete, start the 
service from the Control Panel Services window. 

Procedure 5-31   Permit VNE Server Access when CMF rsh/rcp service is Installed 
on CiscoWorks Host

1 Open a command window. Use cd to set the working directory to the bin directory 
that holds crmrsh.exe. This directory should be at: C:\Program Files\CSCOpx\bin. 

2 Type crmrsh addrhost <hostname> <user name> 

where <hostname> is the IP address or hostname of the VNE Server host, and 
<user name> is the account in which VNE Server runs. 

Note—When entering the hostname, use a lowercase, Fully Qualified Domain 
Name for the VNE Server host. 

3 Type net stop crmrsh 

4 Type net start crmrsh 

5 Test the access changes by doing the following: 

5.1 On the VNE Server host, open a command window. 

5.2 Type rsh <hostname> -l <user name> dir 
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where <hostname> is the IP address or hostname of the CiscoWorks host, and 
<user name> is the name of the account in which VNE Server runs on its host. 

➥ If the test is successful, you will see the contents of a directory on the 
CiscoWorks host displayed in the command window. 

End of Procedure 5-31

After completing these changes, VNE Server can access CiscoWorks on a 
Windows host machine via rcp to retrieve data. 

CiscoWorks on a UNIX Host 

Procedure 5-32   Permit VNE Server Access when CiscoWorks is on UNIX

1 Add the name of the VNE Server host to the /etc/hosts.equiv file on the CiscoWorks 
host. 

2 Add an account to the CiscoWorks host that has the same name as the user 
account from which VNE Server is run on the VNE Server host. 

3 Add the name of the VNE Server host machine and user account to the .rhosts file 
in the user account just created on the CiscoWorks host. The .rhosts file is located 
in the login directory of the user account and has the following format: 

hostname <space> username 

For example, if the user name of the account from which VNE Server is run is 
Administrator, and the VNE Server host name is vnesPC, add the following line: 

vnesPC Administrator 

to the .rhosts file. 

End of Procedure 5-32

After completing these changes, VNE Server can access CiscoWorks on a 
UNIX host machine via rcp to retrieve data. 

Collecting CiscoWorks Server Information 

The VNE Server adapters that connect to CiscoWorks databases require 
connection information about the database. The following procedure describes 
how to collect this information from CiscoWorks. 

If you have access to the CiscoWorks server, the easiest way to get database 
information is to look in the following files. 

• For the RME DB: <CiscoWorks install dir>\databases\rme\orig\odbc.tmp1 

• For the ANI DB: <CiscoWorks install dir>\databases\ani\orig\odbc.tmp1
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If you cannot find these files, use the following procedure to get this information 
through the CiscoWorks web interface. 

Procedure 5-33   Collecting CiscoWorks Server Information 

1 Open a web browser and go to the URL for CiscoWorks. An example is: 
http://CWpc.acme.com:1741 (include the database port number in the URL).

2 Login as an administrative user, press return.

3 Press the Server Configuration button in the lower left browser panel. 

➥ A list of Server Configuration properties is displayed. 

4 Press Diagnostics > Collect Server Info.

➥ The right browser panel displays a Collect Server Information window. 

5 Press the Create button in the Collect Server Information window, 

➥ Within a few minutes a report link appears in the Collect Server Information 
window. 

6 Press the report link and select the ODBC Configuration link. 

➥ A web page is opened that contains CiscoWorks ODBC connection information.

7 Write down the UID, DatabaseName, Commlinks ServerPort, and PWD 
(password) values for use in configuring the CiscoWorks adapters. 

End of Procedure 5-33

Collecting a CiscoWorks Inventory File

A device inventory file from CiscoWorks can be used to create the VNE Server 
device info file. The following procedure describes how to get this file from 
CiscoWorks. 

Procedure 5-34   Collecting a CiscoWorks Inventory File 

1 Open a web browser and go to the URL for CiscoWorks. An example is: 
http://CWpc.acme.com:1741 (include the database port number in the URL).

2 Login as an administrative user, press return.

3 Press the Resource Manager Essentials button in the lower left browser panel. 

➥ A list of Resource Manager Essentials properties is displayed. 

4 Press Administration > Inventory > Export to File. 

➥ An Export to File window appears in the right browser panel. 
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5 Enter a file name to use for the inventory file in the Output File window. Do not 
include a path in the name. 

6 Choose an Output File Format and Output File Version. Any choice will work. 

7 Press the Next button. 

➥ A Data Export Results window appears that shows the location of the inventory 
file that has just been created. 

8 Press the OK button. 

9 Copy the file to a directory that VNE Server can read. 

End of Procedure 5-34

Configuring Concord eHealth 

VNE Server supports three ways to access Concord eHealth utilization data: 

• live—VNE Server directly accesses data from Concord 

• local files—Concord places data files on VNE Server host 

• remote files—Concord places data files on a remote host 

To support live access, Concord data groups must be setup for VNE Server to 
reference during data retrieval. Use the Concord eHealth/Network facility 
Reports > Edit Groups to define these groups for your Concord installation. 

To support file access (either local or remote), Concord must be configured to 
save configuration and utilization data to a location accessible to VNE Server. 
Schedule the data export to occur with the same frequency as you run the 
Concord eHealth Network Utilization Import adapter. 

Refer to Concord eHealth documentation for more information about traffic 
group setup, data file creation, and scheduling the export of utilization data. 

Configuring MRTG 

VNE Server can retrieve and use MRTG utilization data when it is stored as 
either “flat” log files or as RRD files. Each MRTG server must be configured to 
store the utilization files in one directory. VNE Server can be configured to 
collect utilization data from multiple MRTG servers. 

Note—All the log or RRD files that a server maintains must be placed in a single 
directory, or VNE Server will not be able to retrieve the full file set. 
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Configuring InfoVista 

The InfoVista username that VNE Server uses to access the InfoVista server 
must have write privileges on the InfoVista server. Refer to the InfoVista product 
documentation for more information about server configuration. 
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App A Troubleshooting 

Introduction 

This chapter describes troubleshooting steps you can take to investigate and 
solve problems that can occur during VNE Server operation. With any problem 
you encounter, verify that the product setup is correct. If the problem involves a 
data collection failure, verify access to the problem device, as well. If the 
suggested troubleshooting steps do not solve the problem, collect all the 
requested information before you contact OPNET Technical Support. 

If you cannot solve the problem using the documentation, gather the following 
information before you contact OPNET Technical Support. 

1) Fill out a Technical Support Request, and document the problem scenario. 
Refer to Filing an OPNET Technical Support Case on page VNE-A-21 for 
more instructions. 

2) If the VNE Server Event Viewer shows events relevant to the problem, use 
File > Save to save these events to a log file. 

3) Send any event log files you create, the adapterStats file, and the 
vne_rmid_log file to Technical Support. 

Note—The adapterStats file is located in <temp dir>\adapterStats. The 
vne_rmid_log file is located in the <install dir>\log directory. 

Common Operations 

This section describes how to find information commonly required during 
troubleshooting. 

Locating VNE Server Release Information 

You must always provide VNE Server product release information when 
contacting OPNET Technical Support. To locate VNE Server release 
information, select Help > About VNE Server on the Console menu bar to 
display a release information panel. 

The major release (i.e., 2.1.A), patch level (i.e., PL1), and build number (i.e., 
475) appear near the bottom of the About panel. An example of the version 
information is shown below: 

Version: 2.1.A PL1 (Build 475) 
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Locating Oracle Release Information 

If you need to locate Oracle release information, you must run sqlplus, using the 
following procedure:

Procedure A-1   Locate Oracle Release Information

1 Open a command window. 

2 Type sqlplus to enter sqlplus. 

3 Enter the username for the VNE Server account at the username prompt. 

4 Enter the password for the VNE Server account at the password prompt. 

➥ The sqlplus login banner appears, containing Oracle edition and version 
information as shown below. 

Connected to:
Oracle8i Enterprise Edition Release 8.1.7.4.1 - Production
With the Partitioning option
JServer Release 8.1.7.4.1 - Production 

5 Note the information, and type quit to exit sqlplus.

6 Close the command window.

End of Procedure A-1

Determining the Oracle Database Used by VNE Server 

If you need to identify the database instance name used by VNE Server, do the 
following:

1) Locate the installation directory for Oracle. 

The Oracle Database Administrator (DBA) will know Oracle’s location. You 
can also use the Windows Find utility to locate Oracle. Use “oracle” for a 
search string. 

2) Go to the ..oracle\oradata directory. This directory contains directories for 
each Oracle database instance. 

3) Look in each directory for the following file: Fs1dat1.ora. 

The name of the directory that contains this file is the name of VNE Server’s 
Oracle database.

4) Note the names of the database instances.
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Determining the Oracle Net Service Names Known to the VNE Server Host 

You may need to locate the Oracle Net service names during troubleshooting. 
The tnsnames.ora file contains these names. The file is located here:

<oracle_install_dir>\<ora81 or ora92>\network\Admin\tnsnames.ora

You can read this file in text editors such as Notepad or Wordpad. The Net 
service name entries have the following structure: 

<net_service_name> = (service_definitions) 

The text string before the “=” is the Net service name. 

Problem Scenarios 

For each problem scenario, verify the correct configuration of VNE Server, verify 
access to the target network, and perform any indicated troubleshooting steps. 
If the problem persists, collect the specified information for OPNET Technical 
Support before initiating a support case. 

Installation Problems 

The problem scenarios in this section involve problems that can arise during 
installation and product startup.

VNE Server Installation Fails 

Scenario: The VNE Server installer fails to run. Alternately, the installer runs to 
completion but tells you that the installation failed. 

Possible Causes: The following failures can occur. For each cause, take 
corrective action, or collect the specified information. 

1) There is not enough free disk space for installation. 

If you do not have enough disk space to install VNE Server, the installer 
displays a message box informing you of this problem. Remove files from 
the target disk to free enough space so installation can continue. The 
installer monitors available disk space and automatically continues when 
you have enough free space. 

2) The installer aborts during installation. 

Collect installer console information. Perform the following steps. 

a) Press and hold the CTRL key during installer initialization to open an 
installer console window. A status box with a progress bar displays 
during initialization. At the end of initialization the console opens. After 
the console window opens, release the CTRL key. 
VNE Server/Release 3.0 VNE-A-3



App A—Troubleshooting VNE Server User Guide 
b) Change the console window properties to provide a 2000 line screen 
buffer. 

Press OK, and choose Modify shortcut which started this window. 
This change ensures that you have enough window buffer space to 
capture all the installer console activity. 

c) Close the installer console. The installer terminates. 

d) Run the installer again. 

Once again, press and hold the CTRL key during installer initialization to 
open an installer console window. After the console window opens, 
release the CTRL key. 

e) Continue the installation to the point at which the failure occurred. Cut 
and paste the installation console text into a text file. Forward this file to 
OPNET Technical Support. 

3) The installation completes with a failed status. 

The most likely causes of this failure are that the installer failed to copy files, 
failed post-installation editing, or failed to execute a command. Forward the 
installation logs to OPNET Technical Support. The files are: 

— <install_dir>\InstallLogs\installer_debug.log 

— <install_dir>\InstallLogs\OPNET_VNE_Server_InstallLog.
log 

Collect Debug Information: Forward installation logs, installer console 
information, or screenshots to OPNET Technical Support. 

Cannot Run the Oracle Installer

Scenario: The Oracle8i installer terminates immediately after it is started. 

Recovery: To work around this problem, perform the following steps:

1) Create a temporary directory on your Oracle host. 

2) Copy the contents of the Oracle RDBMS Server CD to the temporary 
directory created in step 1. 

3) Search the directory structure created in step 1 for the existence of the 
filename symcjit.dll. 
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4) Rename each copy of the symcjit.dll to symcjit.old. 

5) Run setup.exe from the directory you created in step 1, and install Oracle 
8.1.x.

Note—For more information about this problem, refer to Oracle Metalink Doc 
ID: Note:131299.1. The following URL also contains information about this 
problem: http://www.orafaq.com/msgboard/windows/messages/1040.htm. 

Cannot Start VNE Server 

Scenario: The VNE Server Console does not appear after starting the product.

Symptoms: You clicked on the VNE Server desktop icon or used the Program 
Group menu to start VNE Server, but the Console never opens. 

Possible Causes: This problem may involve an installation error. This can 
occur if, during startup, VNE Server cannot resolve a product definition or 
cannot find a referenced file. This problem can also occur if the product .jar files 
or XML control files become corrupted. 

Recovery: If this is a new installation or upgrade, delete the newly installed 
VNE Server directory tree, and try the installation again. 

If the problem persists, startup VNE Server in a debug window, as follows: 

1) Open a command prompt window, and set the working directory to the 
installation directory: <install dir>\VNEServer\3.0.1. 

2) Type vnes.bat /debug ev to start VNE Server (Oracle8i). A window opens 
and displays startup messages (INFO). 

Note—If using an Oracle9i database, type: vnes.bat /Oracle9i /debug ev.

3) Cut and paste the contents of the startup window into a file for Technical 
Support. 

The messages displayed in this window may contain error information or 
exceptions that help identify the cause of the startup problem. 

Collect Debug Information: Forward the startup window message file, from 
step 3, and the installation logs to OPNET Technical Support. The installation 
logs are 
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• <install dir>\InstallLogs\installer_debug.log 

• <install dir>\InstallLogs\OPNET_VNE_Server_InstallLog.log 

Cannot Start VNE Server Services 

Scenario: The VNE Server services fail to start. 

Symptoms: The Console opens, but the service framework fails to start when 
you start VNE Server services. Alternately, the progress box that appears when 
services are started may display messages about a process failing to start. 

Recovery: Try to start VNE Server services as follows: 

1) Exit VNE Server. 

2) Restart VNE Server. After the Console appears, start services. 

3) If services still do not startup, exit VNE Server. 

4) Use the Windows Task Manager to terminate any rmid.exe and javaw.exe 
processes running on the system. 

5) Start VNE Server, and try starting services again. If the problem still occurs, 
delete the log directory from the VNE Server installation directory, terminate 
any rmid.exe and javaw.exe processes and try again. 

Collect Debug Information: If you cannot successfully start VNE Server 
services using the methods described above, collect debug information for 
Technical Support as follows: 

1) Start VNE Server. After the Console opens, select Control > Management 
Console from the Console menu bar. 

2) Select the Management Console Project Properties panel. 

3) Expand the debug property. Set the state property to true. 

4) Press OK to exit the Management Console. 

5) Exit VNE Server. 

6) Open a command prompt window, and set the working directory to the 
installation directory at <install dir>\VNEServer\3.0.1. 

7) Type vnes.bat /debug ev to start VNE Server (Oracle8i). A window opens 
and displays startup messages (INFO).

Note—If using an Oracle9i database, type: vnes.bat /Oracle9i /debug ev.
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8) After the Console opens, start VNE Server services. 

Note—Services may still fail to startup. 

9) Select Help > Display Process Output Message from the Console menu 
bar. 

A series of overlaid windows open. A window opens for each VNE Server 
process with each window displaying initialization messages (INFO) about 
its process. 

10) Copy and paste the contents of the vnes.bat /debug ev window into 
a file, and forward to OPNET Technical Support. 

11) Look at each of the process windows. Take screenshots, or write down any 
error messages, and forward to OPNET Technical Support. 

12) Take a screenshot of the startup progress box, or write down the failure 
message, and forward to OPNET Technical Support.

VNE Server Cannot Connect to the Database 

Scenario: When you start VNE Server, the Console does not appear. A 
message box appears and informs you that a database connection cannot be 
established. 

Possible Causes: Either the database is not reachable, or the database name 
entered during installation of VNE Server does not match an entry in the Oracle 
tnsnames.ora file. 

Recovery: •

• Verify that the Oracle database you are using (local or remote host) is in 
service. If it is not in service, restore the database to service. 

• If the database is on another host and is in service, verify that it is reachable.

Type tnsping <database name>. If you get a TNS: no listener response, 
the database is not reachable. Correct the network problem.
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• The most likely cause of this problem is that the database name entered 
during VNE Server installation does not match any known Oracle Net 
Services name. 

— Edit the <install dir>\lib\xml\dtd\props_Oracle8i.dtd file 
(props_Oracle9i.dtd for Oracle9i installations). Search for a line in the file 
that contains “fs.db.name”. The quoted database name in this line should 
match an entry in the Oracle tnsnames.ora file. Refer to Oracle Net 
Services on page VNE-5-22 for information about the tnsnames.ora file 
format. 

— Open the <oracle install dir>\ora81\network\ADMIN\tnsnames.ora file for 
Oracle8i.

Or open the <oracle install dir>\ora92\network\ADMIN\tnsnames.ora file 
for Oracle9i. 

— You may see that the name used in the props_Oraclexx.dtd file matches 
an entry in tnsnames.ora, but is misspelled. Correct the error in the dtd 
file. Save and exit the file. 

• Another common cause of this problem is that a fully-qualified hostname (i.e., 
vnesdb.opnet.com) was entered for the database name during VNE Server 
installation, when the entry in tnsnames.ora is actually vnesdb. Correct 
errors of this nature in the dtd file. 

Try, once again, to start VNE Server. If the problem persists, contact OPNET 
Technical Support. 

Collect Debug Information: Take a screenshot of the error dialog box, or write 
down the error message. Forward the information and the following two files to 
OPNET Technical Support: 

• Oracle8i: <install dir>\lib\xml\dtd\props_Oracle8i.dtd 

Oracle9i: <install dir>\lib\xml\dtd\props_Oracle9i.dtd. 

• Oracle8i: <oracle install dir>\ora81\network\ADMIN\tnsnames.ora

Oracle9i: <oracle install dir>\ora92\network\ADMIN\tnsnames.ora
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Configuration Problems 

The problem scenarios in this section involve problems that can arise during 
product configuration.

Cannot Communicate with the Target Network 

Scenario: Config file collection and SNMP-based MIB data collection fails for 
all the network devices immediately after data collection starts. The Event 
Viewer shows numerous events of Error severity that describe device access 
problems. 

Possible Causes: There may be an error in your VNE Server setup, or the 
target devices may be inaccessible. 

Verify Setup: Verify configuration of the host platform, VNE Server, and the 
target network, by checking the following items: 

1) Use the route print command in a Command Prompt window to verify that 
the host PC has a route to the gateway of the target network. If no route 
exists, create a route. 

2) Check the VNE Server device access information for the target network to 
ensure that device IP addresses, login information, and community strings 
are correct. Correct any problems. 

3) Verify that devices in the target network have telnet enabled. Enable telnet 
on devices that have telnet disabled. 

Verify Access: Verify access to the target network. 

1) Ping the gateway that provides access into the target network. Ping 
interfaces on several devices in the target network. Run tracert to 
inaccessible addresses. 

2) If you can ping device interfaces in the target network, verify that you can 
use telnet to access several different devices. 

If access to the target network is the problem, fix any configuration or network 
problems. 

Collect Debug Information: If the problem persists after you have verified VNE 
Server setup and access to the target network, collect the standard SPR Report 
information, as detailed in Filing an OPNET Technical Support Case on 
page VNE-A-21, and contact OPNET Technical Support.
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No Network Data is Written to the Oracle Database 

Scenario: The VNE Server Event Viewer indicates that the adapters are 
running and that data is being collected, but the Report Manager reports contain 
no data. Additionally, the Event Viewer may contain events of Critical severity 
that describe database problems.

Verify Setup: Verify that Oracle services are running, the database is 
accessible, and the VNE Server accounts are setup correctly. 

1) Verify that the Oracle TNSListener and OracleService services are running, 
using the path specific to your operating system. Start these services, if 
they are not running:

Windows NT: Start > Settings > Control Panel > Services 

Windows 2000: Start > Settings > Control Panel > Administrative Tools 
> Services

2) Use Oracle DBA Studio (Oracle8i) to verify that the database used by VNE 
Server is available and is setup correctly. Verify that the global database 
name (GDN) entered during Oracle installation is visible in DBA Studio. If 
the database is not visible, create the database. 

For Oracle9i, use the Enterprise Manager Console for this step. 

3) If the VNE Server database is visible, expand its display. Make sure that the 
view is By Schema (using View > By Schema). Expand Schema and verify 
that the VNE Server account entry exists. (This is the Oracle account name 
entered during VNE Server installation). If it does not exist, rerun 
setup_accounts.sql within sqlplus. See Setting Up VNE Server Database 
Accounts within Oracle on page VNE-5-24, for instructions. 

Collect Debug Information: If the problem persists after you correct any of the 
database problems above, collect the following files before calling OPNET 
Technical Support: 

• In the directory ...\Oracle\admin\<database instance name>\create, collect 
the createdb.log and dbSilentCreate.log files. 

• In the directory ...\Oracle\admin\<database instance name>\pfile, collect 
init.ora. 

Send these files with the standard SPR Report information to OPNET Technical 
Support.
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The Oracle Database Does Not Restart Correctly After PC startup 

Scenario: The VNE Server Console indicates that adapters are running and 
that data is being collected, but the Report Manager reports contain no data. 
The Event Viewer may contain events of Critical severity that describe database 
problems. 

Verify Setup: Verify correct Oracle setup per No Network Data is Written to the 
Oracle Database on page VNE-A-10. 

If Oracle services are running and the database has been configured correctly 
for VNE Server, use the Windows Task Manager to view Oracle memory usage. 
A database dedicated to VNE Server will use more than 70 MB of memory, if 
Oracle starts up properly. If the displayed memory usage is much lower than 
normal, Oracle has probably not started up properly. 

Recovery: If Oracle memory usage is much less than 70 MB, perform the 
following steps to restart. 

For Oracle8i: 

1) In a command window, type: svrmgrl. 

2) At the svrmgrl prompt (svrmgrl>), type: connect internal. 

3) Type shutdown. 

4) Type startup. 

5) Type quit. 

For Oracle9i: 

1) In a command window, type: sqlplus “/ as sysdba”. 

2) Type startup open <database name> parallel. 

3) Type quit. 

When Oracle is running, check its memory usage again. If Oracle memory 
usage is much higher now (tens of MB), Oracle is ready for operation with VNE 
Server. 
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Collect Debug Information: If the problem persists after you correct the 
database problems above, collect the following files: 

• In the directory ...\Oracle\admin\<database instance name>\create, collect 
the createdb.log and dbSilentCreate.log files. 

• In the directory ...\Oracle\admin\<database instance name>\pfile, collect 
init.ora. 

Send these files with the standard SPR Report information to OPNET Technical 
Support.

Adapters Do Not Run as Intended 

Scenario: The VNE Server Console does not show one or more adapters 
running. The Report Manager does not show the data collected by one or more 
adapters. 

Verify Setup: Use the Management Console Adapter Schedule panel to verify 
that the problem adapters have been enabled. Enable any adapters that are 
disabled, if these adapters are supposed to be running. 

Collect Debug Information: If the problem adapters are enabled but the 
problem persists, collect the standard SPR Report information, and contact 
OPNET Technical Support.

Configuration Files are Not Collected or Imported 

Scenario: The config file import adapters (Device Config File Import or 
CiscoWorks Config File Import) cannot locate any configuration files. The output 
file directories for the config file collection adapters are empty. 

Note—The Device Config File Collection adapter collects files that are imported 
by the following adapters: Device Config File Import, Device ifIndex Import, 
Device FR Map Import, Device Version Import, Device IP Route Import, Device 
CDP Import, Device ARP Table Import, Device Interface Import, Device Module 
Import, Device CAM Table Import, and Device VLAN Database Import.

Note—The CiscoWorks Config File Collection adapter collects files that are 
imported by the CiscoWorks Config File Import adapter. 

Verify Setup: Check the following items: 

1) Examine the Event Viewer for events of Error severity that describe device 
access problems. 
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2) Use the Management Console Adapter Schedule panel to verify that the 
proper config file collection adapter is enabled. View the Console Adapter 
Statistics to determine whether the adapter has ever run. Enable the 
adapter, if it is currently disabled. 

3) Use the Management Console Adapter Resources panel to verify that the 
output file directory of the proper config file collection adapter matches the 
input file directory of the associated config file import adapter. Correct any 
directory mismatches.

4) Check the output file directory of the config file collection adapter to ensure 
there are configuration files. 

Verify Access: Verify there is access to target devices and that login 
information is correct. For Cisco routers, verify that Privileged Exec mode is 
accessible. 

Collect Debug Information: If you cannot solve the problem using the steps 
listed above, collect the standard SPR Report information, and contact OPNET 
Technical Support. 

Configuration Files are Not Collected for a Specific Device 

Scenario: Configuration files are not collected for a device. The Network 
Browser and Report Manager do not show information for the device. 

Verify Setup: View the device access entry in the Device and Platform Info 
panel of the Management Console. Verify that the device login information is 
correct. Correct any problems. 

Verify Access: Ping the target device to verify access. Telnet to the target 
device to verify that it is accessible. Verify access to Privileged Exec mode. 
Correct any problems. 

Collect Debug Information: If the problem persists, collect the standard SPR 
Report information, and contact OPNET Technical Support. 

MIB Data is Not Collected for a Specific Device 

Scenario: The Report Manager does not show any data obtained from MIBs for 
a specific device. The Event Viewer shows events of Error severity that describe 
access problems with the problem device.

Verify Setup: View the device access entry in the Device and Platform Info 
panel of the Management Console. Verify that the SNMP community string is 
correct. Correct any problems.
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Verify Access: If you have access to other products that can do SNMP queries 
(HP OpenView, AdventNet, etc.), collect System group information from the 
target device to verify both access and the community string. 

Verify SNMP: Verify that the device’s SNMP agent is running. 

Collect Debug Information: If the problem persists, collect the standard SPR 
Report information, and contact OPNET Technical Support. 

Operation Problems 

The problem scenarios in this section involve problems that can arise during 
continuous operation. 

Oracle ORA-4031 Shared Pool Memory Allocation Errors 

Scenario: The VNE Server Event Viewer displays Critical events informing the 
user of database problems. 

Verify Setup: This problem is common with Oracle 8.1.7.0 installations. VNE 
Server requires an Oracle 8.1.7.4.1 database for operation. Verify that the 
8.1.7.4.1 patch is installed. Install the patch if you are running Oracle 8.1.7.0. 
The patch fixes shared pool memory problems in Oracle. 

Verify proper Oracle setup per No Network Data is Written to the Oracle 
Database on page VNE-A-10. If Oracle services are running and the database 
has been configured properly for VNE Server, check the rmid logs. This log file 
is located at <install dir>\log\vne_rmid_log.log. 

To view the log file, make a copy of the file and open it using a text editor. Search 
for “ORA-”, “ORA-4031”, “error”, and “exception”. 

Recovery: If ORA-4031 errors are present in the rmid log, do the following 
steps to correct the problem.

1) Stop VNE Server data collection by selecting Control > Stop VNE 
Services from the Console menu bar. 

2) Exit VNE Server by selecting File > Exit from the Console menu bar. 

3) Shutdown and restart Oracle, using the appropriate path for your operating 
system and selecting the service OracleServiceO81A:

Windows: Start > Settings > Control Panel > Administrative Tools > 
Services. 

4) After Oracle has restarted, start VNE Server using the OPNET VNE Server 
selection within the OPNET VNE Server program group. 
VNE-A-14 VNE Server/Release 3.0



VNE Server User Guide App A—Troubleshooting
5) Start VNE Server data collection by selecting Control > Start VNE 
Services from the Console menu bar.

6) Monitor operation for an hour or more. No Critical events regarding the 
database should appear in the Event Viewer. 

Collect Debug Information: If the problem persists, collect the standard SPR 
Report information, and contact OPNET Technical Support.

Services Halt and Database Error Events Appear in the Event Viewer 

Scenario: The VNE Server Event Viewer shows events of Emergency and 
Critical severity that describe database problems. The service framework shuts 
down. 

Causes: Any kind of a database access error can cause this problem. If there 
is no free tablespace for the database, this problem will also occur. This problem 
may also occur if data written to the database does not match the underlying 
schema. 

Recovery: If the database is out of service, restore it to service. If connectivity 
to a remote database is lost, restore connectivity. Exit VNE Server, re-enter and 
restart services to recover. 

If the problem is caused by data that violates the underlying database schema, 
turn off the “auto shutdown” feature as follows: 

1) Open the VNE Server Management Console. 

2) Open the Project Properties panel. 

3) Set the stopServicesOnDatabaseFailures property to false. 

4) Press the Apply button to save the changes. 

5) Start services and start your data collection schedule. 

Collect Debug Information: Forward the rmid and Event Viewer event logs to 
OPNET Technical Support. If possible, zip the temp dir and forward that to 
OPNET Technical Support, as well. If you cannot provide this data, for security 
reasons, save the temp dir in a location accessible to you for joint 
troubleshooting with OPNET Technical Support. 
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Removing and Recreating VNE Server User Account and Database from Oracle 

Scenario: A serious problem has developed with the network database that can 
only be corrected by removing and recreating the VNE Server account and 
database. 

WARNING—Never perform this procedure unless advised to do so by OPNET 
Technical Support. All VNE Server data in the Oracle database is removed by 
this procedure. 

Recovery: To remove the VNE Server user account and database from Oracle, 
and recreate a fresh account and database, perform the steps in Setting Up 
VNE Server Database Accounts within Oracle on page VNE-5-24. 

Collect Debug Information: If the database cannot be removed and recreated, 
forward any screen output captured during this procedure to OPNET Technical 
Support. 

Unexpected Devices are Present in the Network Database 

Scenario: The Report Manager and Network Browser show devices that are 
not expected to be in the target network. 

Verify Setup: Check the following items: 

1) Verify that the ASCII Import files reference only devices that are in the 
target network. Incorrect setup of the ASCII Import adapter can result in 
extra devices appearing in the network database. Correct any problems. 

2) View the device access information in the Device and Platform Info panel of 
the Management Console. Verify that the device access information only 
includes devices in the target network. Correct any problems. 

3) Make sure adapters that gather information from other data collection 
systems (such as Concord eHealth) are configured correctly. If the Concord 
adapter is incorrectly configured to communicate with a Concord system in 
a different target network, extra devices can be included in the network 
database. Correct any problems. 

Collect Debug Information: If the problem persists, collect the standard SPR 
Report information, and contact OPNET Technical Support. 

Device Asset Information is Not Collected for a Device

Scenario: The Report Manager Asset Inventory report does not show device 
hardware configuration information for a device. Other MIB data, such as the 
System Description, is present in reports. 
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Possible Causes: The device may not support the ENTITY-MIB. VNE Server 
collects hardware configuration information from this MIB. 

Collect Debug Information: If the device supports the ENTITY-MIB, collect the 
standard SPR Report information, and contact OPNET Technical Support.

Failure to Connect to the CiscoWorks RME Database 

Scenario: The CiscoWorks RME Database Import adapter fails to connect to 
the database. The VNE Server Event Viewer shows connection failure events. 

Verify Setup: Use the Management Console Adapter Resources panel to verify 
that the RME database connection properties for this adapter are correct. 
Correct any problems found. 

Recovery: This problem may also occur due to the RME database getting into 
a state where it no longer accepts connections. Perform the following steps to 
clear this problem by resetting the RME database. 

1) Open a web browser and go to the URL for the CiscoWorks RME database. 
An example is: http://CWpc.acme.com:1741 (include the database port 
number in the URL). 

2) Login as an administrative user, and press return. 

3) Press the Server Configuration button in the lower left browser panel. 

4) Select the Administration, Process Management, and Stop Process 
choices in the Server Configuration panel. 

The right browser panel displays a Stop Process dialog box. 

5) Select the Process radio button in the stop field of the Stop Process dialog 
box. 

6) Select the EssentialsDbEngine process from the Process Name pull-down 
menu and press Finish. 

A message appears stating that the process is stopped. 

7) Press Start Process in the Server Configuration panel. 

The right browser panel displays a Start Process dialog box. 

8) Select the Process radio button in the start field of the Start Process dialog 
box. 
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9) Select the EssentialsDbEngine process from the Process Name drop-down 
menu and press Finish. 

A message appears stating that the process is started.

10) Press Logout to leave the CiscoWorks RME database management 
environment. 

Collect Debug Information: If the problem persists, collect the standard SPR 
Report information, and contact OPNET Technical Support. 

Failure to Connect to the CiscoWorks ANI Database 

Scenario: The CiscoWorks ANI Database Import adapter fails to connect to the 
database. The VNE Server Event Viewer shows connection failure events. 

Verify Setup: Use the Management Console Adapter Resources panel to verify 
that the ANI database connection properties for this adapter are correct. Correct 
any problems found. 

Recovery: This problem may also occur due to the ANI database getting into a 
state where it no longer accepts connections. If this is the case, perform the 
following steps to clear this problem by resetting the ANI database. 

1) Open a web browser and go to the URL for the CiscoWorks ANI database. 
An example is: http://CWpc.acme.com:1741 (include the database port 
number in the URL). 

2) Login as an administrative user, and press return. 

3) Press the Server Configuration button in the lower left browser panel. 

4) Select the Administration, Process Management, and Stop Process 
choices in the Server Configuration panel. 

The right browser panel displays a Stop Process dialog box. 

5) Select the Process radio button in the stop field of the Stop Process dialog 
box. 

6) Select the ANIDbEngine process from the Process Name pull-down menu, 
and press Finish. 

A message appears stating that the process is stopped. 

7) Press Start Process in the Server Configuration panel. 

The right browser panel displays a Start Process dialog box. 

8) Select the Process radio button in the start field of the Start Process dialog 
box. 
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9) Select the ANIDbEngine process from the Process Name pull-down menu 
and press Finish. 

A message appears stating that the process is started.

10) Press Logout to leave the CiscoWorks ANI database management 
environment. 

Collect Debug Information: If the problem persists, collect the standard SPR 
Report information and contact OPNET Technical Support. 

Cannot Import a VNE Server Network Model into the OPNET analysis software

Scenario: Import of VNE Server network model fails when creating a new 
OPNET analysis software project. 

Verify Setup: Check the following items: 

1) In the OPNET analysis software control panel, select Edit > Preferences 
to open the Preferences window. Search for the string vne to find the 
preferences related to VNE Server. 

2) Verify that the vne_import_ior_file preference points to the vneserver.ior 
file. Correct any problems. 

a) If VNE Server resides on the same system as OPNET analysis software, 
this preference must point to the vneserver.ior file in the VNE Server 
temp directory. This temp directory defaults to C:\op_admin\tmp\vne, but 
you can change the directory during VNE Server installation. 

b) If the two products reside on different systems, verify that this preference 
points to the ior file based upon your setup scenario. 

If you have mapped a network drive so the OPNET analysis software 
host can directly access the ior file on the VNE Server host, verify that 
the path is correct. Verify that you can still view the file from the OPNET 
analysis software host. 

If you have copied the ior file to a directory on the OPNET analysis 
software host, verify that this preference points to the correct path. 

3) Verify that the vneserver.ior file remains valid. If VNE Server data collection 
is stopped, the ior file is removed from the temp directory. Make sure that 
VNE Server is operating and that this file is present in the temp directory. 

If the two products reside on different systems, the ior file can become 
stale, if VNE Server data collection is stopped and restarted. If this 
happens, copy the current ior file from the VNE Server host to the VNE 
Server temp directory on the OPNET analysis software host. 
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4) Verify that the vne_import_postproc_function preference is set to 
Vne_Import_Postproc_Default. 

5) Verify that the vne_import_postproc_library preference is set to 
vne_import_postproc. 

Verify Access: If VNE Server and OPNET analysis software reside on different 
systems, verify access by pinging the VNE Server system from the OPNET 
analysis software system. 

Try again: VNE Server (in release 1.1) only supports one model import request 
at a time. Once an import session is in progress, new import requests will fail. 
Try again to import a model from VNE Server. VNE Server 1.2 and up support 
multiple, simultaneous import sessions. 

Collect Debug Information: If the problem persists, collect the OPNET analysis 
software error logs and the standard SPR Report information. Contact OPNET 
Technical Support. 

Licensing Problems 

The problem scenarios in this section involve problems that can arise with 
respect to product licensing. 

Cannot Obtain a License When Starting VNE Server 

Scenario: Services fail to start in the VNE Server Console. An Emergency level 
event appears in the Event Viewer about a failure to obtain a license. 

Recovery: If this problem occurs, perform the following steps to recover. 

1) Verify that the License Server is in service and accessible if located on 
another host. 

2) Verify that a license is available for VNE Server. 

3) Exit the VNE Server Console. Verify that the op_monitor process is not 
running. Kill the process, if it is running. 

4) Check the VNE Server installation directory for an opmonlock directory. If 
the directory exists, delete it. 

Work through these steps to correct any problems found. After completing them, 
you should be able to open the VNE Server Console, start service, and obtain 
a license. 

Collect Debug Information: If the recovery steps do not correct your licensing 
problems, collect the following file, and contact OPNET Technical Support: 
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<install dir>\VNEServer\3.0\log\VNE_Event_Viewer.log. 

Services Shut Down Due to License Problems 

Scenario: VNE Server has been operating for an extended period of time 
(hours, days, weeks) when services stop, and an Emergency level event 
appears in the Event Viewer about a failure to keep a license.

Recovery: If this problem occurs, exit the VNE Server Console. Re-enter the 
Console and start services. Services should start up. If they do not, execute the 
recovery steps in Cannot Obtain a License When Starting VNE Server on 
page VNE-A-20. 

Collect Debug Information: If the recovery steps do not correct your licensing 
problems, collect the following file, and contact OPNET Technical Support: 

<install dir>\VNEServer\3.0\log\VNE_Event_Viewer.log. 

Filing an OPNET Technical Support Case

To file a Technical Support case, proceed as follows:

1) Use a web browser to connect to the OPNET Technical Support web site:

http://www.opnet.com/support/home.html 

2) Locate the Enter/Update a Tech Support Case section on the web page. 

3) Click on the New Case link. 

A Tech Support Request Form appears. 

4) Fill in all the fields in the form, and press Submit TS Request. 

Coordinate with OPNET Technical Support to transfer any data captured during 
troubleshooting. 
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App B Device Configuration Commands

The device configuration commands supported by VNE Server for each vendor 
are listed in the following sections:

• Cisco Commands

• Cisco Catalyst Commands

• Cisco PIX Firewall Commands

• Juniper Commands

• Nortel Networks Commands

• Nortel Networks Passport 8000 Commands

• Nortel Networks Passport 7480, 15000, 20000 Commands

• Extreme Commands

• Foundry Commands
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Cisco Commands

Last updated for release: 1.2 PL3. 

Cisco commands include the following:

• Cicso Global Commands

• Cisco Interface Commands

• Cisco MPLS Commands

• Cisco Tunnel Commands

• Cisco RIP Commands

• Cisco IGRP Commands

• Cisco EIGRP Commands

• Cisco OSPF Commands

• Cisco BGP Commands

• Cisco IS-IS Commands

• Cisco Route-Map Commands

• Cisco System Management Commands

Cicso Global Commands

• hostname <name>

• hostname <name> alt hostname <name> 

• version <version>

• ip domain-name <name>

• ip default-network <address>

• ip default-gateway <address>

• ip local policy route-map <map-tag> 

• ip vrf vrf-name 

• ip vrf forwarding vrf-name 

• ip route [vrf <name>] <dest addr> <mask> <next hop> [metric] [name 
<name>] [tag <number>] [permanent]

• ip route vrf <vrf value> <dest addr> <mask> <next hop> [metric] [name 
<name>] [tag <number>] [permanent] 
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• ip route <dest addr> <mask> <next hop> [metric] [name <name>] [tag 
<number>] [permanent]

• access-list <list number>

• ip access-group {access-list-number | name} {in | out}

• ip as-path access-list <list number> <permit|deny> <reg expression>

• ip prefix-list <list name> [seq <number>] <permit|deny <network/length>> 
[ge <number>] [le <number>]

• ip prefix-list <list name> <permit|deny <network/length>> [ge <number>] [le 
<number>]

• ip prefix-list <list name> [seq <number>] <permit|deny <network/length>>

• ip prefix-list <list name> <permit|deny <network/length>>

• ip community-list <list number> <permit|deny> <community> 
[<community>...]

• ip community-list <standard | expanded> <list number> <permit|deny> 
<community> [<community>...

• ip access-list <standard|extended> <name>

• ip explicit-path <name <name> | identifier <number>>

• ip explicit-path <name <name> | identifier <number>> <enable|disable>

• ip explicit-path {name WORD | identifier number} [{<enable|disable>}]

• ip policy route-map <map-tag> 

• ip authentication mode eigrp <as-number> md5 

• ip authentication key-chain eigrp <as-number> <key-chain> 

• next-address <ip address>

• next-address <loose|strict> <ip address>

• index <number> next-address <ip address>

• index <number> next-address <loose|strict> <ip address>

Cisco Interface Commands

• interface <name/number> [multipoint|point-to-point|<other>]

• no ip address

• ip address <address> <mask> secondary

• ip address <address> <mask>
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• network <address>

• clockrate <bps>

• bandwidth <kbps>

• channel-group <number>

• ring-speed <speed>

• delay <tens of microsecs>

• description <text>

• mtu <bytes>

• ip mtu <value>

• ip route-cache [cbus|flow|distributed]

• no ip route-cache [cbus|flow|distributed]

• encapsulation frame-relay

• encapsulation frame-relay <cisco|ietf>

• ip unnumbered <interface name>

• shutdown

• frame-relay interface-dlci <dlci>

• frame-relay interface-dlci <dlci> <cisco|ietf>

• frame-relay map ip <addr> <dlci>

• frame-relay map ip <addr> <dlci> [broadcast] [cisco|ietf]

• atm pvc <vcd> <vpi> <vci> aal5snap

• atm pvc <vcd> <vpi> <vci> aal5snap [<peak> <average> [burst]] [inarp 
minutes]

• abr

• ubr

• ubr+

• vbr-nt

• protocol ip <ip address>

• protocol ip <ip address> [[no] broadcast]

• pvc <vpi/vci> [qsaal|ilmi|smds]
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• pvc <name> <vpi/vci> [qsaal|ilmi|smds]

• pvc <vpi/vci>

• pvc <name> <vpi/vci>

• ip rsvp bandwidth <interface kbps> <single flow kbps>

• ip rsvp bandwidth <interface kbps>

• standby [<group number>] ip [<ip address> [secondary]]

• standby [<group number>] mac-address <mac address>

• standby mac-refresh <seconds>

• standby name <group name>

• standby [<group number>] preempt priority <priority>

• standby [<group number>] preempt delay [<delay>] [minimum <delay>] 
[sync <delay>]

• standby [<group number>] preempt

• standby [<group number>] priority <priority>

• standby [<group number>] timers [msec] <hello time> [msec] <hold time> 
[advertise <advertisement interval>]

• standby [<group number>] track <interface name> [<interface priority>]

• standby [<group number>] use-bia [scope interface]

• standby [group-number] authentication <string>

• standby delay [minimum <delay>] [reload <delay>]

• no standby redirects unknown

• standby redirects timers <advertisement-interval> <holddown-interval>

• encapsulation dot1Q <vlan-id> [native]

• switchport access vlan <vlan-id>

• spanning-tree vlan <vlan-id> [<vlan-id>...] cost <cost>

• spanning-tree vlan <vlan-id> [<vlan-id>...] port-priority <priority>

• spanning-tree portfast 

• spanning-tree cost <cost>

• spanning-tree port-priority <priority>
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Cisco MPLS Commands

• mpls traffic-eng tunnels

• mpls traffic-eng <level>

• mpls traffic-eng administrative-weight <weight>

• mpls traffic-eng attribute-flags <0x0 - 0xFFFFFFFF>

• mpls traffic-eng bandwidth <bandwidth>

• mpls traffic-eng isis-level <level>

• mpls traffic-eng backup-path lsp-name 

• mpls label protocol ldp

• mpls ip

• mpls ldp holdtime

• mpls ldp advertise-labels [for prefix-access-list ]

• mpls ldp discovery { hello { holdtime | interval } seconds | targeted-hello { 
holdtime | interval } seconds | accept [ from acl ] }

• tag-switching ip

Cisco Tunnel Commands

• tunnel source <ip address | interface name>

• tunnel destination <ip address|hostname>

• tunnel mode mpls traffic-eng

• tunnel mpls traffic-eng fast-reroute

• tunnel mpls traffic-eng affintiy <properties> mask <mask>

• tunnel mpls traffic-eng affintiy <properties>

• tunnel mpls traffic-eng autoroute announce

• no tunnel mpls traffic-eng autoroute announce

• tunnel mpls traffic-eng autoroute metric [absolute|relative] <metric>

• tunnel mpls traffic-eng autoroute metric <metric>

• tunnel mpls traffic-eng path-option <number> <dynamic|explicit name <path 
name|path number>>

• tunnel mpls traffic-eng path-option <number> <dynamic|explicit name <path 
name|path number>> lockdown
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• tunnel mpls traffic-eng priority <setup>

• tunnel mpls traffic-eng priority <setup> <hold>

Cisco RIP Commands

• router rip

• network <address>

• neighbor {ip-address}

• timers basic {update} {invalid} {holddown} {flush}

• version {1|2}

• auto-summary

• no auto summary

• default-metric <value>

• distance <distance> [<address> <mask> [<access-list>]]

• distribute-list <access-list> <in|out>

• distribute-list <access-list> <in|out> [<interface|<proto [as num]>]

• maximum-paths <value>

• passive-interface <interface>

• no passive-interface <interface> 

• redistribute <protocol>

• redistribute <protocol> [<process id>]

• redistribute <protocol> [metric <value>] [route-map <name>] [match 
<external|internal>] ...

• redistribute <protocol> [<process id>] [metric <value>] [route-map <name>] 
[match <external|internal>] ...

• ip rip send version

• ip rip send version [1]

• ip rip send version [1] [2]

• ip rip receive version

• ip rip receive version [1]

• ip rip receive version [1] [2]
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• ip rip triggered

• ip summary-address rip {ip-address} {ip-network-mask}

Cisco IGRP Commands

• router igrp <process id>

• network <address>

• neighbor {ip-address}

• timers basic {update} {invalid} {holddown} {flush}

• timers basic {update} {invalid} {holddown} {flush} [sleeptime]

• metric holddown

• traffic-share {balanced | min}

• default-metric <value>

• distance <distance> [<address> <mask> [<access-list>]]

• distribute-list <access-list> <in|out>

• distribute-list <access-list> <in|out> [<interface|<proto [as num]>]

• maximum-paths <value>

• metric maximum-hops <value>

• passive-interface <interface>

• no passive-interface <interface>

• no passive-interface <interface>

• redistribute <protocol>

• redistribute <protocol> [<process id>]

• redistribute <protocol> [metric <value>] [route-map <name>] [match 
<external|internal>] ...

• redistribute <protocol> [<process id>] [metric <value>] [route-map <name>] 
[match <external|internal>] ...

• metric weights <tos> <k1> <k2> <k3> <k4> <k5>

• variance <variance>
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Cisco EIGRP Commands

• router eigrp <process id>

• network <address>

• network <address> <mask>

• neighbor {ip-address}

• traffic-share {balanced | min}

• metric holddown

• metric maximum-hops {value}

• default-metric <value>

• distance <distance> [<address> <mask> [<access-list>]]

• distance eigrp <internal dist> <external dist>

• distribute-list <access-list> <in|out>

• distribute-list <access-list> <in|out> [<interface|<proto [as num]>]

• maximum-paths <value>

• passive-interface <interface>

• redistribute <protocol>

• redistribute <protocol> [<process id>]

• redistribute <protocol> [metric <value>] [route-map <name>] [match 
<external|internal>] ...

• redistribute <protocol> [<process id>] [metric <value>] [route-map <name>] 
[match <external|internal>] ...

• metric weights <tos> <k1> <k2> <k3> <k4> <k5>

• variance <variance>

• no auto-summary

• ip split-horizon

• no ip split-horizon

• ip bandwidth-percent eigrp {as-number} {percent}

• ip hello-interval eigrp {as-number} {seconds}

• ip hold-time eigrp {as-number} {seconds}

• ip split-horizon eigrp <process id>
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• no ip split-horizon eigrp <process id>

• ip summary-address eigrp <as number> <address> <mask> <admin dist>

• ip summary-address eigrp <as number> <address> <mask>

• timers active-time 

• no timers active-time

• eigrp stub

• offset-list <access-list> in|out <offset> [<interface>] 

Cisco OSPF Commands

• router ospf <process id>

• network <address> <wildcard mask> area <area id>

• default-metric <value>

• distance <distance> [<address> <mask> [<access-list>]]

• distance ospf [external <dist>] [inter-area <dist>] [intra-area <dist>]

• distribute-list <access-list> <in|out>

• distribute-list <access-list> <in|out> [<interface|<proto [as num]>]

• maximum-paths <value>

• passive-interface <interface>

• no passive-interface <interface> 

• redistribute <protocol>

• redistribute <protocol> [<process id>]

• redistribute <protocol> [metric <value>] [route-map <name>] [match 
<external|internal>] ...

• redistribute <protocol> [<process id>] [metric <value>] [route-map <name>] 
[match <external|internal>] ...

• auto-cost

• auto-cost [reference-bandwidth <value>]

• ospf auto-cost [reference-bandwidth <value>]

• area <area id>

• summary-address {address-mask} {prefix-mask} [not-advertise] [tag {tag}]
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• timers spf {spf-delay} {spf-holdtime}

• neighbor {ip-address} database-filter all out

• neighbor {ip-address} [priority {number}] [poll-interval {seconds}] [cost 
{numbers}] [database-filter [all]]

• default-information originate [always] [metric metric-value] [metric-type 
type-value] [route-map map-name]

• ip ospf cost <cost>

• ip ospf network {broadcast|non-broadcast|{point-to-multipoint 
[non-broadcast]}|point-to-point}

• ip ospf dead-interval {seconds}

• ip ospf hello-interval {seconds}

• ip ospf priority {priority}

• ip ospf retransmit-interval {seconds}

• ip ospf transmit-delay {seconds}

Cisco BGP Commands

• router bgp <as>

• auto-summary, no auto-summary

• address-family vpnv4

• address-family vpnv4 [unicast | multicast]

• address-family ipv4 vrf vrf-name

• address-family ipv4 [unicast] vrf vrf-name

• bgp client-to-client reflection, no bgp client-to-client reflection

• bgp cluster-id {cluster-id}

• bgp confederation identifier {autonomous-system}

• bgp confederation peers as-number [... as-number]

• synchronization, no synchronization

• timers bgp {keepalive} {holdtime}

• network {address} {mask} weight {weight} [route-map {map-name}]

• network <address> mask <mask>

• network <address>
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• passive-interface <interface>, no passive-interface <interface>

• bgp always-compare-med

• bgp default local-preference <value>

• default-metric <value>

• distance bgp <external> <internal> <local>

• distribute-list <access-list> <in|out>

• distribute-list <access-list> <in|out> [<interface|<proto [as num]>]

• redistribute <protocol>

• redistribute <protocol> [<process id>]

• redistribute <protocol> [metric <value>] [route-map <name>] [match 
<external|internal>] ...

• redistribute <protocol> [<process id>] [metric <value>] [route-map <name>] 
[match <external|internal>] ...

• neighbor

• neighbor <ip address> active

• neighbor <peer group name> peer-group

• neighbor <ip address> peer-group <peer group name>

• maximum-paths <value>

• aggregate-address <address> <mask> [as-set] [summary-only] 
[suppress-map <map-name>] [advertise-map <map-name>] [attribute-map 
<map-name>]

• bgp fast-external-fallover, no bgp fast-external-fallover

• bgp router-id <ip address>

Cisco IS-IS Commands

• router isis

• is-type {level-1, level-2-only, level-1-2}

• ip router isis <process tag>

• ip router isis

• clns router isis [tag]

• isis metric <def metric> [<delay> [<expense> [<error> [level-1|level-2] 
|level-1|level-2] |level-1|level2] |level-1|level-3]
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• isis metric <def metric>

• isis circuit-type {level-1|level-2-only|level-1-2}

• isis csnp-interval {seconds} {level-1|level-2}

• isis hello-interval {seconds} {level-1|level-2}

• isis hello-multiplier {seconds} {level-1|level-2}

• isis priority {priority} {level-1|level-2}

• isis lsp-interval {milliseconds}

• isis retransmit-interval {milliseconds}

• isis retransmit-throttle-interval {milliseconds}

• set-overload-bit

• spf-interval [level-1|level-2] {seconds}

• lsp-mtu {bytes}

• max-lsp-lifetime {lifetime}

• summary-address {prefix} {mask} [level-1|level-2|level-1-2]

• summary-address address mask {level-1 | level-1-2 | level-2}

• hello-padding {multi-point|point-to-point}

• no hello-padding {multi-point|point-to-point}

• isis password <password> [level-1 | level-2]

• spf-interval [level-1|level-2] <min-interval> [<initial wait> [<min wait>]]

• lsp-refresh-interval <seconds>

• partition avoidance [<area-tag>]

• prc-interval <min-interval> [<initial wait> [<min wait>]]

• lsp-gen-interval [level-1|level-2] <min-interval> [<initial wait> [<min wait>]]

• max-area-addresses <num-addresses>

• area-password <password>

• domain-password <password>

• net <net>

• distance <distance> [<address> <mask> [<access-list>]]

• distribute-list <access-list> <in|out>
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• distribute-list <access-list> <in|out> [<interface|<proto [as num]>]

• maximum-paths <value>

• metric-style wide

• passive-interface <interface>

• no passive-interface <interface>

• redistribute <protocol>

• redistribute <protocol> [<process id>]

• redistribute <protocol> [metric <value>] [route-map <name>] [match 
<external|internal>] ...

• redistribute <protocol> [<process id>] [metric <value>] [route-map <name>] 
[match <external|internal>] ...

• redistribute isis ip <level> into <level> [distribute-list <number> | metric-style 
wide>]

• mpls traffic-eng <level>

• mpls traffic-eng isis-level <level>

Cisco Route-Map Commands

• route-map <name> [permit|deny] [<sequence number>]

• match as-path <path number>

• match community-list <list number>

• match community-list <list number> exact

• match community-list <list number> exact-match

• match ip address <access-list number>

• match route-type <route type>

• match interface {list of interface names}

• match tag {tag-id}

• match metric {metric-value}

• match ip next-hop <access-list> [<access-list> ...]

• set tag {tag}

• set next-hop {next-hop}

• set ip next-hop <address> [<...address>] [peer-address]
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• set as-path prepend

• set as-path prepend <text>

• set as-path tag

• set community

• set communty <number>

• set community <number> additive

• set community none

• set comm-list <community list> delete

• set weight <weight>

• set origin <origin>

• set origin <origin> <as-num>

• set local-preference <number>

• set metric <metric>

• set metric <bandwidth> <delay> <reliability> <loading> <mtu>

• set metric-type <metric type>

• rd route-distinguisher

• route-target {import | export | both} route-target-ext-community

• import map route-map

• export map route-map

• set comm-list <community list> delete

• set ip default next-hop <address> [<...address>] [peer-address]

• set default interface <interface> [<...interface>]

Cisco System Management Commands

• snmp-server community <string> [view <view-name>] [ro|rw] [<access-list 
number>]

• snmp-server view <view-name> <oid-tree> {included|excluded}

• snmp-server host <host-addr> [traps|informs] [version {1 | 2c | 3 [auth | 
noauth | priv]}] <community-string> [udp-port <port>] [<notification-type>]

• snmp-server enable traps [<notification-type>]
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• snmp-server queue-length <length>

• snmp-server packetsize <byte-count>

• snmp-server manager session-timeout <seconds>

• snmp-server trap-source <interface>

• no snmp-server system-shutdown

• snmp-server system-shutdown

• no snmp-server manager

• snmp-server manager

• snmp-server chassis-id <text>

• snmp-server location <text>

• snmp-server contact <text>

• logging <host-name>

• logging buffered [<buffer-size> | <level>]

• no logging console

• logging console <level>

• logging facility <facility-type>

• logging monitor <severity-level>

• no logging on

• logging on

• logging source-interface <interface-type interface-number>

• logging trap <level>

• service timestamps <message-type> [uptime]

• service timestamps <message-type> datetime [msec] [localtime] 
[show-timezone]
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Cisco Catalyst Commands

Last updated for release: 1.2 PL3.

• #version <version>

• #module <module number> <description>

• #vlan <vlan number>

• #vlan(defaults)

• set system location <location string>

• set system name <name>

• set arp <ip address> <hardware address>

• set interface sc0|sl0 up|down

• set interface sl0 <slip address> <dest address>

• set interface sc0 [vlan <vlan number>|ip address [netmask [broadcast]]]

• set module enable|disable <module number>

• set module name <module number> <module name>

• set module name <module number/port number> <module name>

• set vlan <vlan number> <module number/port number ...>

• set vlan <vlan number> [name <name>] [type <type>] [mtu <mtu>] [said       
<said>] [state <state>] [ring <ring number>] [parent <vlan number>] [stp  <stp 
type>] [translation <vlan number>]

• set port enable|disable <module number/port number>

• set port duplex <module number/port number> full|auto|half

• set port speed <module number/port number> 10|100|auto

• set spantree enable|disable <vlan>

• set spantree enable|disable

• set spantree fwddelay <delay> <vlan>

• set spantree fwddelay <delay>

• set spantree hello <interval> <vlan>

• set spantree hello <interval>

• set spantree maxage <age> <vlan>

• set spantree maxage <age>
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• set spantree portcost <module number/port number> <cost>

• set spantree portpri <module number/port number> <priority>

• set spantree portvlanpri <module number/port number> <prioity><vlan>

• set spantree portvlanpri <module number/port number> <priority>

• set spantree backbonefast <enable|disable>

• set spantree guard <none|root|loop> <mod/port list>

• set spantree portfast bpdu-filter <enable|disable>

• set spantree portfast bpdu-guard <enable|disable>

• set spantree portcost <module number/port number list> <enable|disable>

• set spantree portcost <module number/port number list> <cost>

• set spantree portvlanpri <module number/port number> cost <cost>

• set spantree portvlancost <module number/port number> cost <cost> 
<vlan_ids>

• set spantree portpri <module number/port number list> <priority>

• set spantree portvlanpri <module number/port number> <priority> <vlan>

• set spantree portvlanpri <module number/port number> <priority>

• set spantree priority <bridge priority> <vlan> 

• set spantree priority <bridge priority>

• set spantree priority <bridge priority>

• set spantree root secondary dia [<diameter>] [hello <hello_time>]

• set spantree root <vlan list> dia [<diameter>] [hello <hello_time>]

• set spantree root secondary <vlan list> dia [<diameter>] [hello <hello_time>]

• set spantree uplinkfast <enable|disable> [rate <rate>] [all-protocol <on|off>]

• set trunk <module number/port number> [on|off|desirable|auto|nonegotiate] 
[vlan_range] {isl|dot1q|dot10|lane|negotiate]

• set spantree priority <bridge priority> <vlan>

• set spantree priority <bridge priority>

• set cam dynamic|static|permanent <mac> <mod/ports>

• set cam dynamic|static|permanent <mac> <mod/ports> <vlan>
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Cisco PIX Firewall Commands

Last updated for release: 2.0 PL1.

• access-group {access-list-number | name} in interface <interface_name>

• domain-name <name>

• hostname <name>

• PIX Version <version>

• nameif {hardware_id|vlan_id} if_name security_level

• interface <hardware-id>

• interface <hardware-id> <hardware speed tag>

• interface <hardware-id> <vlan-name>

• interface <hardware-id> <vlan-name> <logical|physical>

• interface <hardware-id> <vlan-name> <logical|physical> shutdown

• ip address if_name <ip_address|name>

• ip address if_name <ip_address|name> <netmask|name>

• ip address if_name <ip_address|name> <netmask|name> pppoe

• ip address if_name <ip_address|name> <netmask|name> pppoe setroute

• mtu <if-name> bytes

• snmp-server community <string>

• snmp-server host [<if_name>] <host-addr> [traps|poll]

• snmp-server enable traps

• no snmp-server enable traps

• snmp-server location <text>

• no snmp-server location

• snmp-server contact <text>

• no snmp-server contact

• logging <host-name>

• logging buffered <level>

• no logging buffer

• no logging console
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• logging console <level>

• logging facility <facility-type>

• logging monitor <severity-level>

• no logging on

• logging on

• logging source-interface <interface-type interface-number>

• logging trap <level>

• service resetoutside

• service resetoutside

• names

• description <description text>

• object-group icmp-type <group_id>

• icmp-object <icmp_type>

• object-group network <group_id>

• network-object host <host_addr or name>

• network-object <addr> <mask>

• object-group protocol <group_id>

• protocol-object <protocol>

• object-group service <group_id> {tcp|udp|tcp-udp}

• port-object eq <service>

• port-object range <begin-service> <end-service>

• current object-group

• current ICMP type object-group

• current network object-group

• current protocol object-group

• current service object-group

• rip <if_name> default|passive [version [1|2]] [authentication [text|md5 key 
(key_id)]]

• router ospf <process id>
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• network <address> <wildcard mask> area <area id>

• distance <distance> [<address> <mask> [<access-list>]]

• distance ospf [external <dist>] [inter-area <dist>] [intra-area <dist>]

• redistribute <static|connected>

• redistribute ospf <process id>

• redistribute <static_connected> [metric <value>] [route-map <name>] 
[match <external|internal>] ...

• redistribute ospf [<process id>] [metric <value>] [route-map <name>] [match 
<external|internal>] ...

• area <area id>

• area <area id>

• summary-address {address-mask} {prefix-mask} [not-advertise] [tag {tag}]

• timers spf {spf-delay} {spf-holdtime}

• timers lsa-group-pacing <seconds>

• router-id <id>

• default-information originate

• default-information originate [always] [metric metric-value] [metric-type 
type-value] [route-map map-name]

• routing interface if_name ;

• ospf cost <cost>

• ospf authentication message-digest | null

• ospf authentication-key <key>

• ospf database-filter all out

• ospf mtu-ignore

• ospf message-digest-key <key-id> md5 <key>

• ospf dead-interval {seconds}

• ospf hello-interval {seconds}

• ospf priority {priority}

• ospf retransmit-interval {seconds}

• ospf transmit-delay {seconds}
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• access-list <list id> remark <text string>

• access-list id {deny|permit}{protocol | object-group protocol_obj_grp_id 
{source_addr | local_addr} {source_mask | local_mask} | object-group 
network_obj_grp_id [operator port [port] | interface if_name | object-group 
service_obj_grp_id] {destination_addr | remote_addr} {destination_mask | 
remote_mask} | object-group network_obj_grp_id [operator port [port] | 
object-group service_obj_grp_id]} [log [[disable | default] | [level]]] [interval 
secs]]

• access-list id {deny | permit} icmp {source_addr | local_addr} {source_mask 
| local_mask} | interface if_name | object-group network_obj_grp_id 
{destination_addr | remote_addr} {destination_mask | remote_mask} | 
interface if_name | object-group network_obj_grp_id [icmp_type | 
object-group icmp_type_obj_grp_id] [log [[disable | default] | [level]]] [interval 
secs]]

• prefix-list <list name> seq <number> <permit|deny <network/length>> [ge 
<number>] [le <number>]

• prefix-list <list name> <permit|deny <network/length>> [ge <number>] [le 
<number>]

• prefix-list <list name> [seq <number>] <permit|deny <network/length>>

• prefix-list <list name> <permit|deny <network/length>>

• route-map <name> [permit|deny] [<sequence number>]

• match ip address <access-list number list>

• match route-type <route type>

• match nssa-external <type-1 | type-2>

• match interface {interface name}

• match ip route-source {list of access-list name|number}

• match metric {metric-value}

• match ip next-hop <access-list> [<access-list> ...]

• set next-hop {next-hop}

• set ip next-hop <address> [<...address>] [peer-address]

• set metric <metric>

• set metric-type <metric type>
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Juniper Commands 

Last updated for release: 1.2 PL3.

Juniper commands include the following:

• Juniper Global Commands

• Juniper Interface Commands

• Juniper RIP Commands

• Juniper OSPF Commands

• Juniper BGP Commands

• Juniper IS-IS Commands

• Juniper MPLS Commands

• Juniper RSVP Commands

• Juniper LDP Commands

• Juniper Policy Option Commands

• Juniper Routing Option Commands

• Juniper Routing Instances

Juniper Global Commands

version <value>; 

system {

    host-name <value>; 

    location { 

       country-code <value>; 

       latitude <value>; 

       longitude <value>; 

       npa-nxx <value>; 

    } 

}
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Juniper Interface Commands

<interface-name> { 

    disable;

    enable;

    encapsulation atm-pvc; 

    encapsulation frame-relay; 

    link-mode full-duplex; 

    link-mode half-duplex; 

    speed (10m | 100m);

    mtu <bytes>;

    description <text>;

    unit <logical-unit-number> {

        disable;

        enable;

        encapsulation atm-pvc; 

        encapsulation frame-relay; 

        dlci <value>;

        shaping {

          cbr <rate>;

          vbr peak <rate> sustained <rate> burst <length>;

        }

        vci <vpi-identifier.vci-identifier>;

        family iso;

        family mpls;

        family inet {

            mtu <bytes>;

            primary;

            address <value>;

            address <value> {

                destination <value>;

                multipoint-destination <destination-address> dlci <dlci-identifier>;

                multipoint-destination <destination-address> vci <vci-identifier>;

                multipoint-destination <destination-address> {

                }

                preferred;

                primary;

            } # address 

        } # family 
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Juniper RIP Commands

 family iso {

             mtu <bytes>; 

             primary; 

             address <value> {

                 preferred; 

                 primary; 

             }

         }

         point-to-point; 

         multipoint; 

    } # unit 

} # interface-name 

 rip {

         import [lsb | <value> | rsb]; 

         metric-in <value>;

         send [broadcast | multicast | none | version1];

         receive [both | none | version1 | version2]; 

         disable; 

         group <value> {

             export [lsb | <value> | rsb];

             neighbor <value>;  

             neighbor <value> {

                 metric-in <value>;

                 receive [both | none | version1 | version2];

                 send [broadcast | multicast | none | version-1];

             } # neighbor 

         } # group 

} # rip 
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Juniper OSPF Commands

 ospf {

         export [lsb | <value> | rsb]; 

         reference-bandwidth <value>; 

         area <area-id> {

             interface <interface-name>; 

             interface <interface-name> {

                 disable;    passive;

                 dead-interval <seconds>;

                 hello-interval <seconds>;

                 interface-type [p2mp | nbma];

                 metric <value>;

                 neighbor <value>;

                 neighbor <value> eligible; 

                 priority <value>;

                 retransmit-interval <seconds>;

                 transit-delay <seconds>;

             } # interface 

             label-switched-path <value> metric <value>;

             virtual-link neighbor-id <value> transit-area <value>;

             area-range <addr_with_mask>;

             area-range <addr_with_mask> restrict;

             stub [default-metric <value> | no-summaries | summaries];

             nssa {

                 area-range <value>;   area-range <value> restrict;

                 default-metric <value>;

                 (no-summaries | summaries);

             }

             virtual-link neighbor-id <router-id> transit-area <area-id> {

                 dead-interval <seconds>;    hello-interval <seconds>;

                 retransmit-interval <seconds>;

                 transit-delay <seconds>;

             }

         } # area 

         traffic-engineering {
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Juniper BGP Commands

 bgp {
         local-as <autonomous-system>;

         cluster <cluster-identifier>;
         description <text-description>;
         disable;

         export [lsb | <value> | rsb];
         family inet {
             any { 

                 prefix-limit {
                     maximum <value>;
                     teardown <percentage>;

                 }
                 unicast {
                 } 

                 multicast {
                 }
             } 

         }  
         hold-time <seconds>;
         import [policy-name];

         local-preference <local-preference>; 
         metric-out <metric>;
         multihop <ttl-value>;

         no-client-reflect;
         out-delay <seconds>;
         path-selection (cisco-non-deterministic | always-compare-med);

         peer-as <autonomous-system>;
         preference <value>;
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 group <group-name> { 

             description <text-description>;
             export [lsb | <value> | rsb];
             family inet {

                 (any | unicast | multicast) {
                     prefix-limit {
                         maximum <number>;

                         teardown <percentage>;
                     }
                 }

                 unicast {
                 }
                 multicast {

                 }
             }
             hold-time <seconds>;

             import [policy-name];
             multihop <ttl-value>;
             no-client-reflect;

             out-delay <seconds>;
             local-address <value>;
             passive;

             local-as <value>;
             local-as <value> private;
             local-preference <value>;

             metric-out <value>;
             peer-as <autonomous-system>;
             preference <value>;
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 family inet-vpn {
             }

             neighbor <address>; 
             neighbor <address> { 
                 description <text-description>; 

                 export [lsb | <value> | rsb]; 
                 family inet { 
                 any { 

                     prefix-limit { 
                         maximum <number>; 
                         teardown <percentage>; 

                     } 
                 } 

                 unicast {
                 } 
                 multicast {

                 }
                 hold-time <seconds>;
                 import [ policy-name ];

                 multihop <ttl-value>;
                 no-client-reflect;
                 out-delay <seconds>;

                 peer-as <autonomous-system>;
                 preference <value>;
             }  # neighbor 

         } # group   
     } # bgp 
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Juniper IS-IS Commands

 isis {

         export [lsb | <value> | rsb];
         label-switched-path <value> level <value> metric <value>;
         traffic-engineering {

             shortcuts;
         }
         level <level-number> {

             wide-metrics-only;
         }
         lsp-lifetime <seconds>;

         overload; 
         overload timeout <seconds>;
         interface <interface-name>; 

         interface <interface-name> {
             disable;
             passive;

            csnp-interval (<seconds> | disable);
             lsp-interval <milliseconds>;
             mesh-group (<value> | blocked);

             level <value> [metric <value>];
             hello-interval <seconds>;
             hold-time <seconds>;

             priority <value>;
             te-metric <value>;
             level <value> {

                 hello-interval <seconds>;
                 hold-time <seconds>;
                 metric <value>;

                 priority<value> ;
                 te-metric <value>;
                 passive;

                 disable;
            } # level 
         } # interface

} # isis 
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Juniper MPLS Commands

 }

          secondary <value> {
          }
          class-of-service <value>;

          fast-reroute {
              bandwidth <value>;
              exclude noexclude;

              exclude <value>;
              hop-limit <value>;
              include no-include <value>;

              include <value>;
          }
          preference <value>;

          retry-limit <value>;
          retry-timer <value>;
      }

      interface <value>;
      interface <value> {
          disable;

          admin-group [<value>];
          admin-group {
              <value>

          }
      }
  } # mpls
VNE Server/Release 3.0 VNE-B-31



App B—Device Configuration Commands VNE Server User Guide 
Juniper RSVP Commands

Juniper LDP Commands

 rsvp {

      keep-multiplier <value>;
      refresh-time <value>;
      preemption [normal | aggressive | disabled];

      interface <value> {
          subscription <value>;
      }

}

 ldp {

      import <value>;
      export <value>;

      keepalive-interval <value>;
      keepalive-timeout <value>;
      interface <value> {

          hello-interval <value>;
          hold-time <value>;
      }

  }
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Juniper Policy Option Commands

policy-options {
     as-path <name> regular-expression;

     community <name> [members | <community-ids>];
     policy-statement <policy-name> {
         term <term-name> {

             from {
                 match-conditions;
                 route-filter <destination-prefix> match-type actions;

             }
             to {
                 match-conditions;

             }
             then actions;
         }

     }
}

COMMENTS for policy-options:

match-conditions can be any of the following statments:

area <area-id>; as-path <name>;
color <preference>; color2 <preference>;

community [< names> ]; external [type <metric-type>]; family <name>;
instance <name>; interface <interface-name>;
level <level>; local-preference <value>;

metric <metric>; metric2 <metric>; metric3 <metric>; metric4 <metric>;
neighbor <address>; next-hop <address>;
origin <value>; policy <policy-name>;

preference <preference>; preference2 <preference>;
protocol <protocol>; rib <routing-table>;
tag <string>; tag2 <string>;
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match-type can be any of the following statments:

exact
longer

orlonger
prefix-length-range range1 - range2
through <destination-prefix>

upto <prefix-length2>

actions can be any of the following statments:

accept; reject; next term; next policy; as-path-prepend as-path;
as-path-expand last-as count n; class class-name ; color preference ;

color2 preference ; color (add | subtract) number; 
color2 (add | subtract) number;
community (+ | add) [ names ] ; community (- | delete) [ names ];

community (= | set) [ names ] ;
damping name; destination-class destination-class-name;
external type metric; install-nexthop lsp lsp-name;

load-balance per-packet;
local-preference value; local-preference (add | subtract) number;
metric metric; metric2 metric; metric3 metric; metric4 metric;

metric (add | subtract) number; metric2 (add | subtract) number;
metric3 (add | subtract) number; metric4 (add | subtract) number;
metric (igp | minimum-igp) site-offset;

next-hop (address | peer-address) ;
origin value ;
preference preference; preference2 preference;

preference (add | subtract) number; preference2 (add | subtract) number;
tag tag; tag2 tag;
tag (add | subtract) number;

tag2 (add | subtract) number;
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routing-options {
    autonomous-system <autonomous-system>;

    autonomous-system <autonomous-system> loops <number>;
    confederation <confederation-autonomous-system> members <autonomous-system>;
    router-id address;

    static {
        defaults {
        }

        route <value> next-hop <value>;
        route <addr_with_mask> next-hop <value>; 
        route <value> {

            static-options;
        }
        route destination-prefix {

            next-hop;
            static-options;
        }

    }
}

COMMENTS for routing-options:

static-options can be any of the following:

(active | passive);
* as-path <as-path> <origin (egp | igp | incomplete)> <atomic-aggregate> 

<aggregator as-number in-address>;
* community [ community-ids ]
(install | no-install);

(metric | metric2 | metric3 | metric4) value <type type>;
(preference | preference2 | color | color2) preference <type type>;
(readvertise | no-readvertise);

(resolve | no-resolve);
(no-retain | retain);
(tag | tag2) string;
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Juniper Routing Instances

routing-instances {

    <value> {
        description <value>;
        instance-type vrf;

        interface <value>;
        route-distinguisher <value>;
        vrf-import <value>;

        vrf-export <value>;
        routing-options {
            static {

                route addrwmask {
                    next-hop <value>;
                }

            }
        }
        protocols {

            bgp {
                group <value> {
                    peer-as <value>;

                    neighbor <value>;
                }
            }

        }
     }
}
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Nortel Networks Commands 

Last updated for release: 1.2 PL3.

Nortel Network commands include the following:

• Nortel Global Commands

• Nortel Interface Commands

• Nortel RIP Commands

• Juniper OSPF Commands

• Juniper BGP Commands

• Nortel BGP/EGP

Nortel Global Commands

• box

• stack

• system-name <name>

• ip

• static-router address <dest addr> mask <dest mask> next-hop-address 
<next hop>

Nortel Interface Commands

• <interface type> module <module number> slot <slot number> connector 
<connector number>

• <interface type> slot <slot number> connector <connector number>

• ip address <addr> mask <mask>

• mtu <size>

• mtu-mismatch-detect <state>

• type [broadcast | nbma | pointtopoint | ietf | pmp | passive]

• serial [ethernet | hssi | token-ring module <number> slot <number> 
connector <number>]

• slot <number> connector <number>
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Nortel RIP Commands

• rip

• external-clock-speed <speed>

• frame-relay

• pvc dlci <dlci>

• rip-diameter <max_hops>

• state [enabled | disabled]

• version [rip1 | rip2 | aggr]

• authentication-type [none | simple-password]

• authentication [<number> | <value>]

• supply [enabled | disabled]

• mode [poisoned | actual | split]

• triggered-updates [enabled | disabled]

• ttl <hops>

• listen [enabled | disabled]

• default-supply [enabled | disabled | generated]

• default-listen [enabled | disabled]

• broadcast-timer <seconds>

• timeout-timer <seconds>

• holddown-timer <seconds>

• frsvc [enabled | disabled]

• accept <policy_name>

• announce <policy_name>

• action [ignore | announce | accept | advertise | block]

• preference <number>

• precedence <number>

• match

• modify

• network [addr_mask_and_flag | addr_mask_and_flag]
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• rip-gateway [<ip address> | <ip address>]

• rip-interface

• mask <ip address>

• external-source [any | direct | static | rip | ospf | egp | bgp]

• ospf-type [any | type1 | type2 | external | internal]

• protocol-source [any | direct | static | rip | ospf | egp | bgp]

Nortel OSPF Commands

• ospf

• ospf router-id <router id>

• area area-id <area id>

• ospf area <area>

• metric <metric>

• ospf-router-id ip_address_list

• ospf-tag  as_number_list

• outbound-interface ip_address_list

• advertise [<network ID> | <network ID>]

• router-id <ip_address>

• slot-mask [<number> | <value> | <value>]

• as-boundary-router [true | false]

• ase-metric-support <state>

• as-default-tag [default | automatic | proprietary]

• holddown <value>

• lsa-refresh-max <value>

• lsa-refresh-delay <seconds>

• log-mask <mask>

• area <area-id>

• area <ip_address>

• priority <priority>

• transit-delay <delay>
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• retransmission-interval <interval>

• hello-interval <interval>

• dead-interval <interval>

• poll-interval <interval>

• neighbor <ip_address>

• summary network

• summary network <ip_address> mask <ip_mask>

• area-type stub

• area-type nssa

• stub-metric <cost>

• import-summaries false

• nssa-default-ase-path [type1 | type2]

• nssa-default-originate <state>

• nssa-default-propagate <state>

• nssa-translate-to-5 <state>

• nssa-range <network ID>

• ase-tag <value>

• ase-tag number_list

• virtual-link <ip_address>

• authentication-key <value> [retransmit-interval <number>]

• retransmit-interval <interval>

• ase-type [any | default | type1 | type2]

• auto-tag [enabled | disabled | proprietary]

• nssa-propagate <param>

Nortel BGP/EGP

• bgp-as [<number> | <number>]

• bgp-next-hop ip_address_list

• bgp-peer ip_address_list

• egp-as  as_number_list
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• egp-gateway ip_address_list

• egp-peer ip_address_list

• inbound-interface ip_address_list

• local-as <local-as>

• intra-as-routing <state>

• redistribute-protocols [bgp | all]

• igp-interaction [none | ospf | rip]

• igp-interaction [<value> | ospf | rip | <value>]

• inject-time <value>

• redundant-connection <state>

• max-redundant-routes <number>

• multi-hop <state>

• subnet-aggregation <state>

• black-hole-punching [disabled | drop | reject]

• med-comparison <state>

• confederation-id <id number>

• confederation-peers <as_numbers>

• peer <network ID> as <number>

• local-pref-calculation <state>

• damping-template name <value>

• cutoff-threshold <number>

• reuse-threshold <number>

• reachable-decay <number>

• unreachable-decay <number>

• max-hold-down <number>

• memory-limit <number>

• as-weight-class <value>

• bgp4-preference <number>

• route-damping <state>
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• route-damping-template <value>

• as-path-pattern [<value> | <value>]

• origin [any | igp | egp | incomplete | none]

• aggregator-as <list of as numbers>

• aggregator-router <list of ip addresses>

• as <list of as numbers>

• community [no-export | no-advertise | no-export-subconfed]

• community [<value> | <value>]

• network <list of ip addresses>

• originating-as <list of as numbers>

• peer <list of addresses>

• as-path-prepend

• local-pref-override <state>

• local-preference <number>

• med-method [none | specified | originating]

• med <number>

• community-method [as-is | remove | append | replace]

• inject <list of ip addresses>

• inbound-as <list of as numbers>

• inbound-peer <list of ip addresses>

• next-hop <list of ip addresses>

• outbound-as <list of as numbers>

• outbound-peer <list of ip addresses>

• as-path [<value> | <number> | <value> | <number>]

• atomic-aggregate [default | force | ignore]

• local-pref-override <state>

• peer local <local_address> remote <remote_address> as <as_number>

• retry <interval>

• min-version [bgp3 | bgp4]
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• max_version [bgp3 | bgp4]

• keepalive <seconds>

• advertise-time <seconds>

• min-originate-time <seconds>

• max-update-size <bytes>

• next-hop-self <state>

• route-echo <state>

• detect-as-loop <state>

• tcp-authentication <state>

• tcp-md5-key <key>

• tcp-md5-key-storage [clear-text | encrypted]

• advertise <ip_address_list>
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Nortel Networks Passport 8000 Commands

Last updated for release: 1.2 PL3.

• cli prompt <name>

• box type : <node type>

• sys set location <location string>

• ethernet <ifc num> perform-tagging <enable|disable>

• ethernet <ifc num> qos-level <level>

• ethernet <ifc num> name <name>

• ethernet <ifc num> state <enable|disable>

• ethernet <ifc num> speed <value>

• ethernet <ifc num> duplex <half|full>

• ethernet <ifc num> auto-negotiate <enable|disable>

• ethernet <ifc num> lock <true|false>

• ethernet <ifc num> linktrap <enable|disable>

• ethernet <ifc num> ip dhcp-relay <enable|disable>

• ethernet <ifc num> stg <number> stp <enable|disable>

• ethernet <ifc num> stg <number> faststart <enable|disable>

• ethernet <ifc num> stg <number> change-detection <enable|disable>

• ethernet <ifc num> stg <number> pathcost <cost>

• ethernet <ifc num> stg <number> priority <priority>

• ethernet <ifc num> ip ospf metric <metric>

• ethernet <ifc num> ip ospf advertise-when-down <enable|disable>

• ethernet <ifc num> ip ospf area <ipaddr>

• ethernet <ifc num> ip ospf <enable|disable>

• ethernet <ifc num> ip ospf interface_type

• ethernet <ifc num> ip ospf dead-interval <seconds>

• ethernet <ifc num> ip ospf hello-interval <seconds>

• ethernet <ifc num> ip ospf priority <priority>

• ethernet <ifc num> ip rip advertise-when-down <enable|disable>
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• ethernet <ifc num> ip rip auto-aggr <enable|disable>

• ethernet <ifc num> ip rip default-listen <enable|disable>

• ethernet <ifc num> ip rip default-supply <enable|disable>

• ethernet <ifc num> ip rip cost <cost>

• ethernet <ifc num> ip rip <enable|disable>

• ethernet <ifc num> ip rip listen <enable|disable>

• ethernet <ifc num> ip rip in-policy <policy name>

• ethernet <ifc num> ip rip out-policy <policy name>

• ethernet <ifc num> ip rip poison <enable|disable>

• ethernet <ifc num> ip rip supply <enable|disable>

• ethernet <ifc num> ip rip trigger <enable|disable>

• mlt <mid> create

• mlt <mid> name <name>

• mlt <mid> perform-tagging <enable|disable>

• mlt <mid> add ports <ports>

• mlt <mid> add vlan <vid>

• vlan <vid> create byport <sid> [name <name>] [color <color>]

• vlan <vid> create byport <sid>

• vlan <vid> ports remove <ports> member portmember

• vlan <vid> ports add <ports> member portmember

• vlan <vid> ip create <ip address/mask> mac_offset <value>

• vlan <vid> add-mlt <mid>

• vlan ip ospf metric <metric>

• vlan <ifc num> ip ospf advertise-when-down <enable|disable>

• vlan <ifc num> ip ospf area <ipaddr>

• vlan <ifc num> ip ospf <enable|disable> 

• vlan <ifc num> ip ospf dead-interval <seconds>

• vlan <ifc num> ip ospf hello-interval <seconds>

• vlan <ifc num> ip ospf priority <priority>
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• vlan <ifc num> ip ospf poll-interval <seconds>

• vlan <ifc num> ip rip advertise-when-down <enable|disable>

• vlan <ifc num> ip rip auto-aggr <enable|disable>

• vlan <ifc num> ip rip default-listen <enable|disable>

• vlan <ifc num> ip rip default-supply <enable|disable>

• vlan <ifc num> ip rip cost <cost>

• vlan <ifc num> ip rip <enable|disable>

• vlan <ifc num> ip rip listen <enable|disable>

• vlan <ifc num> ip rip in-policy <policy name>

• vlan <ifc num> ip rip out-policy <policy name>

• vlan <ifc num> vlan <ifc num> ip rip poison <enable|disable>

• vlan <ifc num> ip rip supply <enable|disable>

• vlan <ifc num> ip rip trigger <enable|disable>

• stg <value> create <ports>

• stg <value> add ports <ports>

• stg <value> forward-delay <timeval>

• stg <value> hello-interval <timeval>

• stg <value> max-age <timeval>

• stg <value> priority <priority>

• stg <value> group-stp <enable|disable>

• ip static-route create <ip address/mask> next-hop <value> [cost <value>] 
[preference <value>]

• ip ospf admin-state <enable|disable>

• ip ospf <enable|disable>

• ip ospf router-id <value>

• ip ospf as-boundary-router <enable|disable>

• ip ospf auto-vlink <enable|disable>

• ip ospf default-metric [ethernet <value>] [fast-ethernet <value>] [gig-ethernet 
<value>]

• ip ospf holddown <seconds>
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• ip ospf trap <enable|disable>

• ip ospf area <area> create

• ip ospf area <area> stub <true|false>

• ip ospf area <area> import-summaries <true|false>

• ip ospf area <area> nssa <true|false>

• ip ospf area <area> stub-metric <value>

• ip ospf area <area> range <ip address/mask> create advertise-mode 
<mode> lsa-type <type>

• ip ospf area <area> range <ip address/mask> advertise-mode <mode>

• ip ospf area <area> range <ip address/mask> advertise-metric <metric>

• ip ospf interface <ip address> area <area>

• ip ospf interface <ip address> admin-status <enable|disable>

• ip ospf interface <ip address> interface_type <broadcast|nbma|passive>

• ip ospf interface <ip address> create <broadcast|nbma|passive>

• ip ospf interface <ip address> dead-interval <seconds>

• ip ospf interface <ip address> hello-interval <seconds>

• ip ospf interface <ip address> metric <metric>

• ip ospf interface <ip address> priority <priority>

• ip ospf interface <ip address> retransmit-interval <seconds>

• ip ospf interface <ip address> transit-delay <seconds>

• ip rip <enable|disable>

• ip rip default-import-metric <metric>

• ip rip holddown <seconds>

• ip rip updatetime <seconds> 

• ip rip interface <ipaddr> <enable|disable> 

• ip rip interface <ipaddr> auto-aggr <enable|disable>

• ip rip interface <ipaddr> cost <cost>

• ip rip interface <ipaddr> default-listen <enable|disable>

• ip rip interface <ipaddr> default-supply <enable|disable>
VNE Server/Release 3.0 VNE-B-47



App B—Device Configuration Commands VNE Server User Guide 
• ip rip interface <ipaddr> in-policy <policy name>

• ip rip interface <ipaddr> listen <enable|disable>

• ip rip interface <ipaddr> out-policy <policy name>

• ip rip interface <ipaddr> poison <enable|disable>

• ip rip interface <ipaddr> receive-mode <mode>

• ip rip interface <ipaddr> send-mode <mode>

• ip rip interface <ipaddr> supply <enable|disable>

• ip rip interface <ipaddr> trigger <enable|disable>
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Nortel Networks Passport 7480, 15000, 20000 Commands

Last updated for release: 2.0  PL1. 

• set mod

• set shelf card

• set lp maincard shelf card

• set lp ima

• set lp e1 chan

• set lp sdh vc4

• set lp sdh path

• set atmif customeridentifier

• set trk atm

• add vr

• set vr

• set atmmpe ac atmconnection

• set la framer

• set lp enet

• add atmif vcc vcd tm

• set atmif vcc vcd tm

• set atmif ca

• add atmif vpc vpd tm

• set atmif vpc vpd tm

• set atmif vpc nrp

• set atmif vcc nrp

• add atmif vpt vpd tm

• add atmif vpt vcc vcd tm

• set atmif vpt vpd tm

• set atmif vpt vcc vcd tm

• set vm if

• set atmif vcc src mdtl
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• set atmif vcc src

• set artg pnni mdtl hop

• set artg pnni node

• set artg pnni nodeaddressprefix

• set atmif pnni
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Extreme Commands

Last updated for release: 2.0 PL1.

• create vlan <vlan name>

• delete vlan <vlan name>

• config vlan <vlan name> add ports <portlist> tagged/untagged

• config vlan <vlan name> add ports <portlist> stpd <spantree name>

• config vlan <vlan name> add ports <portlist> stpd <spantree name> 
<port_mode>

• config vlan <old name> name <new name>

• config vlan <vlan name> tag <vlan id>

• tagged

• untagged

• create stpd <spantree name>

• delete stpd <spantree name>

• enable stpd <spantree name>

• enable stpd <spantree name>

• enable stpd <spantree name> ports <portlist>

• disable stpd <spantree name>

• config stpd <spantree name> add vlan <vlan_list>

• config stpd <spantree name> delete vlan <vlan_list>

• config stpd <spantree name> add vlan <vlan name> ports <port list>

• config stpd <spantree name> add vlan <vlan name> ports <port list> 
<port_mode>

• config stpd <spantree name> delete vlan <vlan name> ports <port list>

• config stpd <spantree name> forwarddelay <seconds>

• config stpd <spantree name> hellotime <seconds>

• config stpd <spantree name> maxage <seconds>

• config stpd <spantree name> ports cost <cost> <portlist>

• config stpd <spantree name> ports mode <port_mode> <portlist>
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• config stpd <spantree name> ports priority <priority> <portlist>

• config stpd <spantree name> priority <seconds>

• config vlan <vlan name> ipaddress <ipaddress>

• unconfig vlan <vlan name> ipaddress <ipaddress>

• disable ipfowarding

• disable ipfowarding vlan <vlan name>

• enable ipfowarding

• enable ipfowarding vlan <vlan name>

• config iproute add <ip address> <mask> <gateway> <metric>

• config iproute delete <ip address> <mask> <gateway>

• config iproute add default <gateway>

• config iproute add default <gateway> <metric>

• config iproute delete default <gateway>

• enable rip

• disable rip

• enable rip aggregation

• disable rip aggregation

• enable rip splithorizon

• disable rip splithorizon

• enable rip poisonreverse

• disable rip poisonreverse

• enable rip triggerupdate

• disable rip triggerupdate

• config rip add vlan <vlan name>

• config rip delete vlan <vlan name>

• config rip add vlan all

• config rip delete vlan all

• config rip garbagetime <seconds>

• config rip routetimeout <seconds>
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• config rip rxmode <none|v1only|v2only|any>

• config rip rxmode <none|v1only|v2only|any> vlan <vlan name>

• config rip txmode <none|v1only|v1comp|v2only>

• config rip txmode <none|v1only|v1comp|v2only> vlan <vlan name>

• config rip updatetime <seconds>

• config rip vlan <vlan name> cost <cost>

• config rip vlan all cost <cost>

• enable ospf

• disable ospf

• create ospf area <area id>

• delete ospf area <area id>

• config ospf area <area id> cost <cost>

• config ospf area <area id> priority <priority>

• config ospf area <area id> timer <seconds>

• config ospf vlan <vlan name> area <area id>

• config ospf vlan <vlan name> neighbor add <neighbor ipaddr>

• config ospf vlan <vlan name> cost <cost>

• config ospf vlan <vlan name> priority <priority>

• config ospf vlan <vlan name> timer <timer_params>

• config ospf vlan all area <area id>

• config ospf vlan all cost <cost>

• config ospf vlan all priority <priority>

• config ospf vlan all timer <timer_params>

• config ospf add vlan <vlan name> area <area_id>

• config ospf add vlan <vlan name> area <area_id> passive

• config ospf add vlan all area <area_id>

• config ospf add vlan all area <area_id> passive

• config ospf add vlan <vlan name> area <area_id> link_type 
<auto|broadcast|point-to-point>
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• config ospf add vlan <vlan name> area <area_id> link_type 
<auto|broadcast|point-to-point> passive

• config ospf add vlan all area <area_id> link_type 
<auto|broadcast|point-to-point>

• config ospf add vlan all area <area_id> link_type 
<auto|broadcast|point-to-point> passive

• config ospf add virtual-link <routeid> <area_id>

• config ospf add virtual-link <routeid> <area_id>

• config snmp sysContact <sys contact>

• config snmp sysLocation <sys location>

• config snmp sysName <sys name>

• Software Version <version info>
VNE-B-54 VNE Server/Release 3.0



VNE Server User Guide App B—Device Configuration Commands
Foundry Commands

Last updated for release: 2.0 PL1.

• interface <name/number> [multipoint|point-to-point|<other>]

• no ip address

• ip address <address> <mask> [ospf-ignore | ospf-passive | secondary]

• multilink-group <number>

• link-aggregate configure [system-priority <number>] | [port-priority <num>\ | 
[key <num>]

• ip rip v1-only

• ip rip v2-only

• ip rip v1-compatible-v2

• ip rip poison-reverse

• ip rip learn-default

• ip rip filter in <i j k ...>

• ip rip filter out <i j k...>

• bandwidth <kbps>

• speed-duplex <10-full | 10-half | 100-full | 100-half | auto>

• mtu <bytes>

• ip mtu <value>

• ip route-cache [cbus|flow|distributed]

• no ip route-cache [cbus|flow|distributed]

• ip router isis

• no ip router isis

• ip access-group {access-list-number | name} {in | out}

• isis metric <num>

• isis priority <num>

• isis password <password, can have blank space>

• isis circuit-type {level-1|level-2-only|level-1-2}

• ip ospf cost <cost>
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• ip ospf network [point-to-multipoint]

• ip ospf network

• ip ospf dead-interval {seconds}

• ip ospf hello-interval {seconds}

• ip ospf priority {priority}

• ip ospf retransmit-interval {seconds}

• ip ospf transmit-delay {seconds}

• atm pvc <vpi> <vci> cbr <pcr>

• atm pvc <vpi> <vci> vbr <pcr> <sbr> <mbs>

• atm pvc <vpi> <vci> ubr

• encapsulation frame-relay

• encapsulation frame-relay <ietf>

• frame-relay interface-dlci <dlci>

• frame-relay lmi-type  {ansi|ccitt|lmi}

• frame-relay interface-dlci <dlci> lmi-type {ansi|ccitt|lmi}

• port-name <name string>

• ip tunnel <ip address> {pim|dvmrp|any}

• tunnel source <ip address|interface name>

• tunnel mpls traffic-eng affinity <properties> mask <mask>

• tunnel mpls traffic-eng affinity <properties>

• tunnel mpls traffic-eng autoroute announce

• no tunnel mpls traffic-eng autoroute announce

• tunnel mpls traffic-eng autoroute metric [absolute|relative] <metric>

• tunnel mpls traffic-eng autoroute metric <metric>

• tunnel mpls traffic-eng path-option <number> <dynamic|explicit name <path 
name|path number>>

• tunnel mpls traffic-eng path-option <number> <dynamic|explicit name <path 
name|path number>> lockdown

• tunnel mpls traffic-eng priority <setup>

• tunnel mpls traffic-eng priority <setup> <hold>
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• tunnel mpls traffic-eng fast-reroute

• mpls traffic-eng tunnels

• tunnel mode mpls traffic-eng

• ip rsvp bandwidth <interface kbps> <single flow kbps>

• ip rsvp bandwidth <interface kbps>

• mpls traffic-eng administrative-weight <weight>

• mpls traffic-eng attribute-flags <0x0 - 0xFFFFFFFF>

• mpls traffic-eng backup-path lsp-name

• mpls label protocol ldp

• mpls ip

• tag-switching ip

• mpls traffic-eng bandwidth <bandwidth>

• ip unnumbered <interface name>

• ip explicit-path {name WORD | identifier number} [{enable | disable}]

• next-address A.B.C.D

• shutdown

• standby [<group number>] ip [<ip address> [secondary]]

• standby [<group number>] mac-address <mac address>

• standby mac-refresh <seconds>

• standby name <group name>

• standby [<group number>] preempt priority <priority>

• standby [<group number>] preempt delay [<delay>] [minimum <delay>] 
[sync <delay>]

• standby [<group number>] preempt

• standby [<group number>] priority <priority>

• standby [<group number>] timers [msec] <hello time> [msec] <hold time> 
[advertise <advertisement interval>]

• standby [<group number>] track <interface name> [<interface priority>]

• standby [<group number>] use-bia [scope interface]

• standby [group-number] authentication <string>
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• standby delay [minimum <delay>] [reload <delay>]

• no standby redirects unknown

• standby redirects timers <advertisement-interval> <holddown-interval>

• ip policy route-map <map-tag>

• ip authentication mode eigrp <as-number> md5

• ip authentication key-chain eigrp <as-number> <key-chain>

• encapsulation dot1Q <vlan-id> [native]

• switchport\n

• switchport access vlan <vlan-id>

• switchport nonegotiate

• switchport broadcast <level>

• switchport protocol {ip | ipx | appletalk | other} {on | off | auto}

• switchport mode access

• switchport mode trunk

• switchport mode dynamic auto

• switchport mode dynamic desirable

• switchport trunk encapsulation {isl | dot1q | negotiate}

• switchport trunk native vlan <vlan-id>}

• switchport trunk allowed vlan <vlan-list>}

• switchport trunk pruning vlan <vlan-list>}

• spanning-tree

• no spanning-tree

• pvst-mode

• for "ip address <ip> <mask> [secondary |ospf-ignore | ospf-passive]"

• for "link-aggregate configure [system-priority <number>] | [port-priority 
<num>] | [key <num>]"

• ip policy prefer-direct-route

• no ip policy prefer-direct-route

• ip policy route-map <map-tag>
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• ip default-network <address>

• ip default-gateway <address>

• ip router-id <address>|<any string>

• ip route <dest addr> <mask> <next hop> [metric] [name <name>] [tag 
<number>] [permanent]

• ip route <dest addr> <mask> <next hop> [metric] [name <name>] [tag 
<number>] [permanent]

• access-list <list number> <various param-list>

• ip as-path access-list <list number> <permit|deny> <reg expression>

• ip prefix-list <list name> [seq <number>] <permit|deny <network/length>> 
[ge <number>] [le <number>]

• ip prefix-list <list name> <permit|deny <network/length>> [ge <number>] [le 
<number>]

• ip prefix-list <list name> [seq <number>] <permit|deny <network/length>>

• ip prefix-list <list name> <permit|deny <network/length>>

• ip community-list <list number> <permit|deny> <community> 
[<community>...]

• ip community-list <standard|expanded> <list number> <permit|deny> 
<community> [<community>...]

• ip access-list <standard|extended> <name>

• icmp src-addr dest-addr [icmp-type [icmp-code] | icmp-message] 
[precedence <p>] [tos <tos>] [log | log-input] [time-range <name>] 
[fragments]

• igmp src-addr dest-addr [igmp-type] [precedence <p>] [tos <tos>] [log | 
log-input] [time-range <name>] [fragments]

• tcp src-addr [operator [port]] dest-addr [operator [port]] [established] 
[precedence <p>] [tos <tos>] [log | log-input] [time-range <name>] 
[fragments]

• udp src-addr [operator [port]] dest-addr [operator [port]] [precedence <p>] 
[tos <tos>] [log | log-input] [time-range <name>] [fragments]

• route-map <name> [permit|deny] [<sequence number>]

• match as-path <path number>

• match community-list <list number>

• match community-list <list number> exact|exact-match
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• match community <list number>

• match community <list number> exact-match

• match community <list number>

• match community <list number> exact-match

• match ip address <access-list number>

• match route-type <route type>

• match interface {list of interface names}

• match ip route-source {list of access-list name|number}

• match tag <tag-id> [<tag-id>, ...]

• match length <min> <max>

• match metric {metric-value}

• match ip next-hop <access-list> [<access-list> ...]

• match ip next-hop prefix-list <prefix1> [<prefix2> ...]

• set tag {tag}

• set next-hop {next-hop}

• set ip next-hop <address> [<...address>] [peer-address]

• set ip tos <tos 0-15>

• set ip tos max-reliability

• set ip tos max-throughput

• set ip tos min-delay

• set ip tos min-monetary-cost

• set ip tos normal

• set as-path prepend

• set as-path prepend <text>

• set as-path tag

• set community <comm-list>

• set extcommunity

• set weight <weight>

• set origin <origin>
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• set origin <origin> <as-num>

• set local-preference <number>

• set metric <metric>

• set metric <bandwidth> <delay> <reliability> <loading> <mtu>

• set metric-type <metric type>

• set comm-list <community list> delete

• set ip default next-hop <address> [<...address>] [peer-address]

• set default interface <interface> [<...interface>]

• set automatic-tag

• set interface <interface-type><interface-number> 
[<interface-type><interface-number> ...]

• set level {level-1|level-2|level-1-2|backbone|stub-area}

• set traffic-index <bucket number>

• set clns next-hop <prefix> [prefix ...]

• ip explicit-path <name <name> | identifier <number>>

• ip explicit-path <name <name> | identifier <number>> <enable|disable>

• next-address <ip address>

• index <number> next-address <ip address>

• next-address <loose|strict> <ip address>

• index <number> next-address <loose|strict> <ip address>

• ip vrf vrf-name

• mpls ldp advertise-labels [for prefix-access-list]

• mpls ldp discovery {hello {holdtime | interval} seconds | targeted-hello 
{holdtime | interval} seconds | accept [from acl]}

• mpls ldp holdtime

• mpls label protocol ldp

• rd route-distinguisher

• route-target {import | export | both} route-target-ext-community

• import map route-map

• export map route-map
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• router rip

• neighbor {ip-address}

• update-time <0-1000>

• timers basic {update} {invalid} {holddown} {flush}

• redistribution

• permit|deny redistribute <filter-num> <all|bgp|ospf|static> address <ip-addr> 
<ip-mask> [match-metric <value>|set-metric-value]

• router ospf <process id>

• default-metric <value>

• distance ospf [external <dist>] [inter-area <dist>] [intra-area <dist>]

• distribute-list <access-list> <in|out>

• max-routes <value>

• redistribute <protocol>

• redistribute <protocol> [<process id>]

• redistribute <protocol> [metric <value>] [route-map <name>] [match 
<external|internal>] ...

• redistribute <protocol> [<process id>] [metric <value>] [route-map <name>] 
[match <external|internal>] ...

• auto-cost [reference-bandwidth <value>]

• area <area id>

• area <area id>

• summary-address {address-mask} {prefix-mask} [not-advertise] [tag {tag}]

• timers spf {spf-delay} {spf-holdtime}

• timers lsa-group-pacing <seconds>

• default-information originate [always] [metric metric-value] [metric-type 
type-value] [route-map map-name]

• router bgp

• local-as <as-number>

• address-family vpnv4 [unicast | multicast]

• no auto-summary

• auto-summary
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• no client-to-client-reflection

• client-to-client-reflection

• cluster-id {cluster-id | ip address}

• confederation identifier {autonomous-system}

• confederation peers as-number [... as-number]

• synchronization

• no synchronization

• timers bgp keepalive <decimal> holdtime <decimal>

• network <address> [mask <mask>] [weight <weight>] [route-map 
<map-name>]

• network <address> mask <mask>

• network <address>

• always-compare-med

• bgp default local-preference <value>

• default-metric <value>

• distance bgp <external> <internal> <local>

• distribute-list <access-list> <in|out>

• redistribute <protocol>

• redistribute <protocol> [<process id>]

• redistribute <protocol> [metric <value>] [route-map <name>] [match 
<external|internal>] ...

• redistribute <protocol> [<process id>] [metric <value>] [route-map <name>] 
[match <external|internal>] ... 

• neighbor <ip addr|peer group name> <params.....>

• neighbor <peer group name>

• maximum-paths <value>

• max-routes <value>

• aggregate-address <address> <mask> [as-set] [summary-only] 
[suppress-map <map-name>] [advertise-map <map-name>] [attribute-map 
<map-name>]

• no fast-external-failover
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• bgp fast-external-failover

• router-id <ip address>

• router isis

• is-type {level-1, level-2-only, level-1-2}

• set-overload-bit

• lsp-mtu {bytes}

• max-lsp-lifetime {lifetime}

• summary-address address mask {level-1 | level-1-2 | level-2}

• no hello-padding [multi-point|point-to-point]

• hello-padding {multi-point|point-to-point}

• net <net>

• distance <distance> [<address> <mask> [<access-list>]]

• maximum-paths <value>

• metric-style wide

• metric-style wide [level-1 | level-2-only]

• redistribute <protocol>

• redistribute <protocol> [<process id>]

• redistribute <protocol> [metric <value>] [route-map <name>] [match 
<external|internal>] ...

• redistribute <protocol> [<process id>] [metric <value>] [route-map <name>] 
[match <external|internal>] ...

• redistribute isis ip <level> into <level> [distribute-list <number> | metric-style 
wide>]

• mpls traffic-eng isis-level <level>

• mpls traffic-eng <level>

• mpls traffic-eng <level>

• spf-interval <min-interval>

• lsp-refresh-interval <seconds>

• lsp-gen-interval <min-interval>

• max-area-addresses <num-addresses>
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• area-password <password>

• domain-password <password>

• hostname <name>

• mpls traffic-eng tunnels

• ver <version>

• snmp-server community <string> [view <view-name>] [ro|rw] [<access-list 
number>]

• snmp-server view <view-name> <oid-tree> {included|excluded}

• snmp-server host <host-addr> [traps|informs] [version {1 | 2c | 3 [auth | 
noauth | priv]}] <community-string> [udp-port <port>] [<notification-type>]

• snmp-server enable traps [<notification-type>]

• snmp-server queue-length <length>

• snmp-server packetsize <byte-count>

• snmp-server manager session-timeout <seconds>

• snmp-server trap-source <interface>

• no snmp-server system-shutdown

• snmp-server system-shutdown

• no snmp-server manager

• snmp-server manager

• snmp-server chassis-id <text>

• snmp-server location <text>

• snmp-server contact <text>

• logging <host-name>

• logging buffered [<buffer-size> | <level>]

• no logging console

• logging console <level>

• logging facility <facility-type>

• logging monitor <severity-level>

• no logging on

• logging on
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• logging source-interface <interface-type interface-number>

• logging trap <level>

• spanning-tree [forward delay <num>] [hello-time <num>] [priority <num>]  
(global cmd)

• vlan <num> name <name> by port

• vlan <num> by port

• super-span

• tagged ethernet|pos|atm <portnumber> [to <num> [ethernet|pos|atm <num> 
[....]]]

• untagged ethernet|pos|atm <portnumber> [to <num> [ethernet|pos|atm 
<num> [....]]]

• priority

• router-interface ve <num>

• spanning-tree [forward delay <num>] [hello-time <num>] [priority <num>] 
[max-age <num>] (vlan cmd)

• spanning-tree single [forward delay <num>] [hello-time <num>] [priority 
<num>] [max-age <num>] (vlan cmd)

• spanning-tree single 802-1.w [forward delay <num>] [hello-time <num>] 
[priority <num>] [max-age <num>] (vlan cmd)

• spanning-tree 802-1.w [forward delay <num>] [hello-time <num>] [priority 
<num>] [max-age <num>] (vlan cmd)

• spanning-tree single rstp [forward delay <num>] [hello-time <num>] [priority 
<num>] [max-age <num>] (vlan cmd)
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